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Título Metodología para la obtención de modelos de tejidos del cerebro a 
partir de las imágenes médicas y técnicas de procesamiento de imagen 
digital 

Lugar/es donde desarrolla/n el 
proyecto – Fotos del desarrollo 

CeReCoN (Centro Regional de Investigación y Desarrollo en 
Computación y Neuroingeniería) - Área de Informetría, Lexicometría e 
Ingeniería del Conocimiento - Laboratorio ReAVi (Realidad aumentada 
y Virtual) – Universidad Tecnológica Nacional FRM, 

Institución/es requirente/s SECyT- UTN Mza 

Investigadores/Desarrolladores Césari Matilde - director 

María Cecilia CASTELLANOS - investigador formado 

Marcela FERNANDEZ - investigador formado 

Carolina PENNISI - investigador formado 

Eugenia ALFONSO - investigador apoyo 

Silvana SANDER - investigador apoyo 

María Eugenia STEFANONI - investigador apoyo 

Ricardo Manuel CESARI - investigador apoyo 

Valeria ESPARTARO - investigador estudiante 

Resumen del contenido El análisis de las imágenes médicas facilita a los especialistas la 
visualización, caracterización, medición y diagnóstico de 
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enfermedades y anomalías en el cuerpo humano. Muchos de los 
análisis imagenológicos se realizan hoy en día de manera manual y a 
criterio de los especialistas.  

Los conceptos de la detección de anomalías, han sido aplicados en 
muchos estudios de análisis de imágenes médicas. En estos casos, se 
trata de encontrar anomalías asociadas a varias partes del cuerpo 
como pueden ser hemorragias, fracturas, sangramientos, tumores, etc. 
En dichos estudios suelen emplearse varias modalidades de 
adquisición de imágenes como son la resonancia magnética (RM), los 
rayos X, la tomografía computarizada (TC), entre otras.  

El análisis de los cambios estructurales del cerebro a través de IRM 
puede proveer información útil para el diagnóstico médico. La 
adquisición de IRM, es una técnica no invasiva que utiliza el fenómeno 
de la resonancia magnética para obtener información detallada sobre 
la estructura y composición del cuerpo. La Imágenes de Resonancia 
Magnética (IRM), es utilizada en la actualidad, principalmente en 
medicina para observar alteraciones en los tejidos y detectar cáncer y 
otras patologías. La tarea de reconocimiento de patrones en imágenes, 
requiere de aprendizaje y de funciones apropiadas de clasificación, que 
asignen un determinado parámetro de entrada que por lo general es 
representado con un vector que contiene los atributos de cada una de 
las clases. De las imágenes se extraen regiones de tejidos sanos las 
cuales se usan para crear un modelo de lo que se considera normal 
(modelo de fondo) obteniendo varias clases “normales‘. 

En el presente trabajo se propone un esquema que ayude al 
acondicionamiento de la imagen para ser evaluada médicamente y 
finalizar con la extracción de características de la misma utilizando 
esta información para determinar anomalías asociadas a ciertas 
patologías neuronales. 

Resultados obtenidos (cantidad 
– calidad) en función de los 
objetivos del proyecto 

Obj.1: Estudio bibliográfico a través de técnicas de vigilancia 
tecnológica, y documentación de la información principal acerca de los 
métodos para el Tratamiento Digital de la Imagen Médica cerebrales 
en formato DICOM provenientes de Resonancias Magnéticas; las 
técnicas de Segmentación y Análisis de Textura; y las herramientas 
informáticas que sirven de apoyo en el proceso 

Res 1. Construcción del marco teórico sobre el aspecto técnico y 
médico de las imágenes cerebrales. Aquí se explican los resultados de 
estudios bibliográficos en relación a qué es una imagen digital y en 
especial la adquisición y formato de las imágenes médicas. Así mismo 
se sintetiza, la decodificación del formato de imagen digital cerebrales 
(DICOM) a una matriz de datos, donde se explica, en forma práctica 
para el posterior procesamiento, como adaptar los archivos que 
componen un estudio de resonancia magnética desde el formato de 
imagen DICOM, hasta la codificación en una matriz de datos. 

Resultados Ver Anexo 00 

Obj.2: Explorar el potencial de diversos métodos de análisis 
multivariados de datos y técnicas de inteligencia artificial para realizar 
la segmentación de imagen de resonancia magnética del cerebro, y 
extracción de Características que permitan discriminar entre regiones 
anormales y regiones sanas, a través de imágenes de prueba 
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experimentales de estudios con imágenes existentes normales y con 
anomalías 
Res 2. Construcción del marco teórico sobre las técnicas y 
herramientas de segmentación de imágenes digitales. Aquí se explican 
los resultados de estudios bibliográficos en relación a los métodos 
actuales existentes para el análisis de imágenes médicas, los diferentes 
pasos que se llevan a cabo en una imagen para su análisis, enumerando 
algunas técnicas para la realización de cada una de ellas. 

En especial se estudió las técnicas de segmentación de imágenes, ya 
que en el procesamiento de imágenes, la detección de objetos dentro 
de las mismas, la mayoría de las veces se hace por medio de alguna 
propiedad característica del objeto u objetos que se pretenden 
detectar; propiedades como el tamaño, textura, y forma, las cuales son 
con frecuencia las más usadas. 

Los métodos explicados abordan la distribución espacial de los valores 
de intensidad en las múltiples secuencias y captura al mismo tiempo la 
variabilidad de los datos en cada secuencia.  

Resultados Ver Anexo 00 y 02 

Res 3. *Definición de una metodología eficiente para la obtención de 
modelos de tejidos del cerebro a partir de las imágenes médicas, los 
cuales resulten útiles para el análisis de su comportamiento y la 
detección de anomalías. Mediante el uso de un conjunto de rutinas de 
procesamiento digital de imágenes y su adecuada combinación para 
cada etapa implicada en la obtención de modelos, tomando como base 
las técnicas de Procesamiento Digital de Imágenes, Reconocimiento de 
Patrones a partir de métodos multivariados e Inteligencia Artificial; a 
través de imágenes de resonancia magnética de prueba con tejido 
normal e imágenes con tejido patológico. Las etapas de procesamiento 
consideradas son:la etapa de lectura y reconstrucción de imágenes, 
preproceso, segmentación, y exportación de modelos en formatos 
legibles. 

Resultados Ver Anexo 02 

Proyección de continuidad - 
transferencias 

Una propuesta metodológica basada en técnicas de procesamiento de 
imagen digital, permitirá facilitar la búsqueda de anomalías e 
identificar biomarcadores de enfermedades cerebrales, a partir del 
estudio imagenológicos de la resonancia magnética. Así mismo, de 
manera preliminar, mostrar la importancia de realizar la segmentación 
de imagen cerebral, para su análisis, descripción y extracción de 
características ayudará a estudiar la evolución de los tratamientos de 
algunas enfermedades vinculadas con la epilepsia y esquizofrenia. La 
propuesta metodológica podría ser extendida para el estudio de 
imágenes de resonancia magnética como ayuda a localizar focos 
epilépticos, y biomarcadores de pacientes con esquizofrenia. 

Conclusiones Se han estudiado distintos métodos de segmentación de imágenes. 
Cuando se necesita hacer detección de determinados objetos en una 
imagen de grandes dimensiones, se hace necesario el uso de 
tecnologías que automatizan el proceso, entre ellas el algoritmo de 
superpixel destacado por sus bondades. No obstante, su alta eficiencia 
en el manejo y uso de la memoria del sistema ve limitada su capacidad 
de procesamiento para imágenes de determinadas resoluciones por las 
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prestaciones del dispositivo de cómputo en que se ejecute. Por lo antes 
expuesto se hace necesario subdividir estas imágenes de grandes 
dimensiones en bloques más pequeños que sean fácilmente 
manipulables por los algoritmos de procesamiento a los cuales se 
desean someter para la obtención de información. La segmentación 
superpixel ha demostrado ser un paso de preprocesamiento útil 
capaces de capturar la redundancia dentro de la imagen y luego 
reducir la complejidad de las tareas de procesamiento posteriores, 
como la clasificación de objetos de imagen. 

Se ha realizado un estudio de posibles descriptores de las 
características de cada uno de los segmentos que forman la imagen. En 
cuanto a textura, la entropía es una medida de la cantidad de 
información, por tanto, si la entropía es alta la información de las 
imágenes tiende a ser impredecible. La región heterogénea, aquella 
que selecciona el tumor, contiene los valores más altos de entropía. Es 
por tanto que estás regiones contienen una alta aleatoriedad y baja 
redundancia. En el caso contrario se tiene la región homogénea o 
fondo, se puede observar que en esta región los valores de entropía son 
los más bajos y por tanto esto querrá decir que la información de las 
imágenes tiende a ser predecible. Entre estos dos extremos se 
encuentra la región mixta. Los valores de entropía en la región mixta 
se sitúan entre los de la región homogénea y región heterogénea, esto 
es debido a que las regiones seleccionadas eran homogéneas dentro 
del cerebro, pero no se pueden considerar tan homogéneas como el 
fondo. 

Por otra parte, la energía es también un buen parámetro para la 
diferenciación de regiones. La energía se puede definir como la suma 
de los elementos de la matriz de co-ocurrencia al cuadrado. Las 
regiones más homogéneas tienen unos valores de energía próximos a 
1, en cambio, en las regiones más heterogéneas el valor de la energía 
se alejará del 1. Si se observan los resultados obtenidos referentes a la 
media de la energía se puede comprobar lo explicado anteriormente. 
Por tanto, se tiene el mayor resultado para la región homogénea y el 
menor para la heterogénea. De la misma manera que ocurría 
anteriormente el valor de la región mixta se sitúa entre estos dos 
valores. 

Los otros parámetros estadísticos no son tan relevantes para la 
diferenciación de regiones. Un conjunto de ellos no es de utilidad 
debido a que en las tres regiones se tienen unos valores muy similares. 
Estos parámetros son: Varianza, correlación y homogeneidad. En 
cambio, hay una serie de parámetros, no tan útiles como la energía y 
entropía, pero que sí que permiten diferenciar entre región 
homogénea y región heterogénea. El inconveniente de estos 
parámetros estadísticos es que no es posible diferenciar entre región 
heterogénea y región mixta ya que estas dos regiones quedan 
solapadas. Estos parámetros son: media, mediana, desviación. Además, 
los parámetros de máximo y mínimo las medias de las regiones sí que 
son diferentes entre ellas y servirían para poder diferenciar regiones, 
el inconveniente de estos dos parámetros es que muchos de los valores 
quedan solapados, por tanto, a pesar de que las medias sí que son 
diferentes podría no realizarse correctamente la diferenciación 
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Título Aplicación del software ImageJ en el análisis de imágenes médicas 

Lugar/es donde desarrolla/n el 
proyecto – Fotos del desarrollo 

Laboratorio ReAVi- área ILICo del centro CeReCoN, 4to piso edificio 
Dpto de electrónica. UTN - FRMendoza 

Institución/es requirente/s SECyT- UTN Mza 

Investigadores/Desarrolladores Césari Matilde 

María Cecilia CASTELLANOS - investigador formado 

Marcela FERNANDEZ - investigador formado 

Carolina PENNISI - investigador formado 

Eugenia ALFONSO - investigador apoyo 

Valeria ESPARTARO - investigador estudiante 

Resumen del contenido Aunque el campo de la segmentación de imágenes de RM del cerebro 
es uno de los  campos  donde  más  se  ha  trabajado  en  los  últimos  
años,  este  sigue siendo un problema todavía abierto 

En los últimos años, una de las aplicaciones que más se ha extendido 
en el campo del procesamiento de imagen biológica ha sido ImageJ, 
desarrollada en lenguaje Java por Wayne Rasband en el National 
Institutes of Health de Estados Unidos  

ImageJ es un programa informático de tratamiento digital de imagen 
orientado principalmente hacia el ámbito de las ciencias de la salud. 
Se trata de un software de dominio público y de código abierto. 
Incluye por defecto potentes herramientas para editar, procesar y 
analizar imágenes de casi cualquier tipo y formato. Sin embargo, su 
mayor virtud reside en su extensibilidad: las funcionalidades de 
ImageJ pueden ampliarse hasta resolver casi cualquier problema de 
tratamiento digital de imagen mediante macros, scripts y, 
especialmente, plugins programables en lenguaje Java gracias a la API 
que ofrece. 

Esta nueva funcionalidad se puede escribir en diferentes lenguajes, 
por lo que casi cualquier programador podría implementar sus 
aplicaciones sin necesidad de aprender un nuevo lenguaje, tomando 
como base las librerías de ImageJ, así como otros plugins previamente 
desarrollados por otros programadores. Todo esto puede 
desarrollarse ya sea mediante el editor incluido en ImageJ y un 
compilador Java, o con algún otro IDE como Netbeans o Eclipse 

Resultados obtenidos (cantidad 
– calidad) en función de los 
objetivos del proyecto 

Obj.2: Explorar el potencial de diversos métodos de análisis 
multivariados de datos y técnicas de inteligencia artificial para realizar 
la segmentación de imagen de resonancia magnética del cerebro, y 
extracción de Características que permitan discriminar entre 
regiones anormales y regiones sanas, a través de imágenes de prueba 
experimentales de estudios con imágenes existentes normales y con 
anomalías 
Res 1. Construcción del marco teórico sobre las herramientas 
accesibles para el análisis de las imágenes. Aquí se explican los 
resultados de estudios bibliográficos en relación a las herramientas 
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informáticas de código abierto o licencia libre para visualizar y el 
procesamiento y análisis de imágenes digitales médicas, tal como 
ImagenJ. 

Resultados Ver Anexo 01 

Res 2. Explicar de forma práctica los métodos estadísticos, basado en 
la agrupación de diferentes tonos de gris de acuerdo a datos 
estadísticos, como la media, moda, desviación estándar, distribución 
Gaussiana de probabilidad; Métodos multivariados factoriales para la 
obtención de clusters, de acuerdo a datos extraídos de la imagen; 
Técnicas de Lógica difusa (fuzzy logic), a través de la definición de 
funciones que determinan el grado de pertenencia, de acuerdo a 
intervalos de intensidad de tonos de gris que se pueden definir por 
medio de un histogramas de frecuencia de tonalidades de las 
diferentes áreas de interés, siendo una de las más importantes la 
denominada "fuzzy c-means a/gorithm [ ]; Técnicas de Redes 
Neuronales, a través de la identificación de patrones que cumplen con 
características de acuerdo al tipo de tejido que se desea aislar, donde 
se toman conjuntos de píxeles, los cuales son sometidos a un 
preprocesamiento para obtener características de textura de cada 
conjunto de píxeles, utilizando una matriz de coocurrencias. 

Resultados Ver Anexo 01 y 02 

Obj.4: Estudio preliminar del diseño y desarrollo de programas que 
implementen métodos de segmentación, que permita extraer una 
región de interés en imágenes cerebrales.  

Res 3. Diseño de una interfaz gráfica de usuario a través macros y 
pluing de ImageJ, que permite implementar técnicas de 
procesamiento de imagen, y realizar la segmentación de manera 
óptima, permitiendo el estudio de diferentes regiones de interés: 
región homogénea o fondo, región heterogénea y región mixta 

Resultados Ver Anexo 02 

Proyección de continuidad - 
transferencias 

Si bien Fiji fue pensado originalmente para los neurocientíficos (y 
sigue siéndolo), que acumuló una funcionalidad suficiente para atraer 
a científicos de una variedad de campos, como la biología celular, 
parasitología, genética, ciencias de la vida en general, la ciencia de 
materiales, etc. Como se indica en el sitio web oficial, el objetivo 
principal es "ciencias de la vida", aunque Fiji ofrece muchas 
herramientas que ayudan con el análisis de imagen científica en 
general. 

La aplicación de técnicas de clasificación automatizada mediante el 
aprendizaje automático (ML) y la inteligencia artificial (IA) ha 
demostrado constantemente una mayor precisión que la clasificación 
manual. Por lo tanto, proponer un sistema que realice la detección y 
la clasificación mediante el uso de algoritmos de aprendizaje sería útil 
para los médicos de todo el mundo. 

Conclusiones El software ImageJ es un programa de dominio público 
multiplataforma (existen versiones para Windows, Linux y Mac OS). 
Es muy útil y de gran diversidad para el procesamiento digital de 
imágenes, siendo utilizado incluso en numerosos proyectos de 
investigación 
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Esta aplicación soporta multitud de formatos de imagen, permitiendo 
mostrar, editar, analizar, procesar, guardar, e imprimir imágenes de 8 
bits (256 ´colores), 16 bits (miles de colores) y 32 bits (millones de 
colores), pudiendo leer diversos formatos de imagen como TIFF, PNG, 
GIF, JPEG, BMP, DICOM, FITS, así como formatos RAW. También 
soporta stacks (pilas) de imágenes; es multiproceso, de forma que las 
operaciones que requieren mucho tiempo se pueden realizar en 
paralelo en hardware multi-CPU.  

ImageJ puede calcular áreas y estadísticas, tanto de imágenes 
completas como de ROIs4, así como medir distancias y ángulos, y es 
compatible con las funciones estándar de procesamiento de imágenes 
tales como operaciones lógicas y aritméticas entre imágenes, 
manipulación de contraste, con-volucion, analisis de Fourier, nitidez, 
suavizado, deteccion debordes, filtrado de mediana, 
transformaciones geometricas5, etc. La figura muestra el aspecto de 
la interfaz gráfica deImageJ. 

Los plugins, principalmente desarrollados por usuarios, hacen posible 
resolver muchos y variados problemas de procesado y análisis de 
imágenes, desde imágenes en vivo de las células en tres dimensiones, 
procesado de imágenes radiológicas, comparaciones de múltiples 
datos de sistemas de imagen, hasta sistemas automáticos de 
hematología. También se puede usar como herramienta de enseñanza 

Por tanto, resulta de extraordinaria relevancia el desarrollo de 
macros que optimicen el funcionamiento de programas como el 
ImageJ, que pueden convertirse en valiosas herramientas de enorme 
aplicabilidad en el campo de la neuroimagen 

 

Título Reconocimiento de tejidos en imágenes de resonancia magnética de 
cerebro a través de modelo basado en reglas borrosas 

Lugar/es donde desarrolla/n el 
proyecto – Fotos del desarrollo 

Laboratorio ReAVi- área ILICo del centro CeReCoN, 4to piso edificio 
Dpto de electrónica. UTN - FRMendoza 

Institución/es requirente/s SECyT- UTN Mza 

Investigadores/Desarrolladores Césari Matilde – director 

María Cecilia CASTELLANOS - investigador formado 

Carolina PENNISI - investigador formado 

Ricardo Manuel CESARI - investigador apoyo 

Valeria ESPARTARO - investigador estudiante 

Resumen del contenido La principal ventaja de las imágenes de Resonancia Magnética (RM) 
es su capacidad para reconocer en ellas diferentes tipos de tejidos. 
Esto permite posteriores cuantificaciones para asistir en el 
diagnóstico de diferentes patologías. En este trabajo se utiliza Lógica 
Difusa para evaluar el grado de verdad de predicados que definen los 
distintos tejidos en base a las intensidades de gris que presentan las 
imágenes de RM pesadas en T1, T2  y PD. Estos predicados son de la 
forma “El tejido X es u1 en T1, u2 en T2, u3 en PD”, siendo u1, u2  y u3 
conjuntos difusos definidos en el rango de gris. Los predicados se 
elaboran inicialmente en conjunto con médicos especialistas en 
imágenes, por lo que intentan implementar las consideraciones que 
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ellos mismos aplican al identificar los tejidos que los píxeles de las 
imágenes representan. El objetivo es determinar qué tejido 
corresponde a cada píxel, abordando el problema como un sistema de 
soporte a las decisiones. El procesamiento de la imagen se realiza 
píxel a píxel. Se utilizan operadores para el cálculo de los conectivos 
“or”, “and” y la doble implicación basados en el paradigma 
recientemente desarrollado de la Lógica Compensatoria.   

Resultados obtenidos (cantidad 
– calidad) en función de los 
objetivos del proyecto 

Obj 3: Estudio preliminar de la aplicación de la metodología para la 
construcción de modelos a partir de imagen médica para detectar las 
diferencias de estructuras cerebrales.  

Res 1. Construcción del marco teórico sobre métodos estadísticos, 
métodos multivariados factoriales para la obtención de clusters, de 
acuerdo a datos extraídos de la imagen y técnicas de Lógica difusa 
(fuzzy logic). Aquí se explica los resultados de estudios bibliográficos 
en relación a la agrupación de diferentes tonos de gris de acuerdo a 
datos estadísticos, como la media, moda, desviación estándar, 
distribución Gaussiana de probabilidad; métodos multivariados 
factoriales para la obtención de clusters, de acuerdo a datos extraídos 
de la imagen; técnicas de Lógica difusa (fuzzy logic), a través de la 
definición de funciones que determinan el grado de pertenencia, de 
acuerdo a intervalos de intensidad de tonos de gris que se pueden 
definir por medio de un histogramas de frecuencia de tonalidades de 
las diferentes áreas de interés. 

Res 2. Desarrollo metodológico y obtención de un modelo de textura 
que es capaz de recoger la imprecisión asociada a la presencia de las 
distintas propiedades. Se introduce una semántica basada en las 
propiedades perceptuales, que permite representar términos 
lingüísticos similares a los empleados por el ser humano. 

Resultados Ver Anexo 03 

Proyección de continuidad - 
transferencias 

Se desarrolló una metodología para la obtención de modelos de 
textura que permiten adaptarse tanto a distintos perfiles de usuario, 
recogiendo así la percepción particular de dichos usuarios, como al 
contexto de la imagen a la cual pertenecen las texturas analizadas 

Conclusiones Una de las dificultades que se presenta en las imágenes de Resonancia 
Magnética es que hay un gran solapamiento entre las intensidades de 
gris que presentan diferentes sustancias. Es por ello, que un enfoque 
con técnicas que trabajen con la modelización de la vaguedad parece 
ser adecuadas, como es el caso de la que se propone en este trabajo 

El método ha sido exitosamente probado tanto con imágenes 
simuladas como con imágenes reales de cerebro para determinar 
líquido cefalorraquídeo, materia gris y materia blanca. Las 
operaciones involucradas son sencillas, por lo que el tiempo de 
procesamiento es corto, lo que lo hace adecuado y eficiente para 
trabajar en estudios 3D, donde debe procesarse una gran cantidad de 
imágenes 
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b) Producción en Investigación: 

 

Capítulos de libros 

Autor/autores Matilde Césari; Santiago Pérez; Higinio Facchin 

Capítulo/s “Innovación Digital para Medir Color Sensorial en Agroindustrias”, 
página 257 

Título del libro Libro de Actas Congreso Investigación y Educación en Ciencias de la 
Ingeniería Volumen 2. Capítulo II. Aplicaciones e Investigaciones en 
Ciencia  y  Tecnología. 

Editorial Universidad Tecnológica Nacional Facultad Regional Mendoza 

Compilador (si lo hubiere) Luis E. Gómez - Guillermo A. Cuadrado Dante R. Salatino 

Edición: Nacional o Internacional Nacional 

Código ISBN/ Año 978-950-42-0204-2 

Lugar de publicación Mendoza 

Palabras clave procesamiento digital de imagen, color sensorial, índice de color 

 
 

Capítulos de libros 

Autor/autores Matilde Césari; Santiago Pérez; Higinio Facchin 

Capítulo/s “Caso de Estudio: Procesamiento Digital de Imágenes para Medir 
Color en Zanahorias y Uva”, página 273 

Título del libro Libro de Actas Congreso Investigación y Educación en Ciencias de la 
Ingeniería Volumen 2. Capítulo II. Aplicaciones e Investigaciones en 
Ciencia  y  Tecnología. 

Editorial Universidad Tecnológica Nacional Facultad Regional Mendoza 

Compilador (si lo hubiere) Luis E. Gómez - Guillermo A. Cuadrado Dante R. Salatino 

Edición: Nacional o Internacional Nacional 

Código ISBN/ Año 978-950-42-0204-2 

Lugar de publicación Mendoza 

Palabras clave procesamiento digital de imagen, caso de estudio, índice de color 

 
 

Revistas 

Autor/autores Matilde Inés Césari , Nancy Beatriz Ventrera , Adriana Gámbaro  

Título del artículo Innovación Digital para medir el Color Sensorial en Agroalimentación 

Nombre de la Revista Revista IEEE América Latina 

http://www.ewh.ieee.org/reg/9/etrans/esp/ 

Fecha de Publicación 2020 

Con/Sin referato con 

Ámbito de la publicación Ciencias Agrarias 
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Código ISSN 1548-099 

Palabras clave color sensorial, procesamiento digital de imagen, espacio CIELab, 
índice de color 

 

Difusión en Congresos, Simposios, reuniones científicas, conferencias 

Título del trabajo El modelado flexible de la investigación en Ingeniería (Path Modeling) 

Institución organizadora UTN 

Nombre del evento ENIDI 2019 “X Encuentro de Investigadores y Docentes de 
Ingeniería” 

Carácter expositor 

Fecha 9, 10 y 11 de octubre 2019 

Lugar Mendoza 

Autores de la presentación Matilde Césari & Ricardo Césari 

Publicado en actas, memorias – 
(páginas) 

Libro de Actas X EnIDI. En Área de Tecnologías Emergentes, página 
489 

Con/Sin referato sin 

Año 2020 

Comité científico Pérez, Mauricio Área Bioingeniería e Ingeniería Clínica 

Scotti, Adalgisa Área Bioingeniería e Ingeniería Clínica 

Cremades, Hebe Área Energía, Ambiente, Minería y Petróleo 

Membrives Barrachina, Francisco Área Energía, Ambiente, Minería 
y Petróleo 

Núñez, Ana María Área Enseñanza de la Ingeniería 

Raichman, Silvia Área Enseñanza de la Ingeniería 

Roggiero, Augusto Área Enseñanza de la Ingeniería 

Talío, Fabián Área Informática, Sistemas, Computación y 
Electrónica 

Careglio, Claudio Área Ingeniería Civil, Materiales y Agrimensura 

Tornello, Miguel Área Ingeniería Civil, Materiales y Agrimensura 

Millán, Daniel Área Ingeniería Eléctrica, Mecánica, Electromecánica 
y Electrónica 

Pessano, Gabriel Área Ingeniería Eléctrica, Mecánica, 
Electromecánica y Electrónica 

Barón, Iván Área Ingeniería Industrial 

Cisneros, Héctor Área Ingeniería Industrial 

Palma, Ricardo Área Ingeniería Industrial 

Cabeza, María Silvina Área Ingeniería Química y Biotecnología 

Ninago, Mario Área Ingeniería Química y Biotecnología 

Valente, Graciela Área Ingeniería Química y Biotecnología 

Narambuena, Claudio Área Ingeniería Química y Biotecnología 

Cabeza, María Silvina Área Ingeniería y Ciencias de los Alimentos 

Maldonado, Mariela Área Ingeniería y Ciencias de los Alimentos 
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Millán, Daniel Tecnologías Emergentes 

Quiles, Angel Tecnologías Emergentes 

Soengas, Cecilia Coordinadora General 

Cabeza, María Silvina Coordinadora General 

Gitto, Javier Coordinador General 

Institución UTN- FRM 

Palabras clave Modelado Path Modeling – diagrama de trayectorias – variables 
manifiestas y latentes 

 

Difusión en Congresos, Simposios, reuniones científicas, conferencias 

Título del trabajo Desarrollo de una metodología con técnicas y herramientas de 
procesamiento digital de imagen, de apoyo al profesional de salud 
para detección de tumores cerebrales en imágenes resonancia 
magnética 

Institución organizadora UTN 

Nombre del evento ENIDI 2019 “X Encuentro de Investigadores y Docentes de 
Ingeniería” 

Carácter Poster: DOI: 10.13140/RG.2.2.14184.01287 

Fecha 9, 10 y 11 de octubre 2019 

Lugar Mendoza 

Autores de la presentación Matilde Inés Césari, Ricardo Césari, María Cecilia Castellanos, 
Carolina Pennisi, Eugenia Alfonso, Silvana, Sander, Valeria 
Espartaro y María Eugenia Stefanoni 

Publicado en actas, memorias – 
(páginas) 

Libro de Actas X EnIDI. En Área de Bioingeniría, página 66 

Con/Sin referato sin 

Año 220 

Comité científico Pérez, Mauricio Área Bioingeniería e Ingeniería Clínica 

Scotti, Adalgisa Área Bioingeniería e Ingeniería Clínica 

Cremades, Hebe Área Energía, Ambiente, Minería y Petróleo 

Membrives Barrachina, Francisco Área Energía, Ambiente, Minería 
y Petróleo 

Núñez, Ana María Área Enseñanza de la Ingeniería 

Raichman, Silvia Área Enseñanza de la Ingeniería 

Roggiero, Augusto Área Enseñanza de la Ingeniería 

Talío, Fabián Área Informática, Sistemas, Computación y 
Electrónica 

Careglio, Claudio Área Ingeniería Civil, Materiales y Agrimensura 

Tornello, Miguel Área Ingeniería Civil, Materiales y Agrimensura 

Millán, Daniel Área Ingeniería Eléctrica, Mecánica, Electromecánica 
y Electrónica 

Pessano, Gabriel Área Ingeniería Eléctrica, Mecánica, 
Electromecánica y Electrónica 
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Barón, Iván Área Ingeniería Industrial 

Cisneros, Héctor Área Ingeniería Industrial 

Palma, Ricardo Área Ingeniería Industrial 

Cabeza, María Silvina Área Ingeniería Química y Biotecnología 

Ninago, Mario Área Ingeniería Química y Biotecnología 

Valente, Graciela Área Ingeniería Química y Biotecnología 

Narambuena, Claudio Área Ingeniería Química y Biotecnología 

Cabeza, María Silvina Área Ingeniería y Ciencias de los Alimentos 

Maldonado, Mariela Área Ingeniería y Ciencias de los Alimentos 

Millán, Daniel Tecnologías Emergentes 

Quiles, Angel Tecnologías Emergentes 

Soengas, Cecilia Coordinadora General 

Cabeza, María Silvina Coordinadora General 

Gitto, Javier Coordinador General 

Institución UTN-FRM 

Palabras clave neuroimagen, segmentación de imágenes médicas, reconocimiento 
de patrones, métodos multivariados, inteligencia artificial, 
ingeniería del conocimiento 

 

Difusión en Congresos, Simposios, reuniones científicas, conferencias 

Título del trabajo Revisión de Algoritmos de análisis de Imágenes digitales con ImageJ. 
Fiji 

Institución organizadora INSTITUTO INTERNACIONAL DESPERTANDO VOCAÇÕES (IIDV). 

Nombre del evento COINTER PDVGT 2020 - IV CONGRESSO INTERNACIONAL DE 
GESTÃO E 

TECNOLOGIAS - COINTER PDVGT 2020 

Carácter Charla plenaria 

Fecha 2 y 5 de diciembre 2020 

Lugar forma ONLINE, a través de plataforma SMART EVENT 

Autores de la presentación Matilde Inés Césari 

 

Difusión en Congresos, Simposios, reuniones científicas, conferencias 

Título del trabajo Innovación Digital para Medir Color Sensorial en Agroindustrias 

Institución organizadora UTN-FRM 

Nombre del evento VI Congreso Internacional de Educadores en Ciencias Empíricas en 
Facultades de Ingeniería ECEFI 2020 

Carácter expositor 

Fecha martes 24 y miércoles 25 de noviembre 2020 

Lugar Mendoza - online 

Autores de la presentación Matilde Césari; Santiago Pérez; Higinio Facchini 
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Publicado en actas, memorias – 
(páginas) 

Volumen 2. Capítulo II. Aplicaciones e Investigaciones en Ciencia  y  
Tecnología 

página 257 

Con/Sin referato sin 

Año 2021 

Comité científico Luis E. Gómez - Guillermo A. Cuadrado Dante R. Salatino 

Institución Universidad Tecnológica Nacional Facultad Regional Mendoza 

Palabras clave procesamiento digital de imagen, color sensorial, índice de color 

 

Difusión en Congresos, Simposios, reuniones científicas, conferencias 

Título del trabajo Caso de Estudio: Procesamiento Digital de Imágenes para Medir Color 
en Zanahorias y Uva 

Institución organizadora UTN-FRM 

Nombre del evento VI Congreso Internacional de Educadores en Ciencias Empíricas en 
Facultades de Ingeniería ECEFI 2020 

Carácter exposición 

Fecha martes 24 y miércoles 25 de noviembre 2020 

Lugar Mendoza - online 

Autores de la presentación Matilde Césari; Santiago Pérez; Higinio Facchini 

Publicado en actas, memorias – 
(páginas) 

Volumen 2. Capítulo II. Aplicaciones e Investigaciones en Ciencia  y  
Tecnología 

página 271 

Con/Sin referato sin 

Año 2021 

Comité científico Luis E. Gómez - Guillermo A. Cuadrado Dante R. Salatino 

Institución Universidad Tecnológica Nacional Facultad Regional Mendoza 

Palabras clave procesamiento digital de imagen, caso de estudio, índice de color 

 

Difusión en Congresos, Simposios, reuniones científicas, conferencias 

Título del trabajo Aplicación del software ImageJ en el análisis de imágenes médicas 

Institución organizadora UTN-FRM 

Nombre del evento “1er. Congreso Interuniversitario I+D+i Mendoza” organizado por 
las Universidades de la Provincia de Mendoza, en modalidad híbrida 
(presencialidad y virtualidad) 

Carácter Póster DOI: 10.13140/RG.2.2.28366.54084 

Fecha 24 al 26 de Noviembre de 2021 

Lugar Mendoza - online 

Autores de la presentación Matilde Inés Césari; Valeria Espartaro; Marcela Fernández; María 
Cecilia Castellanos; Carolina Pennisi; Eugenia Alfonso 
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Difusión en Congresos, Simposios, reuniones científicas, conferencias 

Título del trabajo Aplicación del software ImageJ en el análisis de imágenes médicas 

Institución organizadora UTN-FRT 

Nombre del evento “Semana de la Ingeniería 2022  Nacional e Internacional.”.  

Carácter Clase plenaria 

Fecha 6 al 11 de junio 2022 

Lugar Tucumán 

Autores de la presentación Matilde Inés Césari; Valeria Espartaro; Marcela Fernández; María 
Cecilia Castellanos; Carolina Pennisi; Eugenia Alfonso 

 
 

Difusión en Congresos, Simposios, reuniones científicas, conferencias 

Título del trabajo Uso del software ImageJ en análisis de imágenes médicas 

Institución organizadora CONFEDU y UTN FRResistencia 

Nombre del evento 6° Congreso Argentino de Ingeniería y 12° Congreso Argentino de 
Enseñanza de Ingeniería 

Carácter póster 

Fecha 7, 8 y 9 de septiembre 2022 

Lugar Resistencia (Chaco) y Corrientes (Capital) 

Autores de la presentación Césari, Matilde; Espartaro, Valeria 

Palabras clave Procesamiento digital de imágenes médicas, software ImageJ 

 
La documentación probatoria de lo declarado se incorporará a un CD/DVD para ser enviada 
acompañando al Informe Final presentado. 
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d) Becarios: 
 

Apellido y Nombre Valeria Espartaro 

Tipo de beca Beca I+D alumnos 

Fecha de inicio 1er semestre 2019 

Fecha de finalización 2do semestre 2020 

 

Apellido y Nombre REYNOSO, Sebastián 

Tipo de beca Beca I+D alumnos 

Fecha de inicio Setiembre  2020 

Fecha de finalización Diciembre  2020 

 
 
3. GESTIÓN DEL PROYECTO (Para ser informado por el Director) 
  

Tareas Desarrolladas: 
 
Si tuvo dificultades en el  desarrollo de las tareas previstas  en este proyecto de investigación le 
agradeceremos que indique: 

Problemas de ejecución del 
presupuesto 

En primer lugar, el sistema de compra es ineficiente, antes y después de la 
pandemia no se pudo usar presupuesto solo para algún reintegro por 
inscripción a congresos. Reintegros de capacitación, bibliografía y 
equipamiento fueron imposibles por las tantas piedras y los tiempos 
excesivos que tiene el actual sistema para acceder al presupuesto.  

En segundo lugar, la crisis que comenzó en el 2019, hizo que el presupuesto 
quedara absolutamente devaluado y muy poco se podía hacer y muchos 
objetivos se acomodaron por ésto. 

Problemas con los 
integrantes 

Los alumnos asociados al proyecto final de la carrera de electrónica 
abandonaron, para cuando llegó la homologación no fue posible ubicarlos. 

Especificar otros La modelización y el trabajo con técnicas de aprendizaje de máquina es 
muy limitada y escasa por falta de máquina o servicios en la nube con 
performance suficiente para alto procesamiento de imágenes. 

También acceder a expertos e instituciones fuera de la universidad fue 
imposible por la pandemia, luego los contactos se perdieron y las 
experimentaciones se redujeron a trabajar solo con imágenes de 
repositorios y no se pudo llevar a cabo objetivos que implicaba la educción 
de conocimientos de expertos. 

Tampoco se pudo cumplir con el objetivo: explorar el potencial de los 
modelos PLS (PLS-Path Modeling), para la comparación visual y 
documentada de las regiones localizadas que se obtienen con los métodos 
y algoritmos computacionales utilizados vs. las interpretaciones de los 
especialistas, a través de casos experimentales de estudios con imágenes 
existentes normales y con anomalías, mediante un enfoque de variables 
latentes que utiliza las siguientes herramientas estadísticas: regresión 
logística, modelación multinivel y análisis de componentes principales”, se 
pudo hacer una revisión del método y construir un marco teórico pero sin 
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acceso a especialistas en neuroimagen no se pudo  desarrollo preliminar 
de un modelo genérico básico de predicción a través de técnicas de 
ingeniería de sistemas basados en conocimiento borroso y modelos PLS 
(PLS-Path Modeling), que incluyan además de la las características de la 
imagen RM,  aquellos datos circulantes que sean relevantes para establecer 
la probabilidad de que esté presente un cambio patológico o una condición 
biológica anómala que sea relevante para el paciente y su enfermedad. 

Monto del financiamiento 
recibido durante el 
desarrollo del proyecto 

$ 69.000,00 

Porcentaje de metas 
cumplidas respecto a los 
objetivos propuestos en el 
proyecto acreditado 

80% 

Agentes facilitadores (si los 
hubiere) 

      

 
 
Evaluación de los integrantes: 
 

Nómina del personal que interviene en el proyecto 

Nº Apellido y Nombre 
Evaluación 
Director (*) 

1 María Cecilia CASTELLANOS Satisfactorio 

2 Marcela FERNANDEZ Satisfactorio  

3 Carolina PENNISI Satisfactorio  

4 Eugenia ALFONSO Satisfactorio  

5 Silvana SANDER Satisfactorio  

6 María Eugenia STEFANONI Satisfactorio  

7 Ricardo Manuel CESARI Satisfactorio  

8 Valeria ESPARTARO Satisfactorio  

9 SANCHEZ, Franco baja 

10 DEBLASIS, Rodrigo Damián baja 

11 ROLANDO LOPEZ, Mauro Agustin baja 

 
Nota: El Director es responsable de la asignación de tareas del proyecto por lo que se sugiere revisar si 
corresponden a cada investigador las tareas informadas. 
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Resultados obtenidos 

 

● Estrategia metodológica para el reconocimiento de patrones y creación de modelos a partir de 
imágenes digitales cerebrales, tomada mediante la tecnología de resonancia magnética y sin el 
empleo de algún medio de contraste radiológico, permite resaltar regiones con posibles anomalías, 
en base a técnicas de procesamiento digital de imagen para la segmentación y extracción de 
características, a través de la herramienta Fii Imagen J y varios pluing y macros construidas a tal 
fin.  
La metodología se basa en los siguientes pilares:  
A. Extracción del espacio intracraneal  

o Se aplica la LUT’s o paletas de color para visualizar los valores de una sola banda en color 
facilitando el análisis visual 

o La eliminar de las imágenes todos aquellos tejidos que se encuentran fuera del espacio 
intracraneal (hueso, la grasa y la piel) 

B. Segmentación de imágenes de RM cerebral 
o Se aplica técnica de mejoramiento de la imagen (ecualización del histograma).  
o Luego se aplica el Simple Linear Iterative Clustering (SLIC) para obtener las imágenes de 

superpixeles. 
o Finalmente se extraen características de textura, más 1 variable de clase que se obtiene 

empleando las imágenes etiquetadas manualmente. 
C. Clasificación supervisada 

o Construcción de modelos de clasificación supervisada de superpixeles con técnicas de IA. 
● Estrategia metodológica para la obtención de modelos que permitan representar distintos 

términos lingüísticos asociados a las propiedades perceptuales, pudiendo ser adaptados tanto a 
distintos perfiles de usuario como al contexto de la imagen 

 
Conclusiones  

La utilización del diagnóstico por la imagen ha puesto de manifiesto la necesidad de establecer 
procedimientos para garantizar la seguridad del paciente, reducir en la medida de lo posible su exposición a 
cantidades excesivas de radiación y evitar la repetición innecesaria de estudios , así como establecer en la 
práctica médica criterios de indicación de diferentes tipos de estudios disponibles para racionalizar su 
demanda y favorecer la utilización adecuada de los mismos (se considera que entre un 10% y un 40% de los 
estudios de diagnóstico por imagen pueden ser inadecuados y no contribuyen al diagnóstico clínico del 
paciente). 
Con la obtención de la imagen, el médico puede establecer un tratamiento o por lo menos identificar el 
problema y realizar las pruebas más profundas a quienes realmente lo necesiten, evitando gastos 
innecesarios. La imagenología comprende la realización de todo tipo de exámenes diagnósticos y 
terapéuticos, en los cuales se utilizan equipos que reproducen imágenes del organismo.  
El diagnóstico médico a partir de imágenes médicas digitales en numerosas ocasiones tiene una gran 
influencia subjetiva, ya que generalmente se basa en la extracción de determinada información o elementos 
simples sobre fondos complejos. Por esta razón, factores como la dificultad en la percepción de la imagen, 
determinación de características relevantes, condiciones de visualización, experiencia médica, entre otros 
pueden ocasionar lo que se denomina inconsistencia diagnóstica 
El proceso de la segmentación de imagen tiene como objetivo establecer regiones en la misma, donde cada 
región es homogénea en relación a una característica determinada. En el ámbito del procesamiento de 
imágenes médicas, es una herramienta de importancia, cuyas aplicaciones incluyen simulaciones de cirugía, 
medición de volumen de tumores, clasificación de células sanguíneas, estudios de desarrollo cerebral, 
detección de microcalcificaciones en mamografías y detección de tumores. 
La idea central en el reconocimiento de patrones es la simulación de la percepción humana, lo que no implica 
reconstruir en forma exacta los algoritmos utilizados, sino simplemente se intenta alcanzar resultados 
similares. 
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El proceso de segmentación permite aumentar la calidad de la información que entregan las imágenes de 
Resonancia Magnética. Por otra parte, los procesos de segmentación poseen una capacidad de identificación 
de los diferentes tipos de tejidos muy alta. La textura es uno de los elementos utilizados en la interpretación 
visual de imágenes de sensores remotos y ha sido utilizada experimentalmente en análisis automatizados de 
imágenes. En particular el reconocimiento de patrones espaciales en base a textura, es realizado con cierta 
facilidad por el experto, pero es difícil de automatizar sobre una computadora. 
El análisis de texturas ofrece información cuantitativa de aspectos de las imágenes que habitualmente se 
valoran de forma subjetiva, como la heterogeneidad de las mismas, la cantidad de información, la 
repetitividad de patrones, etc. Es conocido que los tumores más agresivos son aquellos que presentan 
aspectos más heterogéneos, donde coexisten zonas de alta proliferación celular, alta vascularización, 
necrosis, edema, etc. Todo esto causa que las imágenes tengan patrones caóticos que en términos cualitativos 
se pueden definir como heterogeneidad. Disponer de los métodos adecuados para medir esta heterogeneidad 
podría ayudar a caracterizar mejor estos tumores y determinar el pronóstico de los pacientes. 
Con el fin de ayudar a los radiólogos y cirujanos en una planificación fiable de la intervención, es necesario 
nuevos métodos y herramientas precisas y eficientes para localizar y segmentar adecuadamente el órgano 
de interés y las patologías presentes 
Se aborda el modelado de las propiedades perceptuales de textura mediante conjuntos difusos, lo 
que permite representar la imprecisión asociada a la presencia de dichas propiedades. Estos conjuntos 
difusos se definen sobre el dominio de medidas computacionales de las propiedades de textura, y su función 
de pertenencia se obtiene relacionando los valores calculados a partir de dichas medidas 
con la percepción humana de la propiedad correspondiente. Se propone la obtención tanto de modelos 
genéricos, que pueden ser aplicados, aunque no se disponga de ninguna información adicional, como de 
modelos que permiten adaptarse al perfil particular de distintos usuarios o al contexto de la imagen. 
Los métodos de detección de anomalías pueden ayudar a los especialistas a encontrar, de una forma más 
rápida y segura, determinado tipo de lesiones en las imágenes obtenidas de los pacientes. Adicionalmente, 
estos algoritmos pueden ser empleados en la clasificación de enormes bases de datos para obtener imágenes 
útiles para la investigación y la impartición de docencia. En el campo de la telemedicina, pueden emplearse 
para preservar regiones de interés clínico, y compactar el resto de la imagen a una tasa de compresión 
elevada y con pérdidas, logrando así archivos más pequeños y adecuados para almacenar y transmitir por 
redes con anchos de banda limitados. 
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Técnicas de procesamiento digital de imágenes médicas 

El proceso digital de imágenes es el uso de los algoritmos informáticos para realizar el procesamiento 
de imágenes en imágenes digitales. La técnica de segmentación de imágenes se utiliza para dividir a 
una imagen en partes significativas que tienen características y propiedades similares, el objetivo 
principal de la segmentación es la simplificación, es decir representar una imagen de manera 
significativa y fácilmente analizable, la segmentación de imágenes es el primer paso necesario en el 
análisis de imágenes.  

Las aplicaciones básicas de la segmentación de imágenes; • Recuperación de imágenes basadas en 
contenido. • Imágenes médicas. • Detección de objetos y tareas de reconocimientos. • Sistemas 
automáticos de control de tráfico y video vigilancia etc. 

El cerebro es un órgano fundamental del cuerpo humano, es el órgano con el que más cuidado se 
debe tener, lo que ha despertado gran interés en su estudio tanto para la investigación como para 
prevención de posibles anomalías presentes en el mismo [1]. Un tumor cerebral es un crecimiento 
descontrolado de células derivadas de componentes cerebrales (tumores primarios) o de células 
tumorales localizadas en otras áreas del organismo (metástasis). 

Los tumores pueden ser benignos o malignos, dependiendo de la rapidez de su crecimiento y de si 
logran resecarse o curarse mediante el tratamiento neuroquirúrgico. A diferencia de los tumores de 
otros tejidos, la distinción entre manifestaciones benignas y malignas no es tan clara, por ejemplo, 
algunas lesiones benignas pueden infiltrar regiones enteras con comportamiento clínico maligno. 

Una gran parte de los adelantos tecnológicos en el campo de la medicina resultan en la manipulación 
y tratamiento de imágenes digitales, estas imágenes se pueden obtener a partir de radiografías, 
ecografías, tomografías y resonancias magnéticas, el experto humano realiza un diagnóstico a partir 
de estas imágenes pero puede haber factores como la gran cantidad de imágenes, la ocultación de 
objetos debido al paso de 3D a 2D, lesiones difícilmente visibles al ojo humano debido a su reducido 
tamaño, subjetividad en la interpretación, cansancio y falta de concentración que pueden influir en 
el diagnóstico final del experto humano, lo cual resultaría peligroso para el paciente [2]. 

En el campo de las tomografías computarizadas el experto radiólogo realiza un diagnosticó de 
normalidad o anormalidad de estudios a pacientes, este estudio es subjetivo, dependiendo en su 
mayoría de la experiencia del experto e influenciado por factores como cansancio, fatiga y efectos 
visuales. 

Los tumores cerebrales son complejos. Hay muchas anomalías en los tamaños y la ubicación de los 
tumores cerebrales. Esto hace que sea realmente difícil para la comprensión completa de la 
naturaleza del tumor. Además, se requiere un neurocirujano profesional para el análisis de 
resonancia magnética. Muchas veces en los países en desarrollo, la falta de médicos hábiles y la falta 
de conocimiento sobre los tumores hace que sea realmente difícil y lento generar informes a partir 
de la resonancia magnética. 

Los primeros trabajos en diagnóstico asistido por computador, más comúnmente denominado CAD 
(Computer Aided Diagnosis), se registran por la década de los 60. Al principio, la comunidad científica 
los concibió como sistemas de diagnóstico automático con la convicción de que podrían diagnosticar 
enfermedades sin ayuda de los expertos humanos. Sin embargo, con el tiempo estas expectativas se 
fueron diluyendo teniendo en cuenta que por aquel tiempo aún no se contaba con la tecnología tanto 
de software como de hardware necesaria.  

Durante ese periodo también se desarrollaban nuevas técnicas de IA en el área de la Ingeniería del 
conocimiento; esto logro conocer mejor el proceso de un experto al realizar un diagnóstico médico, 
que consiste en, examina los datos de un paciente, platear una hipótesis de un determinado 
diagnóstico, posteriormente examina otros datos para ir refinando la hipótesis y comprobar o 
descartar su validez, comparándola con otros procesos de características similares o cercanas [3]. 

Más tarde por los años 80, surgió otro enfoque más realista que planteaba la salida del computador 
como una segunda opinión diagnóstica con el objetivo de aumentar la precisión del diagnóstico, 
aunque sería el experto humano quien tomase la decisión final. 

Con el tiempo este nuevo enfoque fue evolucionado positivamente y para el año 1990 se presentó el 
primer trabajo sobre sistemas CAD en donde se afirmaba que su empleo había aportado una mejora 
estadísticamente significativa al diagnóstico de cáncer de seno [4], después se publicaría sobre los 
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beneficios de CAD en otro tipo de lesiones como microcalcificaciones agrupadas, masas en 
mamografías, nódulos pulmonares, aneurismas y radiografía de tórax [5]. De esta forma CAD ha 
evolucionado positivamente a lo largo del tiempo en cuanto a detección de lesiones en imagen 
médica. 

En el transcurso de los a´ nos 80 y 90 surgieron nuevos sistemas expertos que incorporaban el Deep 
Learning, así como nuevas capacidades de razonamiento incorporando nuevos modelos; sin 
embargo, el impacto no fue tan notable desde el punto de vista clínico como lo fue en lo académico y 
tecnológico [6]. 

CAD generalmente es definido como “sistemas que realizan un análisis cuantitativo sobre la imagen 
médica y su resultado se tiene en cuenta por un especialista al momento de emitir un diagnóstico” 
[7].  

Hoy en día el único método definitivo para confirmar la presencia de la mayoría de tipos de cáncer, 
así como también para clasificarlos, es según Raphael et al. [8] un análisis histopatológico de una 
biopsia o muestra de tejido, ya que este permite visualizar claramente el estado de la enfermedad 
además de ayudar con la formulación de un tratamiento más adecuado, en este sentido se han 
realizado diversas investigaciones sobre sistemas CAD para el análisis de imágenes histopatológicas. 
Los objetivos en este aspecto son ambiciosos ya que no solo se intenta crear sistemas que ayuden 
con la detección y clasificación de la enfermedad sino que además puedan cuantificarla, debido a la 
necesidad de conocer con más precisión el estado del cáncer para mejorar su estimación y predecir 
su progreso. 

El análisis de textura es una herramienta muy útil para obtener información sobre imágenes médicas. 
Éste análisis tiene muchas aplicaciones en la práctica clínica, algunos ejemplos son la segmentación 
de estructuras anatómicas y la detección de lesiones como puede ser un tumor [9;10;11]. 

El concepto de textura en una imagen se puede considerar como la distribución de los valores de 
niveles de gris entre los pixeles que forman una región de interés en una imagen. Este concepto 
planteado se puede representar como un mapa tridimensional basado en los valores de los pixeles. 
Es por tanto que el análisis de textura es una herramienta utilizada para la evaluación de la intensidad 
y la posición de los pixeles en una imagen. Las características de la textura son parámetros 
matemáticos que han sido calculados a partir de la distribución de los pixeles. Hay diferentes formas 
de obtener un análisis de textura, estas se diferencian en la manera de medir las interrelaciones entre 
los pixeles. Los 4 métodos para obtener un análisis de textura son: 1. Métodos estructurales 2. 
Métodos basados en modelos 3. Métodos estadísticos 4. Métodos de transformación [12]. 

Los métodos estadísticos se basan en representar la textura usando propiedades que regulan tanto 
la distribución como las relaciones entre los valores de niveles de gris. Los parámetros de textura 
más utilizados provienen de las categorías principales que se detallan a continuación: Histograma, 
Gradiente absoluto, Matriz de largo recorrido, Matriz de co-ocurrencia [13]. 

 

El análisis de texturas aporta información hasta ahora desconocida. A partir de una serie de datos no 
considerados puede extraerse información relevante, además ésta puede correlacionarse 
estadísticamente con resultados extraídos de una biopsia para marcar unos parámetros 
determinantes y unos umbrales. De este modo al hacer el estudio y relacionar las texturas con la 
tipología de la lesión se puede acelerar el proceso de diagnóstico y tomar unas decisiones de 
tratamiento más dirigidas a la lesión específica. 

 

Antecedentes del diagnóstico de cáncer cerebral asistido por computador 

▪ Araneda Fuentes, C., & Tapia Vilches, I. (2020). Revisión sistemática exploratoria: diagnóstico 
asistido por computadora con uso de inteligencia artificial en imagenología maxilofacial (Doctoral 
dissertation, Universidad Andrés Bello). 

Objetivo: Explorar el uso y viabilidad de la Inteligencia Artificial en el campo de la 
Imagenología Maxilofacial (u odontología) ante la incorporación de la era digital a la 
práctica clínica. Demostrar si la literatura disponible la califica como un método realmente 
efectivo. Materiales y métodos: Revisión Sistémica Exploratoria. 



Informe de Avance y/o Final 2020 Anexo 00 CCUTIME0005279TC 

 

CESARI Matilde Inés 3 
 
 

▪ Díaz Caceres, M. L. (2020). Comparación entre el análisis automático y manual del volumen del 
hematoma intraparenquimal en una tomografía cerebral en un Hospital de Lima Metropolitana. 

Compara el análisis automático y manual del volumen del hematoma intraparenquimal en imágenes de 
tomografía cerebral de una institución de Lima Metropolitana entre los años de 2019-2020. Realiza un 
estudio observacional, analítico y prospectivo, se incluyó 100 estudios tomográficos de cerebro de 
pacientes con diagnóstico de hematoma intraparenquimal entre diciembre del 2019 a abril del 2020. Para 
el análisis inferencial, se utilizó la prueba no paramétrica Wilcoxon, considerando una diferencia 
significativa cuando el valor de p fue menor a 0.05. Encuentra que el volumen del hematoma 
intraparenquimal mediante el análisis automático en tomografía cerebral tuvo una mediana de 27.86 cm3. 
El volumen del hematoma intraparenquimal mediante el análisis manual en tomografía cerebral tuvo una 
mediana de 24.09 cm3. Asimismo, la mediana del volumen del hematoma intraparenquimal mediante el 
análisis automatizado fue 43.55 cm3 en sexo femenino y 21.56 cm3 en sexo masculino, mientras que la 
mediana del volumen del hematoma intraparenquimal mediante el análisis manual fue 39.64 cm3 en sexo 
femenino y 17.76 cm3 en sexo masculino. Según edad, la mediana del volumen del hematoma 
intraparenquimal mediante el análisis automatizado fue 31.81 cm3 en aquellos con 18 a 39 años y 26.19 
cm3 en aquellos con 40 a 59 años. En cambio, la mediana del volumen del hematoma intraparenquimal 
mediante el análisis manual fue 28.83cm3 aquellos con 18 a 39 años y 23.71 cm3 en aquellos con 40 a 59 
años. El volumen del hematoma intraparenquimal mediante el análisis automático y el análisis manual 
tuvieron diferencias estadísticamente (p=0.000). Concluye que existe diferencias significativas entre el 
análisis automático y el análisis manual del volumen del hematoma intraparenquimal en imágenes de 
tomografía cerebral de una institución de Lima Metropolitana entre los años de 2019-2020. 

▪ Limache Calatayud, R. E. (2016). Un enfoque híbrido para la clasificación de imágenes de 
Resonancia Magnética del Cerebro. 

El tumor cerebral es una de las principales causas de mortalidad entre niños y adultos en todo el mundo. 
Un tumor es una masa de tejido que crece fuera de control, los tumores pueden ser benignos o malignos 
(cáncer), dependiendo de la rapidez de su crecimiento y de si logran resecarse o curarse mediante el 
tratamiento neuro-quirurgico. Para diagnosticar un cáncer se realizan diferentes pruebas como 
radiografías, tomografías, ecografías o resonancias magnéticas. Mediante estas pruebas pueden detectarse 
zonas con alta sospecha tumoral, cuyo diagnostico debe confirmarse mediante la realización de una 
biopsia. Estas imágenes no son fáciles de interpretar, lo que provoca que el profesional encargado de 
analizarlas, a pesar de su experiencia no sea capaz de detectar en ellas un porcentaje importante de 
tumores. Una posibilidad para mejorar el diagnostico consiste en utilizar sistemas de diagnostico asistido 
por computador (CAD). Un CAD analiza la imagen medica y trata de detectar zonas sospechosas de 
contener alguna anomalía. Entonces el radiólogo va poder interpretar con menos dificultad la información 
contenida en la imagen medica. El diagnostico asistido por computador es aún una tecnología muy joven, 
es por ello que en esta tesis se ha propuesto una técnica hibrida formado por una red neuronal y un 
algoritmo gen ético para detectar en una imagen de resonancia magnética si tiene o no una anomalía. Para 
la etapa de extracción de características se ha utilizado la técnica de Gabor, y para la etapa de clasificación 
se va usar una red neuronal MLP (perceptron multicapa) con un algoritmo gen ético simple. Los resultados 
de aplicar el enfoque a la data de prueba muestran ser prometedores 

▪ Pérez Ramírez, M. Ú. (2015). Algoritmo de detección de metástasis cerebrales en imágenes de 
resonancia magnética mediante el uso de plantillas tridimensionales de apariencia tumoral. 

El tumor cerebral es un crecimiento celular patológico intracerebral. Puede destruir directamente la 
población celular normal o dañarla indirectamente por invadir otras partes y causar inflamación, edema 
cerebral y presión intracraneal. Las metástasis cerebrales son depósitos celulares originados en otro 
órgano y emigrados posteriormente al cerebro. En España aparecen cada año 165.000 nuevos casos de 
cáncer y de ellos, más de 30.000 (en torno al 18%) sufren metástasis cerebrales, causa significante de 
morbilidad y mortalidad. Unos 6.000 pacientes, la quinta parte, presentan metástasis encefálicas menores 
de 30 mm y pueden beneficiarse de la radiocirugía guiada por la imagen [1]. La motivación de este trabajo 
reside en que la detección temprana de las metástasis cerebrales incrementa la supervivencia, ya que el 
tratamiento más utilizado es la radiocirugía guiada por la imagen. Como apoyo al diagnóstico radiológico 
se emplea el Diagnóstico Asistido por Ordenador (Computer Assisted Diagnosis, CAD) que ofrece una 
metodología cuantitativa, gran reproducibilidad y fiabilidad. Con esta idea en mente, el objetivo de este 
Trabajo Fin de Máster es el desarrollo de un algoritmo que permita la detección de metástasis cerebrales 
a partir del análisis de imagen de resonancia magnética, enfatizando la reducción de falsos positivos. Para 
el procesado y análisis de las imágenes se ha utilizado la herramienta MATLAB. Con el fin de lograr la 
detección de metástasis cerebrales, se correlacionaron unas plantillas tridimensionales sintéticas de 
apariencia tumoral con el volumen de imágenes y se aplicó un umbral de similitud. Posteriormente, se 
segmentaron las detecciones y se aplicaron algoritmos para el cálculo del grado de anisotropía con el 
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objetivo de eliminar estructuras elongadas como vasos sanguíneos. Este Trabajo Fin de Máster se ha 
desarrollado en el Centro de Biomateriales e Ingeniería Tisular de la Universitat Politècnica de València, 
en estrecha colaboración con el Servicio de Radiología de la Fundación Instituto Valenciano de Oncología 
(FIVO). El algoritmo de detección desarrollado se ha aplicado a 19 pacientes diagnosticados con metástasis 
cerebrales (un total de 62 metástasis cerebrales) en el Servicio de Radiología de la FIVO. Tras aplicar los 
algoritmos de reducción de falsos positivos, para el grupo de entrenamiento se ha conseguido un 85% de 
sensibilidad (17 de 20 metástasis detectadas) y una tasa media de falsos positivos por caso de 5,63. En lo 
referente al grupo de validación se ha obtenido una sensibilidad y una tasa media de falsos positivos por 
caso de 88,1% (37 de 42 metástasis detectadas) y 5,91, respectivamente. Esta herramienta es de utilidad 
para el diagnóstico clínico realizado por radiólogos, facilitándoles un análisis automático sobre las 
imágenes a diagnosticar 

▪ Vianney-Kinani, J. M., ROSALES-SILVA, A. J., GALLEGOS-FUNES, F. J., & Arellano, A. (2014). 
Diagnóstico asistido por ordenador de los tumores cerebrales mediante la mejora de imagen y la 
lógica difusa. DYNA, 81(183), 148-157. 

Un sistema de procesamiento de imágenes médicas robusto depende de una variedad de aspectos, 
incluyendo una mejora apropiada de la imagen, y una segmentación óptima. En este artículo se propone 
un algoritmo para facilitar la implementación de estos dos pasos. En primer lugar, una imagen de 
resonancia magnética (RM) se mejora vía filtrado en el dominio espacial y también se mejora su contraste, 
luego, la imagen se segmenta utilizando el agrupamiento difuso “fuzzy C-means” (FCM), posteriormente, la 
región de interés, que puede ser el tumor o edema, se detecta y delinea. La ventaja clave de esta 
canalización de procesamiento de imagen es el uso simultáneo de características calculadas a partir de las 
propiedades de intensidad de la imagen en un patrón en cascada que hace que el cálculo sea auto-
contenido. La evaluación del rendimiento del algoritmo propuesto se llevó a cabo en imágenes cerebrales 
de diferentes sistemas de resonancia magnética, el algoritmo desarrollado probó ser exitoso en 
comparación a otras aplicaciones relacionadas 

 

Se comenzará explicando conceptos y algoritmos de procesamiento para imágenes en escala 
de grises. Muchos de estos conceptos son aplicables directamente a las imágenes en color 

1. Imágenes Digitales 

Este tipo de imágenes puede considerarse como una matriz cuyos índices de fila y columna 
identifican un punto en la imagen y el correspondiente valor del elemento de la matriz equivale al 
valor de magnitud o nivel de gris en ese punto.  

Matemáticamente, una imagen digital matricial de N pixeles de ancho y M pixeles de alto puede ser 
representada como una matriz de dimensiones M×N.  

 
Figura 1. Imagen Digital matricial 

El sistema de coordenadas que se usará, toma como (0,0) la esquina superior izquierda y como 
(M−1,N−1) la esquina inferior derecha.  

El conjunto de valores de cada celda de la matriz, de la forma 1,2,...,L cuyo tamaño depende del 
formato de la imagen: para imágenes con profundidad de color de n bits, L toma el valor L= 2n.  

Algunos formatos habituales son imágenes de 8, 16 o 32 bits. En este trabajo nos centraremos en 
imágenes en escala de grises de 8 bits por ser las que se han utilizado en el Grupo de Investigación. 
Por tanto cada pixel representa la luminosidad o intensidad del pıxel de coordenadas (u,v), siendo 0 
la intensidad mínima (negro) y 255 la máxima (blanco). 
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Tras la captura de la imagen tendremos una matriz de valores en dos dimensiones (2D), es decir, una 
imagen digital. Los valores de la matriz 2D representan niveles de intensidad. 

 
Figura 2. El pixel – Resolución 

La resolución espacial es el grado de detalle discernible en una imagen dado por el tamaño del pixel 
(picture element, el elemento más pequeño en una imagen) o la cantidad de pixeles. Se mide en puntos 
por pulgada (o ppp). Por ejemplo, en una imagen con una resolución de 300 ppp, cada pulgada de la 
imagen contiene 300 puntos. Dicho de otro modo, cada punto o píxel que compone la imagen ocupa 
1/300 de pulgada (14). 

Y la resolución de nivel de gris se refiere al más pequeño cambio discernible en nivel de gris. La 
potencia de 2 que determina el número de niveles de gris es usualmente 8 bits, es decir, 256 
diferentes niveles de gris. 

En este trabajo nos centraremos en imágenes en escala de grises de 8 bits por ser las que se han 
utilizado en el Grupo de Investigación. Por tanto cada pixel representa la luminosidad o intensidad 
del pıxel de coordenadas (u,v), siendo 0 la intensidad mínima (negro) y 255 la máxima (blanco). 

  

  

  

  

  
Figura 3. Imagen Digital como función de dos dimensiones con coordenadas espaciales 

Usualmente decimos que una imagen digital de tamaño M x N con L niveles de gris tiene una 
resolución espacial de M x N píxeles y una resolución de nivel de gris de L niveles. 
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Figura 4. Cuantificación 

En la siguiente figura 5, se observa una misma imagen con una resolución de niveles de gris de 8 bits, 
pero con distintas resoluciones espaciales, las cuales son: 

a. 1024x1024 
b. 512x512 
c. 256x256 
d. 128x128 
e. 62x64 
f. 32x32 

La imagen original tiene una resolución espacial de 1024x1024. Las sucesivas imágenes con 
resoluciones espaciales menores se obtienen de eliminar el número apropiado de filas y columnas de 
la imagen original. 

 
Figura 5. Imágenes con distintas resoluciones espaciales [14] 

En la siguiente figura 6, se observa el caso en el que la resolución espacial (472x374) se mantiene 
constante y lo que cambia es la resolución en los niveles de gris. 



Informe de Avance y/o Final 2020 Anexo 00 CCUTIME0005279TC 

 

CESARI Matilde Inés 7 
 
 

 
Figura 6. Imágenes con distintas resoluciones en los niveles de gris [14] 

En la figura anterior: 

a. 256 niveles de gris 
b. 128 niveles de gris 
c. 64 niveles de gris 
d. 32 niveles de gris 

e. 16 niveles de gris 
f. 8 niveles de gris 
g. 4 niveles de gris 
h. 2 niveles de gris 

 

Algunas relaciones básicas entre píxeles 

• Vecinos de un pixel 

Un pixel p en las coordenadas (x,y) tiene cuatro vecinos horizontales y verticales dados por:  

 

 
Este conjunto de pixeles, llamados los 4-vecinos de p, se denota como conjunto N4(p). 

Los cuatro vecinos diagonales de p tienen las coordenadas: 

 

 
Y se denota como conjunto ND(p). Estos puntos, junto con N4(p), son llamados los 8 vecinos de p, y 
se escriben como N8(p). Algunos de ellos estarán fuera de la imagen si (x,y) está en el borde de la 
imagen [14] 
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• Conectividad, Regiones y fronteras 

La conectividad entre píxeles es un concepto fundamental que simplifica la definición de numerosos 
conceptos de la imagen digital, como regiones y fronteras. 

Para establecer si 2 pixeles están conectados, se debe determinar si son vecinos y si sus niveles de 
gris satisfacen un criterio predeterminado de similaridad (por ejemplo, que sus niveles de gris sean 
iguales). En una imagen binaria (con valores 0 y 1), 2 pixeles pueden ser 4-vecinos, pero sólo se dice 
que están conectados si tienen el mismo valor [14] 

 
Conectividad 

Si V es el conjunto de valores de niveles de gris que definen la conectividad entre píxeles de una 
imagen, podemos definir 3 tipos de conectividad: 

a) 4-conectividad: 2 pixeles p y q con valores en V son 4-adyacentes si q está en el conjunto N4 (p). 

b) 8-conectividad: 2 pixeles p y q con valores en V son 8-adyacentes si q está en el conjunto N8 (p). 

c) m-conectividad (conectividad mixta): 2 pixeles p y q con valores de V son m-adyacentes si: 

1 – q está en N4 (p) ó 

2 – q está en ND (p) y además el conjunto N4 (p) N4 (q) no tiene pixeles con valores de V. 

La conectividad mixta es una modificación de la 8-conectividad que se introduce para eliminar las 
ambigüedades que surgen al utilizar 8-conectividad. Por ejemplo, considérese el arreglo de pixeles 
de la figura7 para V = {1}. Los 3 píxeles en la parte superior muestran múltiple 8-conectividad 
(ambigua), como se indica con las líneas punteadas. Esta ambigüedad desaparece al utilizar m-
conectividad [14]. 

 
Figura 7. Ejemplos de conectividad en una imagen binaria [14] 

Caminos, componentes conexas, conjuntos conectados, regiones 

El camino de un píxel p con coordenadas (x,y) a un pixel q con coordenadas (s,t) es la secuencia de 
distintos píxeles con coordenadas (x0,y0), (x1,y1),...,(xn,yn) 

Donde (x0, y0) = (x, y) y (xn, yn) = (s, t) y los píxeles (xi, yi) y (xi-1, yi-1) son adyacentes para todo 
1<= i <= n.  

En este caso, n es la longitud del camino. Si (x0, y0) = (xn, yn), el camino es cerrado. 

Sea S un subconjunto de pixeles en una imagen. Se dice que 2 pixeles p y q están conectados en S si 
existe un camino entre ellos que consiste enteramente de pixeles en S.  
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Para cada pixel p en S, el conjunto de pixeles que está conectado a él en S se denomina componente 
conexa de S. Si sólo tiene un componente conexo, entonces el conjunto S se denomina conjunto 
conectado. 

Sea R un subconjunto de pixeles en una imagen. Llamamos R una región de la imagen si R es un 
conjunto conectado. La frontera (también llamada borde o contorno), de una región R es el conjunto 
de píxeles de la región que tienen uno o más vecinos que no están en R [14]. 

Distancia entre píxeles 

Para los pixeles p, q y z con coordenadas (x,y), (s,t) y (v, w) respectivamente, D es una función de 
distancia si: 

▪ D(p,q)>=0 -----> D(p,q)=0 si y sólo si p=q 
▪ D(p,q)=D (q, p) 
▪ D(p,z)<=D (p,q) + D(q,z) 

La distancia euclidiana entre p y q se define como:  

Lo que significa que los pixeles que tienen una distancia menor o igual al valor de r desde (x,y) son 
los que contiene un disco de radio r con centro en (x,y) (15) 

 
La distancia euclídea es la más exacta pero presenta el inconveniente de su gran número de cálculos. 
Por otro lado no tiene en cuenta el concepto de vecindad antes descrito. Es por ello que se han 
definido otras. 

 
Figura 8. Alternativas de distancias métricas entre dos pixeles en imágenes digitales [14] 

Operaciones entre píxeles 

Existen básicamente dos tipos de operaciones entre píxeles: 

▪ Operaciones aritméticas (suma, resta, multiplicación, división) 
▪ Operaciones lógicas (AND, OR, NOT, XOR, etc.). 

Por ejemplo, si se desea sumar dos imágenes, lo que se hace es sumar el píxel p de la imagen 1 con el 
pixel q de la imagen 2.  

Estos píxeles deben tener la misma posición en sus respectivas imágenes.  

De esta manera se obtiene una nueva imagen, y el valor de cada uno de sus píxeles es: 

 
De manera similar se hace con el resto de las operaciones aritméticas y las operaciones lógicas, estas 
últimas se aplican en su mayoría a imágenes binarias 
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2. Pasos fundamentales del procesamiento digital de imágenes 

Las partes fundamentales del procesamiento digital de imágenes (en general) son las que 
enumeran a continuación, aunque no siempre se aplican todos los pasos. 

A. Adquisición de imágenes: En esta primera etapa, luego de adquirir la imagen, por lo 
general se aplica un preprocesado de la imagen. 

Como sucede con otros conceptos que abarcan tantos  campos  como  lo  hace  la imagen médica, 
como pueden ser obviamente la medicina, la física, la química, la ingeniería, etc., la definición puede 
variar ligeramente dependiendo del contexto, pero de forma general se puede definir como el 
conjunto de técnicas y procesos que representan  espacialmente  una o  más propiedades físicas  o  
químicas  dentro  del cuerpo humano [16]. 

De las imágenes obtenidas se destacan dos parámetros importantes: 

• Contraste: Diferencia de intensidad entre un punto de la imagen y sus alrededores. Cuando 
hablamos de imagen médica lo importante es conocer la fuente del contraste, es decir, que 
parámetro está siendo representado por una determinada intensidad luminosa. 

• Resolución: Grado de detalle. La resolución puede ser espacial o temporal. 

– Espacial: Se define formalmente como, la distancia mínima que debe existir entre dos puntos 
del objeto para poder identificarlos en la imagen como independientes. 

– Temporal: Definida como la capacidad para adquirir una imagen óptima en el menor tiempo 
posible. Es inversamente proporcional al tiempo de adquisición de la imagen. No puede 
valorarse directamente sobre la imagen como ocurre con la resolución espacial o el contraste. 
La resolución temporal es más importante en estudios dinámicos o funcionales. En estos 
casos la mayor rapidez de la adquisición permite obtener información funcional no 
manifestada en imágenes “estáticas” [17] 

Parámetros de calidad de una imagen médica: 

– Las  imágenes  contienen  información  útil  para  su  estudio  pero  también incorporan ruido 
debido a diversas fuentes (ruido térmico, interferencial, etc.) y de carácter aleatorio que 
“ensucia” la imagen. Es imposible eliminarlo por completo pero  se puede  dar una  medida  
de como  éste  afecta  a  nuestra imagen mediante la SNR (Signal Noise Ratio). 

– Artefactos: Cualquier estructura que aparezca en una imagen médica y no tenga una 
correspondencia real con el organismo estudiado. Son errores sistemáticos, al contrario que 
el ruido, debidos a diversos fuentes, dependiendo de la cual el artefacto puede ser evitable o 
no 

En la mayoría de los casos hay que llegar a un compromiso entre estos parámetros,  por  lo  que  en  
casos  reales  se  intenta  llegar  a  un  equilibrio  que proporcione imágenes suficientemente buenas 
para el análisis que se desee realizar 

De forma general la obtención de imágenes médicas consiste en irradiar al paciente con energía de 
una naturaleza determinada. La procedencia de esta energía definirá el contraste de la imagen, 
apareciendo el concepto de modalidad de imagen utilizado de forma común para enmarcar qué 
radiación se ha utilizado para la adquisición, las modalidades utilizadas en la actualidad son: 

– Radiología: Rayos x (Radiación electromagnética) 
– Medicina nuclear: Radiación  (Radiación electromagnética) 
– Ecografía: Energía Ultrasónica. 
– Resonancia Magnética: Ondas Radio (Radiación electromagnética 

Los distintos tipos de radiaciones utilizados en cada modalidad producen diferentes efectos en los 
tejidos debido a la interacción bioquímica con los mismos, pudiendo llegar a provocar efectos 
negativos sobre el organismo, por lo que en este contexto se pueden clasificar las modalidades como: 

– Radiaciones ionizantes: Se llegan a ionizar moléculas debido a la alta energía de la radiación, 
induciendo reacciones químicas en los tejidos. 

– Radiaciones no ionizantes: La energía no es suficientemente alta para producir ionización, 
solo el cambio de estado de algunas partículas produciendo calor debido a la absorción y 
posterior emisión de la energía. 
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También se pueden clasificar las modalidades según la naturaleza del contraste: 

– Morfológicas o estructurales: Representan la anatomía de los pacientes detalladamente. 
Generalmente tendrán una resolución alta. 

– Funcionales: Aportan parámetros sobre el funcionamiento de los tejidos, como la perfusión 
sanguínea, el metabolismo, etc. 

Otra forma  importante  de  clasificar  las  modalidades  es  según  la  capacidad  para separar objetos 
a distintas profundidades: 

– Imágenes proyectivas: Es una imagen en perspectiva, todas las estructuras de la muestra se 
superponen sobre un plano. 

– Imágenes tomográficas: Se proporcionan varios cortes (rodajas) en tres dimensiones para 
facilitar su interpretación 

Las imágenes médicas obtenidas por las distintas modalidades mapean, es decir, localizan y 
representan gráficamente, la distribución relativa de las partes de la muestra, siendo esta 
visualización obviamente cualitativa. Las imágenes contienen más información de la que revela la 
simple inspección ocular y las técnicas de análisis permiten la obtención de nuevas características o 
parámetros medibles, que también pueden ser representadas sobre el mapeo de la imagen realizado 

Tomografías Computadas (TC): procedimiento de diagnóstico que usa combinación de radiografías 
(Radiaciones ionizantes) y técnicas computarizadas para obtener cortes transversales. Modalidad 
morfológica no funcional para obtener Imágenes tomográficas. 

Las tomografías computadas pueden realizarse para ayudar a diagnosticar tumores, estudiar 
hemorragias internas o buscar otras lesiones o daños 

Resonancia Magnética por Imágenes (RMI): método no funcional para producir imágenes 
tomográficas precisas de los órganos internos del cuerpo; mediante radiaciones no ionizantes. La 
resonancia magnética ofrece excelentes detalles anatómicos debido a su alto contraste entre tejidos 
blandos y la posibilidad de realzar diferentes tipos de tejidos empleando distintos protocolos de 
adquisición (18). Esto se consigue modificando los tiempos de relajación de los tejidos, denominados 
T1 y T2, y los tiempos de repetición TR y de eco TE, o incluso con ayuda de contrastes externos, lo 
cual dará lugar a distintas secuencias de imágenes como las secuencias potenciadas en T1 o T2, las 
secuencias FLAIR (se elimina la señal de los líquidos), de difusión del agua o de perfusión (pudiendo 
también utilizar la propia sangre como agente de contraste) entre otras (19). 

Estas imágenes son de gran utilidad para el diagnóstico precoz de muchas enfermedades y para una 
localización precisa de las lesiones en los distintos órganos. 

Tabla 1. Diferencias entre TC y RMI 

TC RMI 
Proceso rápido Demora más 

Cortes más grandes (0.5 a 1 mm) Cortes chicos < 0.5 mm 
Emplea rayos X Emplea campos magnéticos 

Formato TIFF (Tagged Image File Format): 

Las imágenes pueden ser de 1bit, 8bit, 16bit hasta de 32 bits. Archivos TIFF con imágenes múltiples 
del mismo tipo y tamaño pueden abrirse en forma de stacks o hiperstacks es decir que hace un 
desglose de imágenes múltiples en una sola ventana, ImageJ también permite guardar el archivo TIFF 
como archivo ZIP sin pérdida de información. El archivo en formato TIFF define etiquetas que 
describen las características de la imagen, al guardar imágenes muy grandes es posible que se pierda 
calidad en la misma pues la gama de colores que utiliza es de RGB (rojo, gris, azul), CMYK (cian, 
magenta, amarillo, negro) y peso de la imagen aumenta. 

Las etiquetas que utiliza TIFF permiten almacenar información acerca de las dimensiones de la 
imagen, la cantidad de colores utilizados, el tipo de compresión o la corrección de gama. Por lo tanto, 
una descripción de imagen que utiliza etiquetas simplifica la programación del software permitiendo 
guardar información en formato TIFF. Por otro lado, la cantidad de opciones es tan amplia que 
muchos editores de imágenes que admiten el formato TIFF no las integran todas. Por ende, algunas 
veces, una imagen guardada que utiliza el formato TIFF no se puede leer por medio de otro editor, 
pero la versatilidad de TIFF permite ser importado a diferentes plataformas de publicación. 



Informe de Avance y/o Final 2020 Anexo 00 CCUTIME0005279TC 

 

CESARI Matilde Inés 12 
 
 

Formato DICOM: DICOM (Digital Imaging and Communications in Medicine)  

DICOM es el estándar reconocido mundialmente para el intercambio de imágenes médicas, pensado 
para el manejo, almacenamiento, impresión y transmisión de imágenes médicas y datos de pacientes. 
DICOM ha sido adoptado ampliamente por hospitales y está haciendo incursión en pequeñas 
aplicaciones de oficina para dentistas y médicos. 

Creado por ACR (American College of Radiology) y NEMA (National Electrical Manufacturers 
association) alrededor de 1985, tuvo gran impacto a inicios de 1993 con el auge de las imágenes 
diagnosticas, y es ahora el formato estándar reconocido mundialmente para el intercambio de 
pruebas médicas, visualización, almacenamiento, impresión y transmisión. Posee también un 
protocolo de comunicación de red que permite la comunicación entre sistemas para la transmisión 
de datos e igualmente los ficheros DICOM pueden intercambiarse entre dos entidades que tengan 
capacidad de recibir imágenes y datos de pacientes en formato DICOM. 

DICOM se diferencia de otros ficheros de datos porque agrupa la información dentro de un conjunto 
de datos, por ejemplo, una imagen de radiodiagnóstico contiene el ID del paciente junto con ella, de 
manera que la imagen no puede ser separada por error de su información y esto hace que DICOM 
cobre relevancia en la medicina” [20] 

La aparición y uso de las distintas técnicas de imagen por resonancia junto con la creciente tendencia 
de tener un mundo digitalizado, ha llevado tanto a organizaciones médicas como a fabricantes de 
aparatos médicos de diagnosis a buscar una manera de estandarizar, sobre todo, el diagnóstico por 
imagen, estableciendo un formato único para los datos y las comunicaciones médicas, generalizando 
los protocolos. Uno de los estándares más exitosos hasta la fecha es DICOM (siglas de Digital Imaging 
and Communications in Medicine). 

DICOM es un estándar de comunicación entre sistemas de información utilizado a nivel mundial para 
el intercambio de pruebas médicas, pensado para su manejo, visualización, almacenamiento, 
impresión y transmisión. Su aparición supuso acabar con los problemas de interoperabilidad entre 
distintos tipos de dispositivos. Incluye la definición de un formato de fichero y de un protocolo de 
comunicación de red. El protocolo de comunicación es un protocolo de aplicación que usa TCP/IP 
para la comunicación entre sistemas. Los ficheros DICOM pueden intercambiarse entre dos entidades 
que tengan capacidad de recibir imágenes y datos de pacientes en formato DICOM. 

Una imagen médica por sí misma no aporta suficiente información. Para que sea correctamente 
interpretada es necesario que vaya acompañada de datos del paciente y del proceso de adquisición, 
incluyendo datos de la máquina y de las circunstancias de cómo se realizó la prueba. 

Los ficheros DICOM constan de una cabecera mixta con campos estandarizados y campos de libre 
elección, y un cuerpo con la imagen en sí. Cada campo va etiquetado en la cabecera del fichero DICOM. 
Es en estos campos donde se almacena la información sobre el paciente (identificación y datos 
demográficos), el estudio donde se encuadra la toma de la imagen, la serie a la que pertenece la 
imagen e información sobre la propia máquina. 

La imagen y su información asociada se almacenan en objetos. Los objetos están compuestos por 
entidades de información (hay entidades de paciente, de estudios, de series, de equipo, de imagen…) 
que a su vez se componen en uno o varios módulos, que a su vez contienen varios atributos. Un 
atributo se define con etiqueta, nombre, palabra clave, la representación del valor (tipo de datos y el 
formato) y multiplicidad del valor (especifica el número de valores que pueden ser codificados en 
ese campo). 

En la siguiente figura se puede apreciar una síntesis de los metadatos más importantes y que hemos 
usado durante la implementación de la herramienta que nos ocupa 
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Ejemplo de los metadatos de una imagen DICOM 

Mejora de la imagen 

Se aplican cambios subjetivos en la imagen para lograr realzar algunos parámetros de 
interés. 

La mejora de la imagen se refiere a la acentuación de algunas de sus características tales como bordes 
o contraste para permitir una más adecuada visualización y análisis de la misma, por lo que el 
objetivo fundamental de las técnicas usadas es procesar la imagen de manera tal que resulte más 
apta que la original para una aplicación específica (21). 

Es de destacar que en este proceso no se añade información a la que ya poseen los datos, pero 
aumentando el rango dinámico de una característica elegida, ésta puede ser detectada y analizada 
con mayor facilidad. 

Es importante tener en cuenta el tipo de imagen y para qué va a ser usada, ya que un método de 
mejora apto para imágenes de rayos X, puede no ser conveniente para el procesado de una imagen 
satelital. 

Una primera aproximación de las técnicas de mejora permite agruparlas en: 

1. Métodos en el dominio espacial 

El término dominio espacial se refiere al plano mismo de la imagen, y los métodos en esta categoría 
están basados en la directa manipulación de los píxeles de una imagen, y pueden clasificarse en: 

a. Transformaciones de intensidad o de niveles de gris 
b. Filtrado espacial o convolución espacial 

Los métodos de referencia operan directamente sobre los píxeles y pueden expresarse como: 
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Donde f(x,y) es la imagen de entrada, g(x,y) es la imagen procesada y T es un operador que actúa 
sobre f en algún entorno de (x,y). Normalmente el entorno se define como una área de subimagen 
cuadrada o rectangular centrada en (x,y), aunque a veces se usan otros tipos tales como los círculos. 
El centro de la subimagen se mueve píxel a píxel y se aplica en operador en cada posición (x,y) para 
obtener la imagen de salida [21]. 

a. Transformaciones de intensidad o de niveles de gris 

Procesamiento de punto. La forma más simple de T corresponde a un entorno 1x1, en cuyo caso g 
depende sólo del valor de f en el punto (x,y). Como la mejora en cada punto depende sólo del nivel de 
gris en ese punto, las técnicas de esta categoría se designan como procesamiento de punto.  

En estas condiciones, T se convierte en una función de transformación del nivel de gris de la forma: 

 
Donde r y s indican el nivel de gris de f(x,y) y g(x,y) respectivamente. En la siguiente figura, se 
muestra en (a) el efecto de producir una imagen de mayor contraste que la inicial, al oscurecer los 
niveles de gris que se encuentran por debajo de m e iluminar los niveles por arriba de este valor en 
la imagen original. Esta técnica es conocida como de aumento de contraste. 

En la figura 7 (b), T(r) produce una imagen de dos niveles (binaria). 

 
Figura 7. (a) Aumento de contraste. (b) Imagen binaria [21] 

En la siguiente figura 8 se muestran tres tipos de funciones básicas utilizadas frecuentemente en la 
mejora de la imagen: lineal, logarítmica y de potencia. 

 
Figura 8. Funciones básicas utilizadas en la mejora de la imagen [21] 
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− Transformación lineal 

Como se observa en la figura anterior, hay dos tipos de transformaciones lineales: 

a. La lineal produce como resultado una imagen idéntica a la de entrada 

b. La negativa da como resultado el negativo de la imagen original. 

En la figura 9, siguiente en (a) se ve la imagen original de una mamografía y en (b) el negativo de 
la misma. 

 
Figura 9. Transformación lineal. (a) Imagen idéntica a la de entrada. (b) Negativo de la imagen 

[21] 

− Transformación logarítmica 

Cuando el rango dinámico de una imagen excede la capacidad del dispositivo de presentación, en 
cuyo caso sólo las partes más brillantes de la imagen aparecerán en la pantalla, es usual recurrir 
a una transformación logarítmica del tipo: 

 
Donde c es un factor de escala, y se asume que r>=0.  

Esta transformación realiza la compresión deseada. Esta es la técnica usada para representar la 
Transformada de Fourier, donde el rango dinámico es habitualmente mucho mayor que el de los 
sistemas de visualización estándar que son capaces de reproducir fielmente, en consecuencia 
sólo las partes más brillantes de la imagen son visibles en la pantalla [21]. 

En la siguiente figura en (a) se observa la Transformada de Fourier de una imagen, y en (b) la 
transformación logarítmica de esta con c=1. 

 
Figura 10. (a) Transformada de Fourier de una imagen. (b) Transformación logarítmica de la 

imagen “a” [21]  

Como se puede ver la transformación logarítmica ayuda a visualizar niveles de gris antes no 
distinguibles. 

La transformación logarítmica inversa lleva a cabo una transformación contraria a la anterior. 

− Transformación de potencia 

Las transformaciones de función de potencia tienen la forma básica 

 
Donde c y son constantes 



Informe de Avance y/o Final 2020 Anexo 00 CCUTIME0005279TC 

 

CESARI Matilde Inés 16 
 
 

En la siguiente figura se muestran los distintos gráficos de función para distintos valores de . Las 
curvas que corresponden a valores de >1 tienen un efecto contrario sobre la imagen a las que 
tienen <1. 

 
Figura 11. Curvas de transformación de potencia [21] 

La aplicación de estas curvas sobre una imagen tiene un resultado similar a la transformación 
logarítmica. 

Esta transformación también se utiliza para manipular el contraste de una imagen como se 
muestra en las siguientes figuras. 

 
Figura 12. Aumento de contraste, como resultado de aplicar distintas transformaciones de 

potencia [21] 

En la figura (a) se observa la imagen original, y en (b), (c) y (d) se muestra el aumento de contraste 
producido con c=1 y con valores de gamma de 3.0, 4.0 y 5.0 respectivamente. 

− Transformación lineal por partes 

Fraccionamiento del nivel de gris 

A veces se desea destacar un rango específico de nivel de gris en una imagen apoyándose la 
solución en una de estas dos ideas básicas: 



Informe de Avance y/o Final 2020 Anexo 00 CCUTIME0005279TC 

 

CESARI Matilde Inés 17 
 
 

1. Adjudicar un nivel alto a aquellos niveles de gris en el rango de interés, y un valor bajo para 
los restantes (Figura a). 

2. Aumentar el nivel de gris del rango de interés, pero preservar el resto de los valores naturales 
(Figura b) 

 
Figura 13. Transformaciones lineales para el fraccionamiento del nivel de gris [21] 

Aumento de contraste 

En la siguiente figura se observa una transformación típica de aumento de contraste. Los puntos 
de control (r1,s1) y (r2,s2) determinan la forma de la función de transformación. 

✓ Si r1=s1 y r2=s2 la transformación es una función lineal que no produce cambios en el 
nivel de gris. 

✓ Si r1=r2, s1=0 y s2=L–1, la transformación se vuelve una función de umbral cuyo 
resultado es una imagen binaria. 

Valores intermedios producen distintos grados de distribución del nivel de gris, afectando el 
contraste. 

 
Figura 14. Transformación lineal para el aumento del contraste. [21] 
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En la figura: 

a. Función de transformación 

b. Imagen con bajo contraste 

c. Resultado de aumento de contraste 

d. Resultado de aplicar la función de umbral 

Modificación del histograma 

Puede encararse el mejoramiento de la imagen actuando sobre el histograma.  

El histograma de una imagen digital con niveles de gris en el rango [0, L-1] es una función discreta 
definida como: 

 
Donde “rk” es el k-ésimo nivel de gris, “nk” es el número de píxeles de la imagen con ese nivel de 
gris, n es el número total de píxeles de la imagen y k=0, 1,2,..., L-1 

A continuación en la figura se muestran 4 tipos de histogramas según la imagen sea:  

 
Figura 15. Histogramas típicos según el tipo de imagen. [21] 

Se observa que p (rk) da una estimación de la probabilidad de que aparezca el nivel de gris “rk”. 
La suma de los componentes de un histograma normalizado es igual a 1. 

Si se parte de una formulación continua, para cada r del intervalo [0,1], y nos centramos en las 
transformaciones de la forma s= T(r) que producen un nivel de gris s para cada valor de píxel r 
de la imagen original, la función de transformación debe cumplir con las siguientes propiedades: 

a) T(r) da un valor único y monótonamente creciente en el intervalo 0 ≤ r ≤ 1 

b) 0 ≤ T(r) ≤ 1 para 0 ≤ r ≤ 1 

La condición a) preserva el orden entre negro y blanco de la escala de grises, mientras que la 
condición b) garantiza una aplicación que es coherente con el rango de valores de píxeles 
permitidos. Los niveles de gris se pueden ver como cantidades que varían aleatoriamente, y 
pueden caracterizarse por su densidad de probabilidades pr(r) y ps(s) 

De la teoría elemental de probabilidades, si Pr(r) y T(r) son conocidas y T-1(s) verifica la condición 
a), entonces se satisface: 
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(1) 

Una técnica de mejora se basa en la modificación de la apariencia de una imagen digital al controlar 
la función de densidad de probabilidad de sus niveles de gris por medio de una función de 
transformación T(r). 

Sea la función de transformación (función de distribución acumulada de r): 

 
Y donde: 

 
Sustituyendo en (1) se tiene: 

 
Que da una densidad uniforme en el intervalo de definición de la variable transformada s. 

Esto significa que cuando se emplee una función de transformación igual a la función de 
distribución acumulada de r se produce una imagen cuyos niveles de gris tiene densidad 
uniforme. 

La técnica empleada se llama “ecualización o linealización del histograma”. 

La ventaja que presenta este algoritmo frente a la manipulación manual del contraste es que su 
aplicación resulta completamente automática, esto es la información necesaria para implementar 
este proceso puede ser extraído de la propia imagen original, aunque sólo sea capaz de generar 
una aproximación a un histograma plano. 

A veces se desea tener la posibilidad de especificar determinados perfiles del histograma capaz 
de detectar determinados niveles de gris, lo que lleva a considerar el histograma original y el que 
se desea obtener, desarrollándose para este propósito un método llamado “especificación del 
histograma”. 

Estos dos métodos son globales, en el sentido de que los píxeles se modifican mediante una 
función de transformación basada en la distribución de los niveles de gris en toda la imagen. 

Aunque a veces resulta de interés la mejora general de la imagen, a menudo se requiere actuar 
sobre los detalles en un área pequeña de la misma. Una solución consiste en generar funciones 
de transformación basadas en la distribución de los niveles de gris en una vecindad de cada píxel 
de la imagen 

 

b. Filtrado espacial o convolución espacial 

El filtrado espacial plantea otra visión del problema. Se basa en el empleo de máscaras espaciales, 
también llamados filtros espaciales. La idea es simple: Consiste en determinar g en el punto (x,y) a 
partir de los valores de f en un entorno predefinido en (x,y). 

Normalmente se basa en el empleo de máscaras (plantillas, ventanas o filtros), las cuales son una 
pequeña distribución bidimensional (por ejemplo 3x3) en la que los valores de los coeficientes 
determinan la naturaleza del proceso, el cual se llama procesamiento por máscaras o filtrado.  

En los filtros lineales la aproximación básica consiste en sumar productos entre los coeficientes de la 
máscara y las intensidades de los píxeles bajo la máscara en un punto determinado de la imagen. 

 
La matriz anterior es una máscara 3x3 con pesos “wi”. Con “zi” se indican los píxeles de la imagen en 
los lugares correspondientes. El píxel que ocupa la posición 5 se reemplaza por R con: 
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Luego se traslada la máscara hasta el pixel siguiente y se repite el procedimiento. 

Los filtros espaciales no lineales operan también en entornos, pero su operación se basa 
directamente en los valores de los píxeles y no utilizan explícitamente los coeficientes como en el 
caso lineal. Entre los más comunes se encuentran los que calculan la mediana del nivel de gris en el 
entorno, o el filtro de máximo con R=máx{zi} 

 

− Filtros suavizantes 

Se emplean para lograr que la imagen aparezca algo borrosa en algunas etapas del preprocesado, 
para la eliminación de los pequeños detalles antes de la extracción de un objeto. También para la 
reducción de ruido mediante el aumento de la borrosidad. 

A modo ilustrativo se observa en la siguiente figura un filtro pasa bajo unidimensional. 

 
Figura 16. Filtro suavizante. [21] 

Se puede ver que en el dominio espacial todos los coeficientes son positivos. La construcción más 
simple sería como: 

 
La respuesta R en este caso será el valor promedio de todos los píxeles en el área de la máscara, 
por lo cual se suele llamar máscara de promediado. 

Una de las principales dificultades en este tipo de máscaras es que difumina los bordes y otros 
detalles de realce. 

Para eliminar ruido se puede usar un filtro de mediana el cual no es lineal pero más robusto al 
borroneo. 

− Filtros realzantes 

El objetivo de estos filtros es destacar los detalles finos de una imagen o intensificar los detalles. 
Entre estos se encuentran los filtros pasa alto, un ejemplo unidimensional se muestra en la 
siguiente figura: 

 
Figura 17. Filtro realzante [21] 

Observando la figura en el dominio espacial, se deduce que la máscara debe tener valores 
positivos en su centro y negativos en la periferia. Por ejemplo: 

Se puede observar que la suma de todos los coeficientes es cero. 

Cuando la máscara está sobre un área de nivel de gris casi constante, la salida del filtro es cero o 
muy pequeña. Este filtro elimina el término de frecuencia cero y hace muy pequeñas las 
frecuencias bajas, por lo tanto provoca que la imagen queda muy oscura  
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Se obtienen sin embargo resultados mejores usando un filtro high-boost, el cual usa la idea de 
que una imagen filtrada pasa alto puede ser calculada como la diferencia entre la imagen original 
y la imagen filtrada pasa bajo 

 
Multiplicando la imagen original por un factor de amplificación A se obtiene el filtro high-boost, 
y de aquí se deduce que: 

 
✓ Si A=1 se tiene un filtro pasa alto normal. 
✓ Si A>1 parte de la propia imagen original se añade al resultado del filtro pasa alto, lo que 

devuelve parcialmente las componentes de baja frecuencia, con lo que la imagen final se 
parece más a la original con un realce de los bordes, lo cual depende del valor de A 

− Otros filtros espaciales 

Como se mencionó anteriormente el promediado de los píxeles en una región tiende a difuminar 
la imagen. Como esta operación es análoga a la integración, puede pensarse que la diferenciación 
produzca el efecto contrario, esto es aumentar la nitidez de una imagen. El método más común 
es el del gradiente 

Para f(x,y) el gradiente viene dado por: 

 
Y con un módulo: 

 
Se puede discretizar el problema y aproximarse por: 

 
A partir de la región de imagen: 

 
Otra opción es sumando los valores absolutos: 

 
También puede usarse diferencias cruzadas: 

 
Las cuales pueden ser implementadas con máscaras del tipo (máscaras de Roberts): 

 
Empleando un entorno 3x3 la aproximación al gradiente se puede hacer como: 

 
Las máscaras generalmente usadas son: 

 
Uno de los usos más frecuentes de estas máscaras es para destacar bordes. 
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2. Métodos en el dominio de la frecuencia 

Los principios de filtrado en el dominio de la frecuencia son los estándares: 

Se calcula la Transformada de Fourier de la imagen a filtrar, se multiplica por la función de 
transferencia del filtro, y por antitransformada del producto se llega a la imagen mejorada [22] 

A continuación la figura muestra este procedimiento: 

 
Figura 18. Etapas de la mejora de la imagen en el dominio de la frecuencia [22] 

En el trabajo con imágenes se usan más a menudo las máscaras espaciales que sus correspondientes 
transformadas de Fourier porque resultan fáciles de implementar, aunque en algunos casos se 
necesita trabajar primero en el dominio de la frecuencia por resultar más adecuada su formulación 
inicial, considerando la correspondencia entre contenidos de frecuencia y la apariencia de la imagen 

a. Filtrado Pasa bajo 

Los bordes y otras transiciones bruscas en los niveles de gris contribuyen significativamente a los 
contenidos de alta frecuencia. 

Luego el difuminado se consigue atenuando el rango específico de componentes de alta frecuencia 
en la transformada de la imagen con la aplicación de un filtro pasa bajo 

 
Dónde: 

F(u,v) es la T. de F. de la imagen a suavizar 

G(u,v) es la T. de F. de la imagen suavizada 

H(u,v) es la función de transferencia 

− Filtro Ideal Pasa bajo Bidimensional 

 
Donde D0 es una cantidad específica no negativa llamada frecuencia de corte, y D (u,v) es la 
distancia desde el punto (u,v) al origen de coordenadas del plano de frecuencias, y se expresa 
como: 

 
Este filtro deja pasar todas las frecuencias (sin variación) dentro de un círculo de radio D0, 
mientras que todas las frecuencias de afuera quedan atenuadas completamente. 

Para este tipo de filtro es suficiente especificar su sección transversal, donde la función de 
transferencia completa puede generarse haciendo girar esta sección 360° alrededor del origen 
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Figura 19. Filtro pasa bajo ideal [22] 

− Filtro Butterworth Pasa bajo 

La función de transferencia de este filtro de orden n y con emplazamiento de la frecuencia de 
corte a una distancia D0 del origen, está dada por: 

 

 
Figura 20. Filtro Butterworth pasa bajo [22] 

A diferencia del filtro ideal, éste carece de una discontinuidad brusca, que establezca un corte 
claro entre las frecuencias transmitidas y las filtradas. 

En estos casos es usual definir la frecuencia de corte a partir del lugar de los puntos donde la 
función H (u,v) corresponde a una determinada fracción de su valor máximo [22]. 

Valores comúnmente usados son: 

0.5 del valor máximo de H(u,v) 

0.7 del valor máximo de H(u,v) 

b. Filtrado Pasa alto 
− Filtro Ideal Pasa alto Bidimensional 

Así como el filtro pasa bajo conduce a un difuminado de la imagen, el filtro pasa alto ideal realiza 
una tarea de realce de la misma. Para el filtro ideal: 

 

 
Figura 21. Filtro pasa alto ideal [22]. 
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− Filtro Butterworth Pasa alto 

La función de transferencia de orden n y con frecuencia de corte a una distancia D0 del origen 
está dada por: 

 
Como en el filtro Butterworth pasa bajo, la frecuencia de corte se selecciona normalmente en los 
puntos en que H (u,v) está por debajo de 0.70 de su valor máximo (23). 

 
Figura 22. Filtro Butterworth pasa alto (24). 

 

El procesamiento de imágenes KNIME ofrece una gama de técnicas generales de (pre) procesamiento 
para mejorar la calidad de la imagen: Hay disponibles filtros lineales y no lineales estándar, así como 
operaciones morfológicas y binarias, aritmética de imágenes por píxeles, detectores de bordes, 
algoritmos de sustracción de fondo, proyecciones o los nodos para la manipulación de la 
dimensionalidad, como dividir y fusionar imágenes. Además, el nodo ImageJ Macro, que es parte del 
procesamiento de imágenes KNIME — ImageJ Integration, permite la ejecución de macros 
ImageJ125. 

 

B. Segmentación: Se divide una imagen en sus partes constituyentes. 

La segmentación de imágenes es uno de los procesos más importantes de procesamiento de 
imágenes, la segmentación es una técnica usada para dividir o particionar una imagen en partes, 
llamadas segmentos, la segmentación es la técnica más utilizada para aplicaciones como la 
comprensión de imágenes o reconocimiento de objetos, porque para estos tipos de aplicación es 
ineficiente procesar toda la imagen, esta técnica divide a la imagen en varias partes en función de 
ciertas características de imagen, como el valor de intensidad de pixeles, el color y la textura. Etc 

El área de la segmentación de imágenes, especialmente del cerebro, ha sido durante los últimos años 
una de las que más esfuerzo y recursos ha ocupado. Esta increíble cantidad de trabajo llevada a cabo 
por la comunidad científica no ha llevado de la mano la solución del problema si bien se ha avanzado 
mucho. Las razones de esta situación son varias. De entre ellas cabe destacar la enorme complejidad 
del problema, la multiplicidad de situaciones experimentales y, fundamentalmente, el ignorar 
aspectos fundamentales del problema centrándose en unos pocos datos y sin alteraciones 
patológicas. La mayoría de los métodos de segmentación desarrollados no se han validado en 
ambientes clínicos y se han quedado en los laboratorios de donde nunca salieron. Solo unos pocos se 
han aplicado de forma rutinaria en la práctica médica y, al hacerlo, han puesto de manifiesto sus 
carencias y limitaciones.  

El primer paso en muchos métodos de segmentación de los distintos tejidos cerebrales es eliminar 
de las imágenes todos aquellos tejidos que se encuentran fuera del espacio intracraneal y que tienen 
brillos similares. Entre estos tejidos son de especial importancia el hueso, la grasa y la piel. En los 
últimos años se han desarrollado numerosos métodos de segmentación intracraneal. La mayoría de 
ellos se basa en la aplicación de umbrales y operaciones de morfología matemática aplicados a 
imágenes 3D potenciadas en T1 (3D-T1). Una vez extraído el espacio extracraneal (con todos sus 
componentes de piel, tejido celular subcutáneo y cráneo) de las imágenes, el problema de la 
segmentación de imágenes cerebrales se convierte en un problema de clasificación de tejidos.  
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Otro enfoque que se ha utilizado en la segmentación de imágenes de RM cerebral son las Redes 
Neuronales Artificiales (RNA) donde el proceso de segmentación se resuelve tras un proceso de 
aprendizaje, en el caso de redes supervisadas, o a través de redes no supervisadas como redes 
competitivas. Aunque el campo de la segmentación de imágenes de RM del cerebro es uno de los 
campos donde más se ha trabajado en los últimos años, este sigue siendo un problema todavía abierto 

Los algoritmos desarrollados en imagen médica no son aplicables y transferibles directamente a 
cualquier problema, sino que, por regla general, son desarrollados ad-hoc para la caracterización y 
segmentación de un órgano o patología específica, y también son dependientes de la tecnología de 
adquisición, dado que la misma condiciona las características y calidad de la imagen y por tanto, 
influye en el algoritmo. Los desarrollos existentes en el estado del arte son dedicados. La 
interpretación automática y universal está lejos de ser una realidad a día de hoy. 

En el procesamiento de imagen médica, técnicamente hablando, el reto es triple: 

• realizar una segmentación precisa, 
• que dicha segmentación sea obtenida mediante un proceso automático, 
• y que dicho proceso automático se ejecute rápido. 

Los enfoques de segmentación de imagen se puede categorizar en dos tipos basados en las 
propiedades de la imagen. Enfoque basado en la detección de discontinuidad La imagen se segmenta 
en regiones basadas en discontinuidad, la segmentación basada en la detección de bordes cae en esta 
categoría. Los bordes formados debido a la discontinuidad de intensidad son detectados y vinculados 
para formar los limites de la regiones. Enfoque basado en la detección de semejanza Una imagen se 
segmenta en regiones basadas en la similitud las técnicas que caen bajo este enfoque son; técnicas de 
umbral, técnicas de cultivo de región y fusión de regiones. Dividen la imagen en regiones similares 
que tienen un conjunto similar de pixeles. Las técnicas de agrupación también utilizan esta 
metodología dividen la imagen en un conjunto de clústeres que tienen criterios similares basados en 
algunos criterios predefinidos. 

La clasificación de tejidos de imágenes de resonancia magnética (RMI) y tomografía computada (TC) 
es un proceso en el cual los elementos de imagen que representan el mismo tipo de tejido son 
agrupados en un solo conjunto y son referenciados en una misma clase. 

Las unidades de las imágenes son los píxeles. Las propiedades de un píxel son su posición y su nivel 
o niveles de intensidad, según la imagen sea en escala de grises o color, respectivamente. 

En las imágenes aparecen ciertas áreas que constituyen agrupaciones de píxeles conexos entre sí, 
pero además de la conexión, dichos píxeles presentan propiedades o características comunes, por 
ejemplo: tienen el mismo color. Estas agrupaciones se llaman regiones. 

Técnicas de segmentación estructural Son aquellas técnicas de segmentación que trabajan sobre los 
valores de pixeles discretos de la imagen en lugar de la información estructural de la región Técnicas 
estocásticas de segmentación Son aquellas técnicas de segmentación que trabajan sobre los valores 
de pixeles discretos de la imagen en lugar de la información estructural de la región Técnicas hibridas 
Son aquellas técnicas de segmentación que usan los conceptos de ambas técnicas anteriores, es decir 
usan la información de pixeles y estructurales discretas juntos 

La  segmentación  manual  de  objetos  de  interés  se  ha  realizado  durante largo tiempo para estimar 
de forma objetiva distintas características de los objetos estudiados.  Esta  tarea  se  basa  en  la  
selección  de  los  píxeles  que  pertenecen  al objeto  de  interés  de  forma  interactiva,  bien  
seleccionando  píxel  por  píxel  dicho objeto  o  bien  usando  herramientas  semiautomáticas  como  
la  umbralización  y  el crecimiento de regiones que veremos a continuación.  Sin  embargo,  esta  tarea  
es  larga  y  tediosa,  además  de  presentar  una variabilidad inter e intrausuario nada despreciable. 
Como alternativa, en los últimos años  se  ha  trabajado  muy  intensamente  en  el  desarrollo  de  
técnicas  automáticas que  permitan  obtener  medidas  de  interés  clínico  a  partir  de  las  imágenes  
con poca intervención del usuario. 

Clasificación de técnicas de segmentación 

▪ Técnicas Contextuales: Tienen en cuenta las relaciones que existen entre los objetos de la imagen. 
Una técnica contextual tendrá en cuenta tanto las características del píxel como su vecindad con 
otros. Los algoritmos contextuales están basados en los conceptos de: discontinuidad y similitud. 
– Las técnicas basadas en discontinuidad dividen la imagen detectando cambios abruptos en 

los niveles de gris de la misma. 
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– Las técnicas orientadas a similitud intentan crear regiones uniformes agrupando píxeles que 
satisfacen ciertos criterios de similitud. El resultado depende fuertemente del criterio y de la 
definición de conectividad empleada. 

▪ Técnicas No Contextuales: Ignoran las relaciones que existen entre los objetos que aparecen en la 
imagen. Los píxeles se agrupan de acuerdo a algún atributo común como ser: intensidad, color. 

Técnicas de segmentación: 

La umbralización  es  una  de  las  técnicas  más  sencillas  y,  tal  vez  por  ello, más  utilizada  en  la  
segmentación  de  imágenes  en  general.  Consiste en  la determinación  de  unos  umbrales  que  
delimitan  el  rango  de  intensidades  que caracterizan  y  discriminan  los  distintos  objetos  de  la  
imagen.   

Técnica no contextual. Transforma un conjunto de valores, variando en algún rango, en otro conjunto 
de valores que contienen sólo los valores deseados. Realiza esto aplicando un nivel de umbralización 
a los datos. 

Existen 2 clasificaciones posibles para cada píxel: si el píxel está por debajo del nivel del umbral 
recibirá un valor y si está por encima de este, otro. Como existen sólo 2 posibles clasificaciones, el 
resultado será una imagen binaria (2 tonos). La medida del umbral marca el nivel de gris (es un 
atributo global). 

Son los métodos más simples de segmentación, dividen los pixeles de la imagen con respecto a su 
nivel de intensidad, estos métodos se utilizan sobre todo en imágenes que tienen objetos más ligeros 
que fondo, la selección de estos métodos puede ser manual o automático, es decir puede basarse en 
conocimiento previo o en la información de las características de la imagen.  

 
Figura 23. Histograma: umbralado 

Algunas de las técnicas más conocidas están basadas  en  el  histograma (función  de  densidad  de  
probabilidad  de  los  brillos  de  la  imagen)  de  la  imagen  y son:   

- Umbralización  bimodal:  Se  calcula  el  histograma,  se  suaviza  y  se calcula el umbral como el 
valor valle entre las dos agrupaciones de datos (normalmente fondo y objeto).  

- Umbralización  por  porcentajes  (P-Tile):  Si  se  tiene  información  a  priori del  número  de  píxeles  
del  objeto,  el  umbral  se  calcula  como  el  valor  que hace que el objeto tenga dicho número o su 
mayor aproximación.   

- Umbralización  por  coincidencia  de  contornos:  Se  calcula  el  umbral que  hace  que  coincidan  los  
contornos  naturales  de  la  imagen  con  los producidos por la umbralización.  

- Método de Otsu: Este método busca el umbral que minimiza la varianza acumulada de cada objeto 
por separado. 

 
Figura 24. Ejemplo de un histograma: Representación gráfica de la gama de tonos de una imagen, 

desde las zonas más oscuras a las más claras. 
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Los métodos de umbralización por sí solos no suelen ser suficientes para seleccionar correctamente 
un objeto de la escena, por lo que suelen utilizarse en conjunto con  otras  técnicas  que  aportan  
información  adicional. Entre  estas tenemos  la  morfología  matemática  y  los  sistemas  de  reglas  
aplicadas  sobre  los objetos binarizados resultantes de la umbralización. 

Los métodos de segmentación basados en bordes se basan en el cambio rápido del valor de 
intensidad en una imagen porque un solo valor de intensidad no proporciona buena información 
sobre los bordes. Las técnicas de detección de bordes localizan los bordes y luego se conectan entre 
sí para formar los límites del objeto.  

Para segmentar las regiones requeridas los métodos básicos de segmentación basados en bordes son 
2;  

Método de segmentación basado en Similaridad. Histograma en gris y métodos basados en gradiantes. 
Para detectar los bordes se puede utilizar una de las técnicas básicas de detección de aristas como el 
operador Sobel, el operador Astuto y el operador de Robert, el resultado de estos métodos es 
básicamente una imagen binaria. Estas son las técnicas estructurales basadas en detección de 
discontinuidad.  

Técnica contextual. La uniformidad de una región se define en un predicado de similitud que debe 
cumplirse en todo píxel correspondiente a esa región. Normalmente el predicado se define en base 
al nivel de gris de los píxeles, el color u otra propiedad. Si un píxel cumple el predicado se le asigna 
un valor de verdadero, caso contrario se le asigna falso. 

Método de segmentación basado en región. Son métodos que segmentan la imagen en varias regiones 
que tienen características similares existen 2 tipos de técnicas basadas en este método;  

• Región métodos de cultivo; Segmentación basado en crecimiento son métodos que segmentan la 
imagen en varias regiones basadas en el crecimiento de semillas (pixeles iniciales). Estas semillas 
pueden seleccionarse manualmente (basadas en conocimientos previos) o automáticamente 
(basadas en una aplicación particular.  

Técnica contextual bottom-top. Tiene en cuenta una serie de semillas que define el operador. Las 
semillas son píxeles seleccionados por una persona. Intenta hacer crecer una región conectada 
uniforme originada en cada semilla. Un píxel se agrega a la región si: – No se asignó antes a otra 
región; – Es vecino de la región; – La región creada al agregar el nuevo píxel sigue siendo 
uniforme. Problemas: da distintos resultados de acuerdo al concepto de vecindad empleado (4 
vecinos u 8 vecinos.), y los resultados son muy sensibles a las semillas seleccionadas. 

• Métodos de división y fusión de regiones; utilizan dos técnicas básicas la división y la fusión para 
segmentar la imagen en varias regiones. La división representa, división iterativa de un imagen 
en regiones que tienen características similares y la fusión contribuye a combinar las regiones 
similares adyacentes. 

Técnica contextual top-down. Al igual que la técnica de similitud de regiones, utiliza un 
predicado. Inicialmente la imagen se considera como una única región y el predicado es falso, 
entonces se divide la región en subregiones. Las nuevas regiones obtenidas a partir de otras son 
nuevamente partidas y mezcladas hasta cumplir con el criterio de uniformidad. El proceso se 
repite hasta que todas las regiones sean uniformes o hasta alcanzar un número máximo de 
particiones preestablecido 

El clustering es una familia de clasificadores no supervisados que realizan la  clasificación  de  los  
datos  en  base  a  la  propia  estructura  de  los  mismos.  Esta clasificación  se  realiza  en  base  a  un  
proceso  iterativo  que  trata  de  cumplir  unos criterios de homogeneidad intraclase.  La  finalidad  
del clustering  es  determinar  las  agrupaciones  intrínsecas  de un conjunto de datos sin etiquetar. 
Para ello utiliza algún criterio de homogeneidad  que  suele  basarse  en  el  uso  de  distancias  
(generalmente  la euclídea). Existen  muchas  técnicas  de clustering,  aunque  solo  citaremos  las  
más utilizadas en el contexto de la segmentación de imágenes como son:  

⎯ El  algoritmo  K-medias (MacQueen,  1967)  es  una  de  las  técnicas  de agrupamiento  más  
populares  debido  probablemente  a  su  sencillez.  También  es llamado el algoritmo de las 
medias móviles porque en cada iteración se recalculan los  centros  de  las  clases.  Este  
algoritmo  requiere  de  un  único  parámetro, K, definido como el número de agrupamientos 
que debe encontrar. 
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⎯ El  algoritmo Fuzzy  C-medias  o  k-medias  borroso (Dunn,  1973)  es  una extensión  del  k-
medias  tradicional.  La  principal  diferencia  es  que  en  el  k-medias cada  dato  solo  puede  
pertenecer  a  una  única  clase  mientras  que  en  el Fuzzy  C-medias puede pertenecer a 
varias clases a la vez, con una probabilidad determinada por las distancias a cada uno de los 
centroides.  

⎯ Mixturas de Gausianas. Cuando  los  datos  siguen  una  distribución  conocida  se  pueden  
utilizar técnicas  basadas en modelos como las mixturas de  Gaussianas donde los datos se  
pueden  modelar  como  la  suma  de  un  conjunto  de  distribuciones  paramétrica. Una forma 
de calcular los parámetros de las  distribuciones es usando  un clasificador de máxima 
verosimilitud (Maximum Likelihood). Uno de los algoritmos más  utilizados  para  calcular  la  
mixtura  que  mejor  se  ajusta  a  los  datos  es  el llamado Expectation-Maximization  o  EM 
(Dempster  y  cols,  1977).  El  primero  en aplicar el algoritmo EM para la segmentación de 
imágenes fue Wells (Wells y cols, 1996). 

Esta claro que varios métodos son adecuados para diversos tipos de aplicaciones de imagen, pero el 
estudio es claro que ningún método es suficiente para un tipo especial de imagen no que todos los 
métodos son adecuados para una imagen en particular, por lo que esta tecnología tiene un futuro 
desafiante para su estudio 

Algoritmos de segmentación más conocidos para tratar imágenes médicas: 

Los pasos  para  la  segmentación  cerebral pueden ser los siguientes (de izquierda a derecha): 
eliminación de tejidos extra craneales,  clasificación  de  tejidos,  separación  de  hemisferios  y  
selección  de estructuras concretas 

 
Figura 25. Ejemplo de segmentación.   

Se  pueden  clasificar  los  métodos  de  segmentación  basándonos  en  las propiedades  de  la  imagen  
en  las  que  se  basan.  La  mayoría  de  los  métodos  se basan en la intensidad de las imágenes, otros 
utilizan los contornos y también los hay que utilizan una combinación de ambos datos. También,  se  
pueden  clasificar  en  métodos  monoespectrales  (una  sola adquisición  o  modalidad  de  imagen)  
y  multiespectrales  (si  utilizan  una  o  varias imágenes  con  características  diferentes  pero  con  
correspondencia  geométrica para  un  mismo  volumen  anatómico).  Existen  muchas  formas  de  
clasificar  los métodos de segmentación, ya que son muchos los factores y las técnicas que se han 
empleado a lo largo de los años 

La  segmentación  manual  de  objetos  de  interés  se  ha  realizado  durante largo tiempo para 
estimar de forma objetiva distintas características de los objetos estudiados.  Esta  tarea  se  basa  en  
la  selección  de  los  píxeles  que  pertenecen  al objeto  de  interés  de  forma  interactiva,  bien  
seleccionando  píxel  por  píxel  dicho objeto  o  bien  usando  herramientas  semiautomáticas  como  
la  umbralización  y  el crecimiento de regiones que veremos a continuación.  Sin  embargo,  esta  tarea  
es  larga  y  tediosa,  además  de  presentar  una variabilidad inter e intrausuario nada despreciable. 
Como alternativa, en los últimos años  se  ha  trabajado  muy  intensamente  en  el  desarrollo  de  
técnicas  automáticas que  permitan  obtener  medidas  de  interés  clínico  a  partir  de  las  imágenes  
de  RM con poca intervención del usuario. 

La  umbralización  es  una  de  las  técnicas  más  sencillas  y,  tal  vez  por  ello, más  utilizada  en  la  
segmentación  de  imágenes  en  general.  Consiste  en  la determinación  de  unos  umbrales  que  
delimitan  el  rango  de  intensidades  que caracterizan  y  discriminan  los  distintos  objetos  de  la  
imagen.  La  umbralización manual suele ser una herramienta fundamental en la segmentación de 
imágenes, si  bien  es  preferible  usar  técnicas  automáticas  que  reduzcan  la  variabilidad 
introducida por el usuario. Algunas  de  las  técnicas  más  conocidas  están  basadas  en  el  histograma 
(función  de  densidad  de  probabilidad  de  los  brillos  de  la  imagen)  de  la  imagen  y son:   
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⎯ Umbralización  bimodal:  Se  calcula  el  histograma,  se  suaviza  y  se calcula el umbral como 
el valor valle entre las dos agrupaciones de datos (normalmente fondo y objeto).  

⎯ Umbralización  por  porcentajes  (P-Tile):  Si  se  tiene  información  a  priori del  número  de  
píxeles  del  objeto,  el  umbral  se  calcula  como  el  valor  que hace que el objeto tenga dicho 
número o su mayor aproximación.   

⎯ Umbralización  por  coincidencia  de  contornos:  Se  calcula  el  umbral que  hace  que  
coincidan  los  contornos  naturales  de  la  imagen  con  los producidos por la umbralización.  

⎯ Método de Otsu: Este método busca el umbral que minimiza la varianza acumulada de cada 
objeto por separado.  

Los métodos de umbralización por sí solos no suelen ser suficientes para seleccionar correctamente 
un objeto de la escena, por lo que suelen utilizarse en conjunto  con  otras  técnicas  que  aportan  
información  adicional. Entre  estas tenemos  la  morfología  matemática  y  los  sistemas  de  reglas  
aplicadas  sobre  los objetos binarizados resultantes de la umbralización 

Las técnicas basadas en la detección de contornos utilizan las fronteras de separación  entre  
distintos  tejidos  para  llevar  a  cabo  la  segmentación.  Existen muchos  detectores  de  contornos,  
desde  los  más  sencillos,  como  los  de  Sobel, Prewitt, Gradiente o Laplaciano, hasta los más 
elaborados, como los filtros de Canny, Marr/Hildreth y de congruencia de fase. Todos  ellos  tienen  
como  objetivo  seleccionar  aquellos  píxeles  de  la imagen  que  delimitan  la  frontera  del  objeto/s  
de  interés.  Estos  detectores  de bordes generan la información utilizada por otras técnicas de 
selección de objetos como son, por ejemplo, los contornos activos o snakes 

 
Ejemplo de imagen de RM y la imagen de contornos asociada 

Contornos activos o SNAKES, son curvas paramétricas que tienen unos puntos de control que se 
pueden mover  para  ajustarse  a  la  forma  del  órgano  o  tejido.  Los  movimientos  de  dichos puntos 
son dirigidos normalmente por condiciones de máximo gradiente y restricciones de continuidad y 
curvatura (Xu y Prince, 2000). Suelen emplearse para la segmentación de estructuras concretas 
(ventrículos,  lesiones,  etc.)  y  la  posición  inicial  de  los  puntos  de  control  suele  ser manual (fig 
26). 

 
Figura 26. Ejemplo  de  segmentación  mediante  snakes.  A  la  izquierda  se  muestra  la curva  

inicial  y  a  la  derecha  el  resultado  final  en  una  delimitación  de  la  cavidad ventricular 
izquierda del corazón 

El crecimiento de regiones (Region Growing) es una técnica muy sencilla que suele utilizarse,  al  
igual  que  la  umbralización,  como  apoyo  en  la  segmentación  manual de  imágenes.  Esta  técnica  
consiste  en  la  selección  de  un  punto  semilla  en  la imagen  alrededor  del  cual  se  van  añadiendo  
nuevos  píxeles  que  cumplen  un determinado  predicado  tal  como  estar  en  contacto  geométrico  
con  otros  píxeles clasificados como de interés y tener una intensidad dentro de un rango 
determinado (Adams y Bischof,1994). Suele  emplearse  para  la  selección  de  regiones  homogéneas  
en  las imágenes, tales como placas de esclerosis múltiple o tumores de bajo grado (Fig 27). 
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Figura 27. Ejemplo de crecimiento de regiones. A la izquierda se puede ver la semilla inicial y a la 
derecha el resultado del crecimiento de la región entorno a dicha semilla en un caso en el que se 

delimita el área quística central de una lesión cerebral. 

Los método de segmentación basado en redes neuronales artificiales, simulan las estrategias de 
aprendizaje del cerebro humano con el propósito de tomar decisiones, hoy en día este método se 
utiliza principalmente para la segmentación de imágenes médicas y se utiliza para reparar la imagen 
requerida del fondo, una red neuronal se compone de un gran número de nodos conectados y cada 
un peso particular. Este método tiene como pasos básicos la extracción de características y la 
segmentación por la red neuronal. En su mayoría muchas de estas técnicas de segmentación son 
adecuadas para aplicaciones médicas. Estas técnicas pueden utilizarse para el reconocimiento y la 
detección de objetos como ríos, carreteras, puentes en las imágenes satelitales mientras que en las 
imágenes médicas se pueden utilizar para detectar el cáncer.  

Algoritmos superpixel: SLIC y SLIC0  

La segmentación de imágenes es el proceso de particionar una imagen en múltiples conjuntos de 
píxeles, comúnmente conocidos como superpixels.  

La segmentación superpixel ha demostrado ser un paso de pre-procesamiento útil en muchas 
aplicaciones de visión por computadora (26,27). Los superpixels son capaces de capturar la 
redundancia dentro de la imagen y luego reducir la complejidad de las tareas de procesamiento 
posteriores, como la clasificación de objetos de imagen. Mientras que los seres humanos pueden 
dividir una imagen en objetos coherentes fácilmente, se encuentra bastante difícil hacer lo mismo 
para los sistemas de visión automática.  

Los algoritmos utilizados para generar superpíxeles se pueden clasificar aproximadamente como 
métodos basados en gráficos o basados en gradientes. 

El método de generación de superpíxeles basado en gráficos considera cada píxel como un nodo en 
el gráfico. El peso del borde entre dos nodos es proporcional a la similitud entre píxeles adyacentes. 
Los superpíxeles se crean minimizando la función de costo definida en el gráfico. Podemos nombrar 
algoritmos como NC05 [28;29], GS04 [30], SL08-Mooreetal [31;32], GCa10 y GCb10 [33;34] 

A partir de la agrupación inicial aproximada de píxeles, el método de ascenso por gradiente modifica 
iterativamente los grupos hasta que se cumplen algunos criterios de convergencia para formar 
superpíxeles 

Podemos nombrar algoritmos como MS02 [35], QS08 [36;37;38], WS91 [39], TP09 [40] 

En la última década se han propuesto varios algoritmos superpixel pero solo haremos mención del 
SLIC y SLIC0  

• SLIC - (41). El algoritmo en cuestión es particularmente interesante por su simplicidad. SLIC 
implementa una agrupación local de K-means para generar una segmentación de superpixels con 
K superpixels. Por lo tanto, SLIC se puede clasificar como el método del ascenso del gradiente.  

• SLIC0 - Versión de parámetro cero de SLIC (42). Presentado en 2012, SLIC0 elige de forma 
adaptativa el parámetro de compacidad para cada superpixel de forma diferente. Esto genera 
superpixels de forma regular tanto en regiones texturizadas como no texturizadas. La mejora 
viene con casi ningún compromiso sobre la eficiencia computacional de SLIC, mientras que 
proporciona mejoras en el rendimiento de segmentación. 

La comparación entre estos algoritmos mencionados y otros existentes se puede encontrar en (43,44, 
45), donde se prueban en busca de la capacidad de adherirse a los límites de la imagen, el tiempo de 
ejecución, la eficiencia de la memoria y el rendimiento general de segmentación.  
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De esta evaluación está claro que las diferentes implementaciones del algoritmo SLIC tienen un buen 
desempeño general y la mejor relación con las demandas computacionales de recursos siendo uno 
de los mejores enfoques posibles, tanto en términos de facilidad de programación como de 
rendimiento general.  

En particular, la variante SLIC0, de SLIC fue de particular interés, ya que los desarrolladores 
proporcionan el código fuente en C + + del algoritmo.  

La variante de SLIC0 que se implementará es una versión modificada, la cual fue ajustada por el Dr. 
Alain Martínez Laguardia con el fin de lograr una mayor eficiencia y eficacia del uso del procesador a 
la hora de ejecutar dicho algoritmo, la modificación más relevante fue el ajuste para procesar 
imágenes de 24 Mpx, siendo esta la resolución donde se mostraron los mejores resultados respecto 
a tiempo de cómputo. Todo lo anterior mencionado está expuesto en (46). 

La aplicación realiza segmentación (basado en SLIC0) con sólo un parámetro definido por el usuario, 
el número de superpixels a crear y luego exporta un archivo '.dat' con etiquetas de asociación entre 
píxeles y el superpixel correspondiente. Una segunda aplicación, también en C ++, toma el archivo 
'.dat' generado con el primero y exporta dos archivos de texto, uno con la asociación de píxeles a 
superpixel y un segundo con varias características de los superpixels calculados. Los archivos 
exportados son archivos de texto estándar (.txt), que se pueden importar fácilmente a Matlab u otro 
software profesional para la manipulación de datos. 

SLIC 

Un nuevo método para generar superpíxeles, que es más rápido que los métodos existentes, tiene 
una mayor eficiencia de memoria, muestra el mejor cumplimiento de límites actual y mejora el 
rendimiento del algoritmo de segmentación. La agrupación en clústeres iterativa lineal simple (SLIC) 
utiliza el algoritmo K-means para generar superpíxeles. En comparación con otros algoritmos, tiene 
dos diferencias importantes: 

1) Al limitar el espacio de búsqueda a un área proporcional al tamaño del superpíxel, el número de 
cálculos de distancia en la optimización se reduce significativamente. Esto reduce la complejidad 
lineal del número de píxeles N y es independiente del número de superpíxeles 

2) Las medidas de distancia ponderada combinan el color y la proximidad espacial, al tiempo que 
brindan control sobre el tamaño y la compacidad de los superpíxeles 

SLIC es similar al método descrito en [47] para el paso de preprocesamiento de estimación de 
profundidad, y no se ha estudiado en la dirección de superpíxeles 

SLIC es fácil de usar y comprender. De forma predeterminada, el único parámetro del algoritmo es k, 
el número de superpíxeles de aproximadamente el mismo tamaño. Para imágenes en color utiliza el 
espacio de color CIELAB. El proceso de agrupación comienza desde el paso de inicialización, con k 
centros de agrupación iniciales.  

Para generar superpíxeles de aproximadamente el mismo tamaño, el intervalo de cuadrícula es

. 

Se mueve el centro a la posición inicial correspondiente a la posición de gradiente más baja en la 
vecindad 3 × 3. Esto se hace para evitar colocar los superpíxeles en los bordes y reducir la posibilidad 
de crear superpíxeles con ruido.  

A continuación, en el paso de asignación, cada píxel i se asocia con el centro del clúster más cercano 
donde el área de búsqueda se superpone con su posición, como se muestra en la Figura 28.  
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Figura 28. Reducir el área de búsqueda de superpíxeles 

Esta es la clave para acelerar nuestro algoritmo, ya que limitar el tamaño del área de búsqueda reduce 
significativamente el número de cálculos de distancia y da como resultado una ventaja de velocidad 
significativa sobre el agrupamiento de kmeans convencional, donde cada píxel debe compararse con 
todos los centros de clúster. Esto solo se puede lograr mediante la introducción de una medición de 
distancia D, que determina el centro del grupo más cercano de cada píxel. Dado que el rango espacial 
esperado de un superpíxel es un área de tamaño aproximado S × S, se realiza una búsqueda de píxeles 
similares en el área 2S × 2S alrededor del centro del superpíxe. 

 

C. Representación y descripción: Se elige una representación de los datos para poder observar 
información cuantitativa de interés o rasgos que permiten diferenciar una clase de objetos de 
otros 

Cuando se quiere caracterizar una imagen para ser capaces de extraer información útil de ella se 
emplean descriptores de imagen. Estos descriptores, básicamente, analizan la imagen y obtienen de 
ella una serie de parámetros, llamados características. Para que la descripción resulte útil, ha de ser: 
única, completa e invariante frente a transformaciones geométricas y/o de intensidad. 

1. Métodos utilizados en el proceso de extracción de características primitivas de la imagen 

Textura 

La textura es otra característica importante de los objetos que nos permite medir la regularidad de 
una imagen. La textura es definida por un conjunto de pixeles, es decir un solo pixel no define algún 
tipo de textura [48]. 

Características de Tamura: Las características de Tamura son en total 6, y sus autores encontraron 
que hay tres de ellas que correlacionan fuertemente con la percepción humana: coarseness (se 
entiende como rugosidad), contraste y direccionalidad. En su trabajo original en [49] presenta la 
forma de calcular las 6 características para obtener un valor escalar por cada imagen procesada. 

1. Tamura Coarseness: El coarseness proporciona información acerca del tamaño de las texturas en 
la imagen. Cuando las texturas tienen un micro patrón y un macro patrón el procedimiento de 
Tamura considera el patrón más grande, y la forma de hacerlo es aplicando operadores de distinto 
tamaño de la siguiente manera: 

Sea I una imagen; I(x, y) el valor del pixel en la posición (x, y). 

a) Para cada pixel (x, y) se calcula el promedio sobre una vecindad definida que debe ser de un 
tamaño potencia de dos, por ejemplo 2 × 2; 4 × 4: 32 × 32 : 

 
b) Para cada punto (x, y) se calcula la diferencia entre las vecindades que no se sobre solapan a 

lados opuestos del punto en las direcciones horizontal y vertical. 

 
O 
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c) Para cada punto (x, y) seleccionar el valor con la diferencia más grande: 

 
d) Finalmente tomar el promedio 2S como una medida de rugosidad para la imagen: 

 
2. Contraste de Tamura: El contraste está influenciado por los niveles de grises, la polarización en 
los niveles de blanco y negro, definición de los bordes y periodo de repetición de los patrones. Este 
se calcula utilizando la media y la varianza de los valores de intensidad en una vecindad dada de la 
siguiente manera: 

 
En donde 

 
z = 0;25 es recomendado como la mejor discriminante de texturas 

3. Direccionalidad de Tamura: La presencia de dirección en la imagen es más interesante, que la 
orientación. Para calcular la direccionalidad, las derivadas horizontal y vertical son calculadas al 
convolucionar la imagen I utilizando los siguientes operadores de 3 × 3: 

 
Luego, para cada posición (x, y) se calcula el ´ángulo de orientación utilizando: 

 
Con la definición de las características de Tamura presentadas anteriormente, se obtienen tres 
medidas de textura por imagen, con los cuales puede construirse el vector de características que 
contiene información de las texturas, para construir un vector de Tamura. 

Métrica de Similitud en Textura: La medida de similitud de textura entre dos imágenes está 
representada de forma cuadrática entre el vector característica de la imagen de entrada y el vector 
característica de una imagen de la base de datos (Distancia Euclidiana), la cual es definida como: 

 
Donde, fij está definida como una característica de Tamura 

Forma 

Para el análisis de forma existe el uso de momentos invariantes afines los cuales son invariantes a 
traslación, rotación, escala y transformadas afines. Momentos Invariantes Afines: El interés de los 
momentos generales está en que los contornos pueden modelarse como un tipo especial de funciones 
acotadas y calcular los momentos de la misma, es por esto que se aplica en el reconocimiento de 
formas, los momentos invariantes clásicos fueron presentados por [50]. 

En [51] derivaron un nuevo conjunto de momentos invariantes que son invariantes bajo 
transformadas afines, este trabajo hace uso de 4. Momentos Geométricos y Momentos Centrales: La 
definición de los momentos geométricos 2-D de orden (p + q) de una funciones de distribución de 
densidad f(x; y) como la siguiente: 
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Los momentos que tiene la propiedad de traslación invariante son llamados momentos centrales y 
son definidos como: 

 
Donde x y y son las coordenadas del centroide de la función de la imagen f(x; y) 

 
Momentos invariantes afines implementados: 

 
Métrica de Similitud en Forma: La métrica utilizada para comprar dos vectores de forma es la 
Distancia Euclidiana. Si la variación se acerca a 0 significa que son similares en caso contrario no se 
parecen 

2. Algoritmos de análisis de texturas 

La descripción de la textura de una imagen ha constituido uno de los grandes temas en el campo del 
procesamiento de imágenes. Aunque no existe una definición formal de textura, intuitivamente se 
puede asociar a diversas propiedades de las imágenes, tales como suavidad, rugosidad, regularidad, 
etc. A veces se describe la textura de una imagen como la variación entre píxeles en una pequeña 
vecindad de dicha imagen. También se puede describir como un atributo que representa la 
distribución espacial de los niveles de intensidad en una región dada de una imagen digital. En ambas 
definiciones aparece el concepto de variación espacial en un entorno de vecindad [52;53].  

En cualquier caso, los enfoques utilizados para analizar las texturas son muy diversos, y difieren 
principalmente en el método utilizado para extraer las características de la textura.  

Básicamente se identifican cuatro categorías: 

a. Métodos estructurales. Estas técnicas describen las texturas como la composición de elementos 
bien definidos, tales como líneas paralelas regularmente espaciadas o concatenaciones de figuras 
geométricas de formas conocidas tales como pentágonos. Requieren la definición de reglas que 
permitan diseñar tal encadenamiento 

b. Métodos basados en el modelo. Estas técnicas se fundamentan en la construcción de un modelo 
empírico de cada píxel en la imagen basado en una suma ponderada de las intensidades de los 
píxeles en la vecindad del primero. Los parámetros estimados de los modelos así generados se 
utilizan como descriptores de las características de la textura. 

c. Métodos basados en una transformada. Estas técnicas convierten la imagen en una nueva forma 
o espacio utilizando las propiedades de frecuencia espacial de las variaciones de intensidad de 
los píxeles. La transformada más utilizada es la rápida de Fourier 

d. Métodos estadísticos. Son técnicas que describen la textura de una imagen a través de los 
momentos estadísticos de orden superior basados en los correspondientes histogramas de 
niveles de intensidad. Dentro de los descriptores estadísticos se encuentran los basados en las 
denominadas matrices de co-ocurrencia 

Dentro de los métodos estadísticos habituales, existen dos variantes: 

i. Momentos del histograma (Método estadístico de primer orden) 

ii. Matriz de co-ocurrencia (Método estadístico de segundo orden) 

Dichos métodos se basan en la distribución espacial de los niveles de gris, siendo el más simple el de 
los momentos del histograma, que se basa en utilizar los datos resultantes del histograma para 
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definir niveles de gris en una imagen o una región. Dada la siguiente ecuación donde m es el valor 
medio de z, es decir el número de niveles: 

“z”: intensidad de una imagen discreta p (zi) =1,2,…, L correspondiente al histograma, donde L es en 
número de niveles 

 
El segundo momento, también denominado varianza, toma bastante importancia porque es la media 
del contraste del nivel de gris que se puede utilizar para establecer descriptores de suavidad relativa. 
El tercer momento es una media de la torsión del histograma, mientras que el cuarto es la monotonía 
relativa. El quinto momento, así como los siguientes no están relacionados con la forma del 
histograma, pero ofrecen una mayor discriminación cuantitativa del contenido de la textura.  

El procedimiento es el siguiente: 

1. Se calcula el histograma de la imagen. 

2. Si a cada valor del histograma se divide por el número total de píxeles de la imagen, se obtiene un 
histograma de probabilidades de nivel de gris “h” anteriormente descritas. 

En el análisis de imágenes sólo por histogramas se desaprovecha la información correspondiente a 
la posición relativa de los píxeles entre sí, por lo que en este proyecto se ha decidido utilizar la matriz 
de coocurrencia para medir la cantidad de pixeles que se encuentran a una determinada distancia 
con un nivel de gris en común. 

La matriz de co-ocurrencia P [i, j] se define especificando una dirección de desplazamiento d= (di, dj) 
y contando todos los pares de píxeles separados por “d” y que tienen valores de gris “i” y “j”. 

Para analizar texturas pueden calcularse diferentes matrices de coocurrencia de la misma imagen 
con valores diferentes de “d. Los descriptores de textura son cálculos matemáticos obtenidos de la 
matriz de co-ocurrencia original de los niveles de gris de la imagen. 

A continuación, se explicará el modo de obtener la matriz de coocurrencia y posteriormente el cálculo 
de los descriptores de textura  

– DISEÑO DE LA MATRIZ DE CO-OCURRENCIA 

La matriz de co-ocurrencia describe la frecuencia de un nivel de gris que aparece en una relación 
espacial específica con otro valor de gris, dentro del área de una ventana determinada. La matriz de 
co-ocurrencia es un resumen de la forma en que los valores de los píxeles ocurren al lado de otro 
valor en una pequeña ventana. 

Normalmente el procedimiento de generación de imágenes de textura consta de cinco variables: 

− Tamaño de la ventana 
− Banda espectral de entrada 
− Las texturas derivadas 
− Cuantización (número de bits) del canal de salida 
− La componente espacial (distancia interpixel y el ángulo para el cómputo de la co-ocurrencia). 

La ventana debe de ser cuadrada y con número impar de píxeles. El resultado del cálculo de la textura 
es un único número que representa la ventana completa, el cual es colocado en el lugar del píxel 
central. Luego, la ventana se mueve un píxel y el cálculo se repite calculando una nueva matriz de co-
ocurrencia para esta nueva ventana y resultando un nuevo valor, para el píxel central de esta nueva 
posición de la ventana. De este modo se construye toda una nueva imagen con valores de texturas. 

– CONSTRUCCIÓN DE LA MATRIZ DE CO-OCURRENCIA 

Supongamos una imagen de ejemplo como se muestra abajo que consta de 4 píxeles de lado y 4 
niveles de grises: 0, 1, 2 y 3. Donde la direccionalidad es impuesta por los puntos cardinales. 
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La matriz de co-ocurrencia considera la relación espacial entre dos píxeles, llamados píxel de 
referencia y píxel vecino. Por ejemplo, si se escoge el píxel vecino que está situado un píxel a la 
derecha de cada píxel de referencia, 0 grados, esto se expresa como (1,0): 1 píxel en la dirección x, 0 
píxel en la dirección y. 

Para la representación de dichas direcciones al ser en parejas de píxeles, se interpreta dichas 
direcciones de la siguiente manera: 

− (1,0) orientación horizontal, 0 grados. 
− (0,-1) orientación vertical, 90 grados. 
− (1,1) orientación diagonal hacia arriba, 45 grados. 
− (1,-1) orientación diagonal hacia abajo, 135 grados. 

Las posibles combinaciones se muestran en la siguiente tabla: 

 
Cada píxel en la ventana se va convirtiendo sucesivamente en el píxel de referencia, empezando por 
el ubicado arriba a la izquierda y finalizando abajo a la derecha. 

Existen, por lo tanto diferentes matrices de co-ocurrencia para cada relación espacial según la 
direccionalidad deseada. En el siguiente ejemplo consideraremos la relación espacial (1,0), es decir, 
horizontal 

 
La interpretación de la matriz es de la siguiente manera: 

Se trata de contar el número de veces que aparece la combinación de dos números dada una 
dirección, y mostrar el resultado en la posición x, y de la matriz. En la matriz precedente, se cuenta 
cada píxel de referencia con su vecino a la derecha. Si el cálculo se realiza solo de este modo, usando 
sólo una dirección, entonces el número de veces que aparece la combinación (2,3) no es el mismo 
que la combinación (3,2) (por ejemplo el 3 está a la derecha del 2 una vez, pero a la izquierda 
ninguna), por lo tanto la matriz no es simétrica respecto de la diagonal.  

Ya que la simetría es necesaria para el correcto cálculo de la matriz de co-ocurrencia, se contará el 
par de píxeles dos veces, es decir, uno hacia la izquierda y otro hacia la derecha. Otro método de 
calcular dicha matriz resultante sería sumar a la matriz anterior su traspuesta, por lo que el resultado 
sería el siguiente: 
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Una vez obtenido el resultado correspondiente a la matriz simétrica, se debe interpretar dichos 
valores como probabilidad. Para ello se calculará el número de la casilla correspondiente con el 
número total de casillas, es decir, el número de veces que se produce dicho evento partido por el 
número de eventos totales. 

 
Donde: 

− “i” es el número de filas y “j” es el número de columnas 
− V es el valor de la celda (i, j) 
− 𝐶𝑖𝑗 es la probabilidad en la celda (i, j) 
− N es el número de filas o columnas. 

Al ser una matriz de 4x4, hay 12 posibles pares entre ellos, por lo que tendremos que sumar los otros 
12 de la matriz traspuesta y dan un resultado total de 24. 

Dicho esto, nos dispondremos a calcular la matriz resultante con dichos parámetros: 

 
Aspectos a resaltar de la matriz de co-ocurrencia 

1) Los elementos de la diagonal representan pares de píxeles que no tienen diferencias en su 
nivel de gris. A cuanta más probabilidad, menos contraste ya que la mayoría de los píxeles 
vecinos son similares. 

2) Al sumar los valores de la diagonal, obtenemos la probabilidad que un píxel tenga el mismo 
nivel de gris que su vecino. 
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3) Las líneas paralelas a la diagonal separadas una celda, representan los pares de píxeles con 
una diferencia de 1 en su nivel de gris. Esto conlleva que cuanto más nos alejemos de la 
diagonal, la diferencia entre niveles de gris será mayor. 

4) La suma de la diagonal se denomina “GLDV” (Grey Level Difference Vector) y también es 
utilizado como medida textural. 

– MEDIDAS TEXTURALES PARA EL ANÁLISIS 

Para medir la textura de las imágenes existen varias metodologías: 

• Primer orden: son las calculadas a partir de los valores de gris originales de la imagen y su 
frecuencia, como la media, varianza, desviación estándar. En estas medidas no se considera la 
relación entre los píxeles. 

• Segundo orden: medidas que consideran la relación de coocurrencia entre dada una orientación 
y una distancia a grupos de dos píxeles en una imagen original. 

• Tercer y más Orden: se consideran las relaciones entre 3 y más píxeles. Su cálculo es teóricamente 
posible aunque requiere un coste alto en tiempo y los resultados son difíciles de interpretar. 

Se han calculado las variables texturales de segundo orden a partir de la matriz de co-ocurrencia del 
nivel de gris (GLCM), que se construye a partir del análisis de parejas de píxeles para una distancia y 
orientaciones dadas entre ellos: 

✓ Inverse Difference Moment (ISM): también llamada homogeneidad: 

 
En general, cuanto mayor es el número de la diagonal en la matriz de co-ocurrencia, más 
homogénea es la textura en esa parte de la imagen que está siendo analizada. 

Se dirá que si los valores de la diagonal de la matriz de co-ocurrencia son próximos a uno (1) 
entonces es una imagen suave y los que son cercanos a cero o nulo entonces se dirá que al no 
tener homogeneidad es una imagen tosca. 

✓ Contraste: es la cantidad de variaciones locales en los tonos de gris de la imagen. Cuanto mayor 
es la variación de los tonos de gris, mayor es el contraste: 

 
✓ Correlación : es la dependencia lineal de los tonos de gris en la imagen: 

 
Si la correlación es 0, no existe correlación lineal entre los niveles de gris 

La correlación será la medida que tomaremos para saber si las muestras negativas y las muestras 
positivas. Al ser dependencia lineal de los tonos de gris en la imagen, nos indicará el grado de 
diferencia entre ambas. 

✓ Entropía: Es una medida de la complejidad de la imagen. A mayor entropía mayor complejidad: 

 
La entropía es una medida de desorden de un sistema físico. Esta idea trasladada al contexto de 
las imágenes nos permite deducir que cuando en un entorno de vecindad alrededor de un píxel 
existe un alto grado de desorden, la entropía será mayor que cuando existe un cierto orden. 

✓ La energía normalizada de una sub-imagen formada por N coeficientes se define como: 
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Donde 𝐸𝑛𝑖 refleja la distribución de energía a lo largo del eje de frecuencia sobre una escala y una 
orientación determinada. 

Los valores de la matriz de co-ocurrencia son de probabilidades por lo que la ecuación de energía 
lo que hace es maximizar los valores grandes y minimizar los valores más pequeños. Esta medida 
nos indicará los picos obtenidos durante el análisis de la matriz de co-ocurrencia 

Datos estadísticos complementarios 

✓ Media: Cantidad total de la variable distribuida a partes iguales entre cada observación 

 
La media de intensidad de una región no es en sí mismo un descriptor de textura, simplemente 
expresa el nivel medio de intensidad en la región. Éste dato es importante para el análisis ya que 
expresa el nivel medio del índice de la lesión para la región considerada. 

✓ Disimilitud: Falta de semejanza o de parecido entre dos o más muestras. 

 
La obtención de agrupamientos naturales responde a muy diversos criterios. En general, el factor 
fundamental es el uso de una medida de disimilitud entre agrupamientos. Siguiendo esta medida, 
lo que se consigue es distinguir si dos muestras pertenecen al mismo agrupamiento (disimilitud 
baja) o no (disimilitud alta). Esta medida también se aplica de agrupamiento a agrupamiento, a 
fin de propiciar fusiones y separaciones entre los diversos agrupamientos obtenidos. El objetivo 
de esta medida es conseguir agrupamientos lo más adecuados posibles, por lo que es un índice 
bastante descriptivo para saber si en una lesión hay disimilitud entre distintas imágenes. 

✓ Kurtosis: Analiza el grado de concentración que presentan los valores alrededor de la zona 
central de la distribución. 

 
Es el grado de concentración que presentan los valores alrededor de la zona central de la 
distribución. Nos mostrará el grado de extensión de los dos tipos de muestras en la imagen 

✓ Media Geométrica: Medida similar a la media que viene dada por: 

 
Define el porcentaje de reconocimiento de formas del muestreo indicándonos así, la uniformidad 
de la lesión. 

✓ Mediana: Representa el valor de la variable de posición central en el conjunto de datos ordenados 
dados. 

 si el número de muestras es impar 

 si el número de muestras es par 

Utilizada para eliminar ruido o detalles pequeños de poco interés puesto que sólo afecta a zonas 
con muchos cambios. Esta medida nos indicará el ruido de la imagen analizada. 

 

D. Aprendizaje de máquina para la construcción del modelo de clasificación: Esta etapa 
consistió en la construcción y comparación de modelos de clasificación supervisada, de los cuales 
se eligió el mejor para luego emplearse en la segmentación de las imágenes 

Primero se seleccionaron 5 algoritmos de entre los más relevantes según lo evidenciado en el estado 
del arte, después, una vez se entrenaron los modelos a modo de comparativa, se evaluó su 
rendimiento y finalmente se aplicó el mejor algoritmo en la segmentación 
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a) Algoritmos de clasificación  

Se seleccionaron los siguientes algoritmos de clasificación supervisada: Random Forest, Supourt 
Vector Machines (SMO), LogiBoost, J48 y BayesNet. Empleando el entorno KNIME que tiene integrada 
Weka. 

Random Forest. Este algoritmo está entre los mejores y más usados, fue introducido por Breiman 
[54;55;5657]. También conocido en castellano como “Bosques Aleatorios” es una combinación de 
árboles predictores tal que cada árbol depende de los valores de un vector aleatorio probado 
independientemente y con la misma distribución para cada uno de estos. Es una modificación 
sustancial de bagging que construye una larga colección de árboles no correlacionados y luego los 
promedia.  

Supourt Vector Machines (SMO). Sequential Minimal Optimization es un algoritmo que sobresale por 
su eficiencia con grandes conjuntos de datos. Implementa el algoritmo de optimización mínima 
secuencial de Platt [58] para el entrenamiento de un clasificador de soporte de vectores [59;60]. Esta 
implementación reemplaza globalmente todos los valores faltantes y transforma los atributos 
nominales en binarios. También normaliza todos los atributos por defecto. (En ese caso, los 
coeficientes de la salida se basan en los datos normalizados, no en los datos originales - esto es 
importante para interpretar el clasificador).  

LogitBoost. Es la implementación en Weka del algoritmo de regresión logística aditiva introducido 
en [61;62]. Este realiza la clasificación usando un esquema de regresión como el base learner, y puede 
manejar problemas de varias clases. Este algoritmo se seleccionó debido a su rendimiento en 
comparación a otros algoritmos tipo Boosting para este problema.  

J48. Es la implementación de código abierto (Weka) del algoritmo C4.5 desarrollado por Quinlan 
[63;64;65] el cual genera un árbol de decisiones podado o no-podado. Estos árboles son referidos 
como un clasificador estadístico. C4.5 construye árboles de decisión desde un grupo de datos de 
entrenamiento, usando el concepto de entropía de información. 

BayesNet. Es la implementación del clasificador de probabilidad Naive Bayes. Está estructurado 
como una combinación de un grafo acíclico dirigido de nodos y enlaces, y un conjunto de cuadros de 
probabilidad condicional [66;67;68]. Este clasificador demostró un mayor rendimiento frente a otros 
del tipo bayesiano. 

b) Métricas de evaluación 

Conforme al problema tratado, el enfoque utilizado para entrenamiento y test, varía un poco con 
respecto a la tradicional en aprendizaje supervisado, ya que aquí no solo se debe clasificar las filas 
del dataset (que en este caso corresponden a superpixeles) sino que además se necesita presentar la 
segmentación final de la imagen. Por tanto, cada vez se probó el método con al menos 1 imagen y se 
entrenó con el resto.  

Debido a la existencia de diversos criterios sobre lo que se entiende por buena calidad de imagen 
desde el punto de vista físico y desde el punto de vista médico, en la evaluación de la calidad de las 
imágenes digitales, está generalizado el uso de dos tipos de medidas: objetivas y subjetivas para 
cualquier tipo de técnica o estudio.  

En este caso se escogieron las medidas subjetivas, ya que estas no solamente sirven para evaluar la 
calidad en imágenes sino que pueden ser aplicadas a otras situaciones como puede ser en este caso 
la evaluación de la efectividad del software Fiji en el conteo de los eritrocitos. 

Como ejemplo de estas medidas o indicadores de desempeño se encuentran la sensibilidad, 
especificidad, predictividad negativa, predictividad positiva, tasa de falsa alarma o fracción de falsos 
positivos, etc. Algunos autores emplean estas medidas e incluyen otras para evaluar métodos de 
segmentación, como son: la exactitud, la medida-F y el recall [69]. Otros en cambio emplean además 
la eficacia y el nivel de prueba [70] 

Antes de entrar a los detalles de dichas métricas, es importante comprender la matriz de confusión 
de una evaluación de clasificación binaria (figura). Las etiquetas de clase en el conjunto de 
entrenamiento pueden tomar solo dos valores posibles, a los que normalmente podemos referirnos 
como positivo o negativo.  



Informe de Avance y/o Final 2020 Anexo 00 CCUTIME0005279TC 

 

CESARI Matilde Inés 41 
 
 

Las instancias positivas y negativas que un clasificador predice correctamente se denominan 
positivos verdaderos (TP) y negativos verdaderos (TN), respectivamente. De forma similar, las 
instancias clasificadas incorrectamente se denominan falsos positivos (FP) y falsos negativos (FN). 

 
Figura 29. Matriz de confusión de la clasificación binaria. 

Para el desarrollo de este trabajo se escogieron específicamente las medidas estadísticas de exactitud 
(Ex), especificidad (Sp), sensibilidad (Se), predictividad positiva (Pp) y medida-F. 

• La Exactitud (Accuracy) o precisión, se utiliza como una medida estadística de lo bien que una 
prueba de clasificación binaria identifica o excluye correctamente una condición. Es decir, la 
precisión es la proporción de resultados verdaderos (tanto los verdaderos positivos como los 
negativos verdaderos) entre el número total de casos examinado.  

La precisión da un panorama general (a nivel multi-clase) del rendimiento del modelo construido 
y, como se observa en la ecuación, la precisión tiene en cuenta el número de verdaderos negativos. 

 

• La Especificidad es la probabilidad de clasificar correctamente negativos. 

 

• La Sensibilidad (recall, sensitividad, true positive rate (TPR)) o Tasa de detección es la 
probabilidad de que los positivos sean detectados correctamente. Se define como el número de 
verdaderos positivos divididos por el número total de elementos que realmente pertenecen a la 
clase positiva (es decir, la suma de verdaderos positivos y falsos negativos, que son casos que no 
fueron etiquetados como pertenecientes a la clase positiva pero deberían haberlo sido 

 

• La Predictividad Positiva es la probabilidad de clasificar bien un positivo. Representa el número 
de positivos verdaderos (es decir, el número de elementos correctamente etiquetados como 
pertenecientes a la clase positiva) dividido por el número total de elementos etiquetados como 
pertenecientes a la clase positiva (es decir, la suma de verdaderos positivos y falsos positivos, que 
son elementos incorrectamente etiquetados como pertenecientes a la clase) 

 

• La Medida F es la probabilidad de que el modelo marque los positivos señalados por el experto 
sin cometer errores 

 

a) Validación cruzada  

La validación cruzada (cross-validation) es una técnica utilizada para evaluar los resultados de un 
análisis estadístico y garantizar que son independientes de la partición entre datos de entrenamiento 
y prueba [71;72;73;74].  

En la validación cruzada de K iteraciones los datos de muestra se dividen en K subconjuntos. Uno de 
los subconjuntos se utiliza como datos de prueba y el resto (K −1) como datos de entrenamiento. El 
proceso de validación cruzada es repetido durante K iteraciones, con cada uno de los posibles 
subconjuntos de datos de prueba. Finalmente se realiza la media aritmética de los resultados de cada 
iteración para obtener un único resultado. 
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Figura 30: Validación cruzada 10-fold 

Entonces para evaluar y garantizar estadísticamente los resultados se empleó la técnica Cross 
Validation a 10-fold: en cada iteración el conjunto de entrenamiento lo conformaron 9 imágenes y el 
de test, 1 imagen, a modo ilustrativo ver la Figura. 

b) Anotación Ground truth  

El ground truth es el procedimiento que permite evaluar la precisión de la segmentación del sistema 
CAD al compararla con la segmentación manual hecha por los expertos. Según [75] cuando el ground 
truth (imágenes marcadas) está presente, la segmentación se puede medir en términos de precisión 
(tasa de acierto) y robustez. La precisión por su parte refleja la exactitud de la segmentación con 
respecto a las imágenes marcadas. 

El ground truth se realizó empleando el mismo procedimiento de asignación de clases, esto teniendo 
en cuenta que el fin del procedimiento es el mismo: asignar clase al superpixel en función de su 
imagen marcada. 

c) Imágenes segmentadas 

Finalmente, a partir de la clasificación se construyeron imágenes segmentadas las cuales son 
similares a las imágenes de etiquetas pero con la diferencia de que fueron producidas por el sistema 
CAD. Debe recordarse que Inicialmente la imagen fue descompuesta en sus superpixeles, los cuales 
fueron clasificados. Por tanto, fue necesario mantener dentro del dataset de clasificación una 
columna con la información de la posición de cada superpixel en la imagen. Así después de la 
clasificación se usó la información de esa columna (que no fue tenida en cuenta por el clasificador) 
para colocar cada superpixel en su posición agrupándolos de acuerdo a su clase [76]. 
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Herramienta Fii ImageJ 

El software ImageJ es un programa de dominio público multiplataforma (existen versiones para 
Windows, Linux y Mac OS) [1]. Es muy útil y de gran diversidad para el procesamiento digital de 
imágenes, siendo utilizado incluso en numerosos proyectos de investigación.  

Ha sido también utilizado con anterioridad en estudios histológicos de retina [2]. Debido a su enorme 
versatilidad, se ha utilizado para detectar cambios de densidad en el número de células o cambios en 
la morfología de determinados tipos celulares, como las células de microglía, que en procesos 
degenerativos proliferan, cambian de forman y migran hacia los lugares donde están produciéndose 
esos cambios degenerativos [3]. También se ha publicado recientemente un artículo en el que se 
desarrolla una nueva macro del ImageJ que permite identificar células, por técnicas histoquímicas y 
de inmunofluorescencia, que están degenerando en criosecciones de retina [2]. 

ImageJ es una aplicación para el procesamiento y análisis de imagen escrito en Java y desarrollado 
por el NIH(National Institutes of Health) ampliamente usado en las ciencias naturales, gracias a su 
simple interfaz, su velocidad de procesamiento y su extensibilidad. 

ImageJ es un software de dominio público, lo que supone que tanto su adquisición como sus 
actualizaciones o la necesidad de nuevas licencias no tienen coste alguno. Al tratarse de una 
aplicación libre favorece la independencia tecnológica del desarrollador, lo que generalmente implica 
mayor calidad y completitud. Se adapta fácilmente a las necesidades de distintos grupos trabajando 
en campos muy diversos. El código fuente se encuentra completamente accesible y el desarrollador 
lo puede adaptar a sus necesidades si lo cree necesario. 

ImageJ se ha utilizado como librería base para utilizar sus mismas estructuras de datos así como su 
funcionalidad y otros plugins adicionales. Está diseñado con una arquitectura abierta que permite la 
fácil adición de plugins y macros personalizados usando las herramientas proporcionadas por las 
librerías de tratamiento de imagen de ImageJ. Esta característica ha popularizado la plataforma por 
su facilidad para enseñar tratamiento de imagen. 

ImageJ es capaz de leer múltiples formatos entre los que se encuentran, TIFF, PNG, GIF, JPEG, BMP, 
DICOM, FITS, o RAW y por tanto, así como editar, analizar, procesar, etc. imágenes de 8, 16,32 o 24 
(RGB) bits. Maneja pilas de imágenes en 3, 4 y 5 dimensiones y utiliza multiproceso paralelizando las 
operaciones que requieran más tiempo. Obviamente al utilizar la JVM elimina los problemas de 
portabilidad dado que la inmensa mayoría de las plataformas actuales soportan ésta. 

ImageJ puede ejecutarse en cualquier computadora con Máquina virtual Java 5 o superior, como 
aplicacion de es-critorio o incluso como un applet. Hay tambien distribucionesdescargables para 
Microsoft Windows, Mac OS, Mac OS X, Linux, y Sharp Zaurus PDA.  

Fiji ( Fiji es sólo ImageJ ) es un paquete de procesamiento de imágenes de código abierto basado en 
ImageJ . El objetivo principal de Fiji es proporcionar una distribución de ImageJ con muchos paquetes 
de plugins. Fiji cuenta con un sistema de actualización integrado y tiene como objetivo proporcionar 
a los usuarios una estructura coherente de menú, una amplia documentación en forma de 
descripciones detalladas de algoritmo y tutoriales, y la capacidad de evitar la necesidad de instalar 
varios componentes de diferentes fuentes [4].  

Fiji también está dirigido a desarrolladores, a través del uso de un sistema de control de versiones , 
un gestor de incidencias, canales de desarrollo dedicados, y una infraestructura de rápida creación 
de prototipos en forma de un editor de scripts que apoya BeanShell , Jython , JRuby , y otros lenguajes 
de script, así como justo a tiempo de desarrollo de Java [5]. 

 
1 Caraballo RM. Introducción al programa ImageJ. Disponible en: 

http://difusion.df.uba.ar/ConectarIgualdad/1.%20Tutorial%20ImageJ.pdf 
2 Maidana DE, Tsoka P, Tian B, Dib B, Matsumoto H, Kataoka K, et al. A novel ImageJ macro for automated cell 

death quantitation in the retina. Invest Ophthalmol Vis Sci 2015; 56:6701-6708 
3 Bejarano-Escobar R, Blasco M, Martín-Partido G, Francisco-Morcillo J. Light-induced degeneration and microglial 

response in the retina of an epibenthonic pigmented teleost: age-dependent photoreceptor susceptibility to cell 
death. J Exp Biol 2012; 215:3799-3812 

4 ImageJ/Fiji,imagej.nih.gov/ij/ 
5 https://es.qwe.wiki/wiki/FIJI_(software) 
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Instalación y mantenimiento 

El programa ImageJ puede ser descargado desde http://imagej.nih.gov/ij/download.html. Los 
detalles sobre cómo instalar ImageJ en Linux, Mac OS X y Windows se encuentran disponibles en: 
http://imagej.nih.gov/ij/docs/install/ (Help>Installation…command). Es especialmente útil 
la plataforma específica “Troubleshooting” y la sección “Known Problems”. La instalación de Fiji se 
describe en http://fiji.sc/wiki/index.php/Downloads. 

El paquete de descarga puede no contener las últimas correcciones de errores, por lo que es 
recomendable actualizar ImageJ justo después de la primera instalación. Actualizar IJ consiste 
únicamente en ejecutar Help>Update ImageJ…, lo cual instalará la última versión ij.jar en la carpeta 
de ImageJ (en Linux y Windows) o dentro de ImageJ.app (en Mac OS X). 

Help>Update ImageJ… puede ser usado tanto para actualizar el archivo ij.jar como para volver a una 
versión anterior. Las actualizaciones de la versión son anunciadas frecuentemente en las noticias del 
sitio web de IJ y están etiquetadas alfabéticamente (p.e., v.143m). Típicamente, estas actualizaciones 
contienen varias nuevas características y corrección de errores, descritos con detalle en la página de 
noticias de ImageJ.  

Las “Daily builds”, por otra parte, son etiquetadas con subíndices numéricos (p.e., v.1.43n4) y son 
a menudo actualizados sin documentación. No obstante, si están disponibles, las notas de 
actualizaciones para las “daily builds” pueden encontrarse en 

 http://imagej.nih.gov/ij/source/release-notes.html.  

Cuando un ciclo de actualización finaliza (la versión v.142 acabó con 1.42q, la v.1.43 con 1.43u, etc.) 
se crea un “paquete de instalación”, descargable desde  

http://imagej.nih.gov/ij/download.html.  

Normalmente, este paquete se incluye con una pequeña lista de add-ons (Macros, Scripts y Plugins). 

ImageJ solo no es tan potente: su poder realmente es el vasto repertorio de Plugins que son capaces 
deextender las funcionalidades de ImageJ más allá de su núcleo básico. Los cientos, probablemente 
miles, de plugins gratuitos disponibles de contribuyentes de todo el mundo juegan un papel esencial 
en el éxito de ImageJ. Es conveniente el uso de Distribuciones de ImageJ que incluyen de forma 
preorganizada una colección de add-ons. 

Fiji (Fiji Is Just ImageJ – Batteries included) es una distribución de ImageJ junto con Java, 
Java 3D y varios plugins organizados dentro de una estructura de menús coherentes. Citando a sus 
desarrolladores, “Fiji es a ImageJ lo que Ubuntu es a Linux”. El foco principal de Fiji es el de ayudar a 
la investigación en ciencias biológicas, focalizándose en el registro de imágenes, stitching, 
segmentación, extracción de características y visualización 3D, entre otros. También soporta muchos 
lenguajes de script (BeanScript, Clojure, Jython, Python, Ruby).  

Es importante destacar, que Fiji incorpora un conveniente actualizador que sabe si tus ficheros están 
actualizados, obsoletos o modificados localmente. Existe una documentación extensiva disponible 
para la mayoría de estos plugins.  

El proyecto Fiji fue presentado públicamente por primera vez en la ImageJ User and Development 
Conference en Noviembre del 2008. La distribución Fiji ha sido la elegida para trabajar en este 
Proyecto. 

 

Interfaz de Usuario 

A diferencia de la mayoría de programas de procesamiento de imagen, ImageJ no incorpora un área 
de trabajo principal. La ventana principal de ImageJ es realmente parca, conteniendo únicamente una 
barra de menú (que aparece en la parte superior de la pantalla si se usa Mac) la cual incluye todos los 
Comandos, una Barra de Herramientas, una Barra de Estado y una Barra de Progreso. Las imágenes, 
histogramas, perfiles, widgets, etc. son mostradas en ventanas adicionales.  

Los resultados de las mediciones son mostrados en la Tabla de Resultados. La mayoría de ventanas 
pueden arrastrarse a lo largo de la pantalla y redimensionarse. 

  

http://imagej.nih.gov/ij/source/release-notes.html
http://imagej.nih.gov/ij/download.html
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La barra de herramientas de ImageJ contiene útiles para hacer selecciones, dibujar, aumentar y 
desplazar, etc. Además, la parte derecha de la barra de herramientas contiene siete espacios que 
pueden albergar cualquiera de los más de 60 útiles y más de 15 juegos de herramientas disponibles 
en la web de ImageJ. 

 
Interfaz de Usuario 

Todas las herramientas de ImageJ comparten características comunes: 

– La flecha roja en la esquina inferior derecha de algunos iconos en la barra de herramientas 
representa un menú contextual que puede desplegarse mediante un clic derecho en el icono de 
dicha herramienta. 

– Si el diálogo ‘Options’ está disponible para una herramienta en particular, podrá accederse a él 
haciendo doble clic sobre el icono de la herramienta (p.e., Wand Tool). 

 
Cuando el cursor se sitúa sobre la imagen, las intensidades de los píxeles y sus coordenadas aparecen 
en la barra de estado. Después de ejecutar un filtro, el tiempo transcurrido y la velocidad de 
procesamiento (en píxeles/segundo) son también mostrados. Cuando se hace clic sobre la barra de 
estado la versión de ImageJ, versión Java, memoria en uso, memoria disponible y porcentaje de 
memoria utilizada son mostrados. 

Además, clicando sobre la barra de estado de ImageJ, se fuerza a ejecutar el “recolector de basura” de 
Java, el cual puede ayudar a recuperar memoria no utilizada (mirar Edit>Options>Memory & 

Threads…). Se puede acceder mediante Plugins>Utilities>Monitor Memory…: cada clic en la barra 
de estado debería conducir a un aumento en la utilización de la memoria de ImageJ. 
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Si se ha definido una escala espacial en Image>Properties… o Analyze>Set Scale…, las propiedades 
de la selección se muestran en la barra de estado en unidades calibradas. Redimensionando o 
moviendo mientras se mantiene presionado “Alt” se forzará a que esta información se muestre en 
píxeles. 

 
Memoria utilizada 

La barra de progreso, localizada a la derecha de la barra de estado, muestra el progreso de tiempo 
consumido por las operaciones. No aparecerá si la operación requiere menos tiempo de, 
aproximadamente, un segundo. 

 
Barra de progreso 

Para abrir una imagen en ImageJ hay al menos 2 caminos. 

a) desde el menú File como en la mayoría de los programas: 

 
Desde el menú File seleccionamos Open y en el cuadro de diálogo elegimos la imagen que deseamos 
abrir. 
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b) Si tenemos abierto un explorador de archivos (Explorador de Windows) podemos hacer click con 
el botón izquierdo del mouse sobre el archivo y, mientras mantenemos apretado dicho botón, 
arrastrar la imagen y soltarla sobre la barra del ImageJ (donde dice <<Drag and Drop>>): 

 
Cuando se abra una imagen, ya sea mediante File>Open, arrastrando y soltando el archivo, o 
File>Open Samples, ImageJ abrirá una nueva ventana. La ventana tiene el nombre del fichero como 
título, y muestra alguna información útil sobre la imagen: la resolución real (en el caso de la imagen 
inferior en centímetros cuadrados), la resolución de píxeles, el tipo de imagen y la memoria requerida 
por la imagen. 

 
Ventana de la imagen abierta 

ImageJ permite seleccionar una región de la imagen para luego aplicar algún algoritmo (no todos lo 
permiten) solo a esos pıxeles, en lugar de a la imagen completa. Nos referiremos a esa región como 
región de interés, ROI, o simplemente región. Los algoritmos que se analizan están implementados 
como plugins internos.  

Formatos y tipos de imágenes 

En términos de bits por píxel (bpp), el tipo más frecuente de imágenes (Image>Type>) que ofrece 
ImageJ son (ImageJ soporta bastantes más tipos de imágenes): 

– 8-bit: Imágenes que pueden mostrar 256 (28) niveles de grises (únicamente enteros). 
– 16-bit: Imágenes que pueden mostrar 65536 (216) niveles de grises (únicamente enteros). 
– 32-bit: Imágenes que pueden mostrar 4, 294, 967, 296 (232) niveles de grises (números 

reales). En imágenes de 32 bits, los píxeles son descritos mediante valores de punto flotante 
y pueden tener cualquier valor de intensidad, incluyendo NaN (Not a Number). 

– Color RGB: Las imágenes en color pueden mostrar 256 valores en el canal Rojo, Verde y Azul. 
Estos son imágenes de 24 bits (23×8). Las imágenes de color RGB también pueden ser 
imágenes de color de 32 bits (imágenes de color de 24 bits con 8 bits que codifican valores 
de combinación alfa, i.e., latransparencia).  
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Cómo cambiar el tipo de imagen 

De forma nativa (i.e., sin la necesidad de plugins de terceros) ImageJ abre los siguientes formatos: 
TIFF, GIF,JPEG, PNG, DICOM, BMP, PGM y FITS. Muchos más formatos son soportados con la ayuda 
de plugins. 

Estos son discutidos después en Formatos No Nativos. 

o TIFF: (Tagged Image File Format) es el formato “por defecto” de ImageJ. Las imágenes pueden 
ser de 1 bit, 8 bits, 16 bits (sin signo), 32 bits (reales) o color RGB. Los archivos TIFF con múltiples 
imágenes del mismo tipo y tamaño se abren como Stacks (pilas) o Hyperstacks. ImageJ abre sin 
pérdidas archivos TIFF mediante los esquemas de comprensión LZW, PackBits y ZIP. Además, los 
archivos TIFF pueden ser abiertos y guardados como archivos ZIP. Las etiquetas e información 
necesarias para importar el archivo (número de imágenes, diferencia respecto a la primera 
imagen, diferencia entre imágenes) son impresas en el Log Window cuando ImageJ está 
funcionando en modo de depuración (Edit>Options>Misc…). 

o DICOM: (Digital Imaging y Communications in Medicine) es un estándar popular en la 
comunidad de imágenes médicas. El soporte en ImageJ se limita a archivos DICOM sin comprimir. 
Los archivos DICOM con múltiples imágenes se abren como pilas. Utilizar Image>Show Info… para 
mostrar la información de cabecera DCIM. Una secuencia DICOM puede ser abierta usando 
File>Import>Image Sequence… o arrastrando y soltando el archivo sobre la ventana de ImageJ. 
Las secuencias importadas se ordenan mediante el número de imagen en lugar del nombre del 
archivo y las etiquetas se preservan cuando las imágenes DICOM son guardadas en el formato 
TIFF. ImageJ soporta diccionarios DICOM personalizados, tales como el que se encuentra en 
http://imagej.nih.gov/ij/download/docs/DICOM_Dictionary.txt. Más información se puede 
encontrar en el Center for Avanced Brain Imaging. 

o FITS: (Flexible Image Transport System) es el formato adoptado por la comunidad 
astronómica para intercambio de datos y almacenamiento de archivos. Utilizar Image>Show Info… 
para mostrar la cabecera FITS. 

o PGM: (Portable GrayMap), PBM (Portable BitMap) y PPM (Portable PixMap) son formatos de 
imágenes simples que utilizan una cabecera ASCII 

Si ImageJ no reconoce el tipo de fichero llama al plugin de lectura apropiado usando 
HandleExtraFileTypes, un plugin incorporado con ImageJ. Si esta falla, se intenta abrir el archivo 
usando la librería OME Bio-Formats (si está presente), un plugin notable que soporta más de cien de 
los más comunes tipos de formatos usado en microscopia. Si no obstante el archivo no puede ser 
abierto, se muestra un mensaje de error. Debido a que estos plugins están bajo un desarrollo 
constante, es importante mantenerlos actualizados. 
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Además, en el sitio web de ImageJ se recogen más de sesenta plugins que reconocen los formatos de 
ficheros más “exóticos”. El Portal de Documentación de ImageJ también mantiene una lista de los 
formatos de ficheros soportados por ImageJ. 

Calibración de Imágenes para medir 

Cuando se necesita medir posiciones en el espacio es necesario calibrar la imagen de modo de 
traducir la ubicación en píxeles en posición en términos de distancias respecto de algún punto de la 
imagen medidas en cm, metros o alguna otra unidad de longitud. Para esto tenemos que saber a 
cuántos metros equivale 1 píxel. Para ello lo que se suele hacer es incluir en la imagen un objeto de 
dimensiones conocidas. Entonces, midiendo cuántos píxeles ocupa en la imagen dicho objeto uno 
puede saber cuánto mide un píxel. 

Por ejemplo, al utilizar la pelota para calibrar las imágenes. Sabemos que la pelota mide 6.7cm porque 
la medimos con una cinta métrica. Ahora lo que necesitamos es saber cuántos píxeles mide la pelota. 
Una opción es ampliar mucho la imagen en la zona de la pelota y mirar cuántos píxeles ocupa 
utilizando el cursor. Para eso nos paramos con el cursor en un extremo de la pelota, tomamos nota 
de la posición del cursor y luego desplazamos el cursor hasta el otro extremo de la pelota donde 
volvemos a tomar nota de la posición del cursor. La distancia en píxeles entre esos dos puntos nos da 
el tamaño de la pelota. 

Podemos hace algo un “poco más preciso”, es trazar un perfil de intensidades sobre la pelota. Para 
ello procedemos del siguiente modo: a) Utilizando la lupa, hacemos zoom sobre la pelota hasta que 
vemos los píxeles. b) Seleccionamos en la barra de botones del ImageJ el botón que tiene una línea. 
Esta herramienta nos permite dibujar una recta con el mouse sobre la imagen y después ver que 
valores toma la imagen a lo largo de dicha recta. Dibujemos entonces una recta que pase por un 
diámetro de la pelota. Una vez que trazamos la recta apretamos la combinación de teclas ctrl + k al 
mismo tiempo. Al hacerlo ImageJ nos dibuja un perfil de la imagen sobre la recta. Podemos mejorar 
nuestra medición de la pelota, repitiendo el procedimiento para muchos cuadros distintos y después 
hacer un poco de estadística para mejorar nuestro valor para el diámetro de la pelota. 

Una vez que tenemos una medición para el tamaño de la pelota en píxeles calibramos el tamaño de 
píxel en unidades de longitud. Si la pelota mide 6.7cm y eso equivale en la imagen a unos 10 píxeles, 
quiere decir que el tamaño del píxel es de aproximadamente 0.0067m. Es decir, unos 6.7mm por 
píxel. 

A continuación, en el menú desplegable Analyze señalar Set Scale. Indicar la distancia que 
previamente se la dibujado sobre la regla, las unidades en que está medida y señalar “Global” para 
que utilice esa calibración en todas las mediciones. 

Elegir la misma región en varias imágenes  

Elegir una región del fondo (background) en una de las imágenes y dibujar un rectángulo (u otra 
figura). Con M aparece la información de la región, como por ej. el área, el promedio de la intensidad, 
la std, el max y el min. Si se quieren agregar más parámetros ir en la misma ventana a Resultados y 
clickear los resultados que se quieren mostrar.  

Para colocar la misma región en otra imagen hay que copiar la región: Análisis – Tools – 

RoiManager y se abre una ventana clickear Add esto hace que se copie la región y queda con un 
código numérico. Clickear en la imagen y hacer doble clic sobre el código numérico (entonces 
aparece la misma región en la imagen post) apretar M y fijarse en el promedio. 

El ROI manager, un gestor de las regiones de interés  

Cualquiera que haya sido la estrategia elegida para llevar a cabo la segmentación el resultado final es 
una selección formada por una o varias regiónes de interés o ROI que discrimina los objetos del fondo. 
Estas ROI se pueden gestionar gracias a una herramienta que es el ROI manager.  

Edit > Selección > Add to Manager ó (Ctr + T)  

El ROI manager no solo nos permite crear una lista de ROI a la que podemos ir añadiendo elementos 
(Add) sino que también nos permite salvarlas (more > save…) a un archivo, ya sea de forma individual 
o si seleccionamos varias simultáneamente, y volver a abrirlas en el futuro (more > open…) sobre la 
misma imagen que hemos analizado o cualquier otra.  
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Esto es muy importante ya que si vamos a presentar un trabajo con datos cuantitativos, además de 
conservar el archivo de imagen original también deberíamos de conservar las regiones que hemos 
cuantificado. También permite aplicar la misma ROI a los diferentes canales de una Stack 
posibilitando por ejemplo segmentar núcleos celulares en el canal del DAPI para luego analizar la 
expresión nuclear de nuestra proteína de interés en otro canal.  

Además el ROI manager nos permite seleccionar una o varias regiones simultáneamente, cambiarles 
el nombre (Rename), realizar operaciones lógicas de conjuntos entre ellas (more > AND, OR, XOR) y 
finalmente cuantificarlas (more > multimeasure).  

Cuando ya tenemos nuestros objetos de interés seleccionados como ROI, que como acabamos de 
comentar podemos gestionar con el ROI manager realizar la cuantificación es trivial. Primero 
escogemos que parámetros deseamos cuantificar y luego los medimos.  

Analyze > Set Measurements…  

Analyze > Measure 

Únicamente es importante mencionar que cuando estamos cuantificando una ROI no debemos de 
seleccionar la opción de utilizar umbral cuando establezcamos las medidas que queremos realizar 
(NO!! limit to threshold). Esta opción solo es necesaria si vamos a realizar la cuantificación sobre una 
imagen entera en la cual hemos establecido el umbral, pero no hemos creado una selección a partir 
de él. En este caso al activar esta opción cuando proceda a realizar la cuantificación únicamente se 
tendrán en cuenta aquellos píxeles que estén por encima del umbral. 

Pilas, Pilas Virtuales e Hiperpilas 

ImageJ puede mostrar múltiples imágenes espaciales o temporales relacionadas en una única 
ventana. Este conjunto de imágenes son llamadas pilas. Las imágenes que conforman una pila se 
denominan diapositivas. En pilas, un píxel (que representa datos de la imagen 2D en un mapa de bits) 
se convierte en un voxel (píxel volumétrico), i.e., un valor de intensidad sobre una cuadrícula regular 
en un espacio de tres dimensiones. 

Todas las diapositivas en una pila deben tener el mismo tamaño y la misma profundidad de bit. Una 
barra de deslizamiento permite moverse a través de las diapositivas y el deslizador está precedido 
por un icono de play/pause que puede ser empleado para comenzar/parar una animación. Haciendo 
clic con el botón derecho sobre este icono aparecerá el cuadro de diálogo Animation Options…Todos 
los filtros de ImageJ procesarán, como opción, todas las diapositivas de una pila. ImageJ abre archivos 
TIFF de múltiples imágenes, y guarda pilas como archivos TIFF de múltiples imágenes.  
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El comando File>Import>Raw… abre otras imágenes múltiples sin comprimir.  

Un directorio de imágenes puede ser abierto como una pila ya sea arrastrando y soltando el 
directorio sobre la ventana de ImageJ o mediante la elección File>New>Image… y configurar el campo 
“Slices” a un valor mayor que uno. El submenú Image>Stacks> contiene comandos para operaciones 
comunes con pilas. 

Las pilas virtuales residen en el disco (de forma opuesta a las residentes en RAM) y son la única 
forma de cargar secuencias de imágenes que no caben en la RAM. Se deben tener en cuenta varias 
cosas cuando se trabaja con pilas virtuales: 

Las pilas virtuales son de solo lectura, de forma que los cambios hechos a los píxeles de datos no son 
guardados cuando se cambia a otra diapositiva. Esto puede ser evitado mediante el uso de macros 
(p.e., Process Virtual Stack) o el comando Process>Batch>Virtual Stack… 

Puede haber desbordamiento de memoria al emplear comandos como Image>Crop ya que cualquier 
pila generada a partir de comandos que no genere pilas virtuales será residente en RAM.  

Normalmente se puede acceder de forma más rápida a pilas virtuales TIFF que a pilas virtuales JPEG. 
Una secuencia JPEG puede ser convertida a TIFF abriendo las imágenes JPEG como una pila virtual y 
usando File>Save As>Image Sequence… para guardarla en formato TIFF 

Las hiperpilas son imágenes multidimensionales, extendiendo las pilas de imágenes a cuatro (4D) o 
cinco (5D) dimensiones: 𝑥 (anchura), 𝑦 (altura), 𝑧 (diapositivas), 𝑐 (canales o longitudes de onda) y 𝑡 
(marcos de tiempo). Las hiperpilas se muestran en una ventana con tres barras de deslizamiento 
etiquetadas. De la misma forma que las barras de deslizamiento en las pilas, el deslizador en el marco 
temporal posee un icono de play/pause. 

Selección de un área de interés 

La mayoría de los comandos en el ImageJ funcionará sobre una región de la imagen que es preciso 
seleccionar o separar de alguna manera. Por ejemplo, para seleccionar toda la imagen se puede ir al 
menú Edit-->Selection-->Select All. 

También se puede definir un área específica de interés dentro de la imagen, usando cualquiera de las 
herramientas de selección en la barra de trabajo: rectangular, oval, poligonal y mano alzada (los 
primeros cuatro íconos de la barra de trabajo, en orden). 

 
Herramientas para seleccionar un área de interés. 

Rectángulo: cuando se usa la herramienta de selección rectangular se puede modificar el 
tamaño de la selección arrastrando las esquinas de la selección. Si se mantiene apretada la 
tecla Shift al hacer la selección se fuerza a que la selección sea cuadrada. 

Oval: De manera similar a la herramienta de selección rectangular, la herramienta de 
selección oval, al mantener apretada la tecla Shift, fuerza a que la selección sea circular. 

Utilizando las flechas del teclado se puede mover la selección, y si lo hacemos manteniendo la tecla 
Alt presionada se puede agrandar la selección de a un pixel. 

Cuando se crea o modifica el tamaño de una selección su posición, ancho y altura se pueden observar 
en la barra de trabajo del ImageJ. A continuación, se observa una figura donde se selecciona un área 
circular de la imagen de prueba (centro del tubo). 
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Selección de un área circular en una imagen. 

Al aplicar entonces una función de análisis (como haremos a continuación) la misma se lleva a cabo 
sólo sobre el área seleccionada. 

Análisis de los canales de color de una imagen mediante histogramas 

Una imagen digital está compuesta por pixels. Cada pixel es un punto con un valor de intensidad para 
cada canal (colores “primarios”). Al combinar los distintos canales obtenemos el color deseado. En 
nuestro caso vamos a analizar el aporte de cada canal a la imagen, estudiando los canales 
denominados RGB: rojo (red), verde (green) y azul (blue). 

La dentro cada canal un pixel toma un valor entero entre 0 y 255 (si los pixels son de 8 

bits) para asignarle un color, generando una escala entre estos valores para cada canal. Así las zonas 
oscuras de una imagen estarán representadas por píxeles con valores cercanos a 0 mientras que las 
zonas más claras con píxeles cercanos a 255. 

De esta manera, al analizar los canales RGB de una selección de la imagen podemos cuantificar 
(contar) cuántos pixels con cada valor color (entre 0 y 255) hay para cada canal (RGB). Al graficar 
número de pixels en función del valor dentro de la escala obtenemos un histograma (un conteo de 
pixels para cada valor). 

El ImageJ realiza este análisis de manera directa. Para ello seleccionamos primero la región de 
interés, y luego hacemos click en el menú Analyze-->Histogram. Inmediatamente el programa abre 
una nueva ventana donde aparece un histograma “promedio” de todos los canales: 

 
Menú Analyze-->Histogram. 
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Ventana con los datos para los histogramas de cada canal. 

Al hacer click en el botón RGB vamos cambiando a los disintos canales, y sus respectivos histogramas. 

 

Histogramas para el promedio de todos los canales, y para cada canal. 

En esta ventana también aparecen los valores para distintos parámetros: 

Mode: es el valor que más veces aparece (se ve como el máximo del histograma). 

Mean: es el promedio de todos los valores (generalmente es cercano a la moda). 

Count: es el número de pixels analizados. 

StdDev: es la desviación estándar, que puede aproximarse como el error en la determinación 
de la media (por ejemplo, 92±12). 

Min y Max: los valores mínimo y máximo del histograma. 
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Al hacer click en el botón Copy se copia una tabla de valores que puede copiarse a una planilla de 
cálculo. En dicha tabla aparece el valor dentro de la escala del canal elegido, y el número de pixels 
con dicho valor. De esta manera podemos copiar todos los datos a una hoja de cálculo para su 
posterior análisis (incluso podemos graficar el histograma por nuestra cuenta). 

 
Hoja de cálculo con los datos copiados para uno de los histogramas. 

La columna A es el valor para el color, la columna B es el número de pixels para dicho valor. 

Para ello vamos a realizar el proceso completo para una imagen, para que luego repitan el ejercicio 
con las distintas imágenes. 

 

Funciones más utilizadas en el tratamiento digital de imágenes 

1 Mejora del brillo y contraste 

Esta herramienta se utiliza para alterar interactivamente el brillo y el contraste de la imagen activa. 
Con imágenes de 8 bits, el brillo y el contraste son cambiados mediante la actualización de la LUT de 
la imagen, por lo que el valor de los píxeles permanece inalterado. El brillo y contraste de imágenes 
RGB es cambiado mediante la modificación del valor de los píxeles. 

 

 
Ajuste del Brillo y Contraste 

Histogram
muestra cómo son 
mapeados los píxeles 
a valores de 8 bits

rango de visualización 

o ventana

Set: introducir los valores mínimo y

máximo del rango de visualización

Minimum and Maximum sliders

Controlan los valores límites mínimos
y máximos del rango de visualización

Brightness slider

Incrementa o 
decrementa el brillo de 
la imagen mediante el 
desplazamiento del 
rango de visualización

Contrast slider

Incrementa o decremento el contraste
mediante la variación de la anchura del
rango de visualización

Auto: optimizará automáticamente el

brillo y el contraste basándose en un
análisis del histograma de la imagen Reset: Reestablece las

configuraciones de brillo
y contraste original
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• “Histogram”: El gráfico de líneas en la parte superior de la ventana, el cual es superpuesto sobre 
el histograma de la imagen, muestra cómo son mapeados los píxeles a valores de 8 bits (0-255). 
Los dos números debajo de la gráfica son el valor mínimo y máximo de los píxeles mostrados. 
Esos dos valores definen el rango de visualización o ventana. ImageJ muestra imágenes mediante 
el mapeado lineal del valor de los píxeles en el rango de visualización al rango de valores 0-255. 
Los píxeles con un valor menor que el mínimo son mostrados como negro y aquellos con un valor 
mayor que el máximo son mostrados como blancos. 

• “Minimum and Maximum sliders”: Controlan los valores límites mínimos y máximos del rango de 
visualización. Al presionar “Shif’” se ajustarán simultáneamente todos los canales de una imagen 
compuesta. 

• “Brightness slider”: Incrementa o decrementa el brillo de la imagen mediante el desplazamiento 
del rango de visualización. Si se presiona “Shift” se ajustarán simultáneamente todos los canales 
de una imagen compuesta. 

• “Contrast slider”: Incrementa o decrementa el contraste mediante la variación de la anchura del 
rango de visualización. Cuanta menor anchura tenga, mayor será el contraste. Al presionar 
“Shift” se ajustarán simultáneamente todos los canales de una imagen compuesta. 

• “Auto”: ImageJ optimizará automáticamente el brillo y el contraste basándose en un análisis del 
histograma de la imagen. Si se crea una selección, la imagen entera será optimizada en base a un 
análisis de esa selección. La optimización se realiza permitiendo que un pequeño porcentaje de 
píxeles en la imagen sean saturados (mostrados como blanco o negro). Cada clic adicional en 
“Auto” incrementa el número de píxeles saturados y por lo tanto la cantidad de optimización. Una 
llamada a una macro run(“Enhance Contrast”, “saturated=0.35”) es generada si el comando de 
registro (Plugin>Macro >Record…) se está ejecutando. 

• “Reset”: Reestablece las configuraciones de brillo y contraste original. El rango de visualización 
se establece al rango de valores de píxeles completos de la imagen. Una llamada a la macro 
resetMinAndMax() es generada si el comando de registro se está ejecutando. Presionando 
“Shift” se reestablecen las configuraciones originales en todos los canales de una imagen 
compuesta. 

• “Set”: Permite introducir los valores mínimo y máximo del rango de visualización en un cuadro 
de diálogo. Una llamada a la macro setMinAndMax() es generada si el comando de registro se está 
ejecutando 

Una imagen de 16 bits consiste en 65536 valores de grises posibles. La mayoría de las veces, sin 
embargo, la información relevante de la imagen está contenida sólo dentro de un rango estrecho de 
la escala de grises.  

Este es el caso, p.e., en microscopía de luz reducida, en la que la señal está restringida en el extremo 
inferior de la escala de grises. El diálogo “Set Display Range” permite elegir cómo escalar el rango 
de los niveles de gris en imágenes de 16 bits. 

 
Configuración del rango de visualización 

• “Automatic”: Automáticamente se selecciona el mejor rango dados los valores de intensidad de 
la imagen basándose en el porcentaje del número total de valores píxeles desde el valor de píxel 
más bajo al más alto. 
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✓ “8-bit (0-255)”: Nivel de grises de 0-255. 
✓ “10-bit (0-1023)”: Nivel de grises de 0-1023. 
✓ “12-bit (0-4095)”: Nivel de grises de 0-4095. 
✓ “15-bit (0-32767)”: Nivel de grises de 0-32767. 
✓ “16-bit (0-65535)”: Nivel de grises de 0-65535. 

Seleccionar “Propagate to all open images” para aplicar estos valores al resto de las imágenes 
actualmente abiertas. Con imágenes multicanal, la opción para propagar el rango específico al resto 
de canales también está disponible. 

• “Apply”: Aplica la función de mapeo del rango de visualización actual a los datos de píxeles. Si hay 
una selección, solo los píxeles dentro de la selección serán modificados. Esta opción actualmente 
solo funciona con imágenes de 8 bits, pilas de 8 bits y pilas RGB. Esta es la única opción de B&C 
que altera los datos de los píxeles de imágenes no RGB. 

 

2 Anchura de ventana 

Este commando y Brightness/Contrast… (B&C) son redundantes, pero Window/Level… (W&L) se 
comporta de una manera más cercana al aplicado en terminales de imágenes médicas mediante el 
ajuste interactivo de “Window” -el rango del mínimo y el máximo (contraste)- y “Level” –la posición 
de ese rango en el espacio de la intensidad de escala de grises (brillo). 

Si la ventana B&C está abierta, se cerrará y en su lugar aparecerá la ventana W&L. 

 
Window/Level… 

Otra opción para mejorar una imagen es aplicar un filtro. Menú Process | Filters | 

median…funciona muy bien con valores de Radius entre 1 y 2. Process | Filters | Gaussian Blur… 
es otro de los filtros que permiten mejorar los contornos y es muy fácil de aplicar. Con la opción 
preview se puede probar diferentes Radius. 

Si necesitamos quitar ruido de fondo en una imagen una opción podría ser: obtener un valor medio 
del ruido de fondo (por ejemplo, herramienta de selección rectangular, dibujar un rectangulo en la 
zona del fondo; ctrl + M, tomar el valor mean. Luego menú Process|Math|Substract… y restar dicho 
valor a la imagen. 
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También con la varita mágica se puede seleccionar el fondo y utilizar Edit/Fill para retirar el fondo 

 
 

3 Balance de color 

Para múltiples canales de pilas e hiperpilas (imágenes compuestas) ajusta cada canal de color 
independientemente. Usar el menú desplegable para especificar qué color/canal será ajustado (se 
representará el histograma para el canal seleccionado). 

Los deslizadores “Maximum” y “Minimum”, “Auto”, “Set” y “Apply” trabajan de la forma que se describe 
para Image>Adjust>Brightness/Contrast… De la misma manera que ocurre para la herramienta 
Window/Level…, si la ventana B&C está abierta, será cerrada y reemplazada por la ventana de “Color”. 

 
Balance de color 

4 Umbralización 

Esta herramienta es utilizada para configurar automática o interactivamente los valores bajos y altos 
del umbral, segmentando las imágenes en escala de grises en características de interés y el fondo. 
Usar Analyze>Measure… (con “Limit to Threshold” en Analyze>Set Measurements… seleccionado) 
para medir el conjunto de las características seleccionadas. Ir a Analyze>Analyze Particles… para 
medir las características individualmente. Utilizar la herramienta “Wand Tool” para seleccionar una 
única característica. 
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Umbralización 

• “Upper slider”: Ajusta el mínimo valor del umbral. Mantener pulsado “Shift” mientras se ajusta 
el mínimo para mover una ventana de umbralización de ancho fijo a lo largo del rango de los 
niveles de grises. 

• “Lower slider”: Ajusta el máximo valor de umbralización. 
• “Method”: Permite seleccionar cualquiera de los 16 métodos diferentes de umbralización 

automática. El método “Default” es el algoritmo modificado IsoData usado en las versiones de 
ImageJ 1.41 y anteriores. Hay que hacer notar que estos son métodos globales de umbralización 
que típicamente no pueden trabajar con imágenes iluminadas de forma desigual. En estos casos 
los algoritmos locales son más apropiados, permitiendo el umbral para variar suavemente la 
imagen. Estos son implementados en el plugin “Auto Local Threshold”, preinstalado en Fiji. 

• “Display”: Permite seleccionar uno de los tres modos de visualización: 
– Red: Muestra los valores umbralizados en rojo. 
– B&W: Las características se muestran en negro con el fondo en blanco. Este modo tiene en 

cuenta la casilla “Black background” seleccionada en Process>Binary>Options… 
– Over/Under: Muestra los valores que quedan por debajo del umbral en azul, los píxeles 

umbralizados en escala de grises, y los que quedan por encima del umbral en verde. Estos 
colores pueden ser cambiados a partir de una macro mediante la llamada a los métodos 
ImageProcessor.set.setOverColor() y setUnderColor(). 

• “Dark background”: Se selecciona cuando las características que se quieren resaltar son más 
brillantes que el fondo. El estado de esta casilla no cambia después del reinicio. 

• “Stack histogram”: Si está seleccionado, ImageJ primero calculará el histograma de una pila 
entera (o hiperpila) y después computará el umbral basado en ese histograma. Debido a ello, 
todas las diapositivas son binarizadas utilizando un único valor calculado. Si no está seleccionada, 
el umbral para cada diapositiva es calculado de forma individual 

• “Auto”: Utiliza el método de umbralización actualmente seleccionado para, automáticamente, 
configurar los valores del umbral basado en un análisis del histograma de la imagen o selección 
actual. 

• “Apply”: Configura los píxeles umbralizados a negro y el resto de píxeles a blanco. Para imágenes 
flotantes de 32 bits “Apply” ejecutará también Process>Math>NaN Background. 

• “Reset”: Desactiva la umbralización y actualiza el histograma a su estado original. 
• “Set”: Los nuevos valores del umbral pueden introducirse en este cuadro de diálogo. 
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Otra posibilidad sería la de utilizar el histograma de la imagen para establecer el umbral de tal 
forma que este se establezca en función del análisis de la forma de este. Por ejemplo, en ImageJ/Fiji 
la opción default establece automáticamente el umbral al valor de intensidad en que se encuentra el 
mínimo entre dos máximos relativos del histograma. Otros algoritmos incluidos en la herramienta 
del umbral permiten establecer el umbral en base a otros criterios. 
Image > Adjust > Auto_Threshold…Try All para probar simultáneamente y comparar entre si 
todos los algoritmos disponibles. 

 
Image > Adjust > Threshold… y establecer el umbral manualmente o automaticamente 
mediante el algoritmos seleccionado. 
Edit > Selection > Create Selection. Crea una ROI que incluye únicamente los píxeles con 
un valor de intensidad igual o mayor que el umbral. 
Edit > Selection > Add to Manager. Añade la ROI seleccionada al ROI Manager. 
Alternativamente, una vez establecido el umbral también podemos seleccionar ROI 
mediante la herramienta de encontrar partículas. Analyze > Analyze Particles… Size & 
Circularity, Add to Manager.  

Esta herramienta nos permite seleccionar individualmente objetos con un área que nosotros 
vamos a especificar (en micras si la imagen esta calibrada y en píxeles si no lo está) y con un 
cierto grado de circularidad (entre 1 que sería un circulo prefecto y 0). 
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5 Umbralización de color 

Umbraliza imágenes RGB de 24 bits basadas en componentes HSB, RGB, CIE Lab o YUV. Los rangos 
de los filtros pueden ser configurados manualmente o basándolos en el valor de los píxeles de las 
componentes de una ROI definida por el usuario. Este comando, implementado en la versión 1.43l, 
es una versión experimental que se incluye del plugin “Threshold Color” y no está aún integrada 
completamente en ImageJ. 

• “Pass”: Si está seleccionado, los valores dentro del rango son umbralizados y mostrados (filtro 
pasobanda), en caso contrario, los valores fuera del rango seleccionado son umbralizados (filtro 
rechazobanda). 

• “Thresholding Method”: Permite seleccionar cualquiera de los 16 métodos automáticos de 
umbralización. 

• “Threshold Color”: Selecciona el umbral de color: ya sea Red, Black, White o Black & White. 
• “Color Space”: Selecciona el espacio de color: HSB, RGB, CIE Lab o YUV. 
• “Dark background”: Debe ser seleccionado cuando las características de la imagen son más 

brillantes que el fondo. El estado de esta casilla no cambia después del reinicio. 
• “Original”: Restaura la imagen origina y actualiza el buffer cuando se cambie a otra imagen. 
• “Filtered”: Muestra la imagen filtrada. Hay que hacer notar que el tipo de la imagen final 

umbralizada es RGB, no de 8 bits en escala de grises. 
• “Select”: Crea una selección ROI basándose en la configuración actual. La selección se realiza de 

acuerdo a las opciones definidas en el diálogo Process>Binary>Options… 
• “Sample”: (Experimental) Configura el rango de los filtros basándose en los valores de los píxeles 

de las componentes de una ROI definida por el usuario. 
• “Stack”: Procesa las diapositivas restantes de la pila (si las hubiese) utilizando la configuración 

actual. 
• “Macro”: Crea una macro basada en la configuración actual la cual es mandada a la ventana 

“Macro Recorder” (Plugins>Macros>Record…) si está abierta. 
• “Help”: Abre un cuadro de diálogo de ayuda. 

 
Umbralización de color 
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6 Transformada rápida de Fourier (FFT) 

Calcula la transformada de Fourier y muestra el espectro de potencia. Las coordenadas polares de 
los puntos medidos pueden guardarse mediante Analyze>Measure… 

Si el cursor se sitúa sobre una ventana activa del dominio de frecuencia (FFT), su localización es 
mostrada en coordenadas polares. El ángulo es expresado en grados, mientras que el radio es 
expresado en píxeles por ciclo (p/c). El radio se expresa en unidades por ciclo (p.e. mm/c) si la escala 
espacial de la imagen fue definida usando Image>Properties… o Analyze>Set Scale 

 

 
 

7 Transformada inversa de Fourier 

Calcula la transformada inversa de Fourier. Se pueden filtrar o enmascarar puntos en la imagen 
transformada (dominio de la frecuencia) y hacer la transformada inversa para producir una imagen 
que solo contenga las frecuencias seleccionadas o que suprima dichas frecuencias. Utilizar las 
herramientas de selección y los comandos fill/clear de ImageJ para dibujar áreas negras o blancas 
que enmascaren porciones de la imagen transformada. Las áreas negras (valor del píxel = 0) hacen 
que las frecuencias correspondientes sean filtradas (eliminadas) y las áreas blancas (valor del píxel 
= 255) provocan que las correspondientes frecuencias pasen (no sean eliminadas). No es posible, sin 
embargo, aplicar ambos filtrados durante la misma transformada inversa. 

Notar que las áreas a ser filtradas en el dominio frecuencial de la imagen deben ser rellenadas con 
ceros y las áreas que pasen deben estar rellenadas con 255. Esto puede verificarse moviendo el 
cursor sobre un área rellenada y observando que los valores mostrados en la barra de estado son o 
bien 0 o 255.  
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En consecuencia, se debería siempre confirmar que las áreas enmascaras no contienen algún otro 
valor gris, usando la opción “reset blank & White” en la ventana “Color Picker” cuando se defina 
el primer plano (foreground) (Edit>Fill) y el fondo (background) (Edit>Clear). 

 
Ejemplo de un filtrado de bajas frecuencias 

Con selecciones alejadas del centro, la misma frecuencia espacial aparece dos veces en el espectro de 
potencia, en puntos opuestos del centro. Esto es suficiente para rellenar/limpiar (fill/clear) solo 
uno de ellas. 

Recalcula el espectro de potencia a partir del dominio frecuencial de la imagen (32-bit FHT). Este 
comando permite empezar de nuevo después de haber perdido la imagen de 8 bits del espectro de 
potencia debido a una edición equivocada. 

Opciones FFT. Muestra un cuadro de diálogo. El primer grupo de casillas seleccionables especifican 
qué imágenes son creadas por el comando FFT: 

 
Opciones FFT 

• “Display FFT Window”: Es la salida estándar. Consiste en una imagen de 8 bits del espectro de 
potencia y los datos actuales, los cuales permanecen invisibles para el usuario. La imagen del 
espectro de potencia es mostrada en una escala logarítmica, mejorando la visibilidad de los 
componentes que son débilmente visibles. Los datos actuales son usados por el comando 
“Inverse FFT”. 

• “Display Raw Power Spectrum”: Muestra el espectro de potencia sin la escala logarítmica. 
• “Display Fast Hartley Transform”: Utiliza el formato interno empleado por el comando, el cual 

está basado en una transformada de Hartley en lugar de una transformada de Fourier. 
• “Display Complex Fourier Transform”: Una pila con dos imágenes para las partes real e 

imaginaria de la FFT. 
• “Do Forward Transform”: Si está seleccionado, la imagen actual es transformada inmediatamente 

cuando se cierra el cuadro de diálogo “FFT Options dialog”. 

 

Filtro Paso-Banda. Elimina las altas frecuencias espaciales (difuminando la imagen) y las bajas 
frecuencias espaciales (similar a eliminar la imagen difuminada). También puede suprimir rayas 
horizontales o verticales que fuesen creadas mediante el escaneo de la imagen línea a línea. El Filtro 
Paso-Banda utiliza un algoritmo especial para reducir artefactos en los bordes (antes de la 
transformada de Fourier, la imagen se extiende en tamaño adjuntando copias espejo de partes de la 
imagen fuera de la imagen original, por lo que no se producen saltos en los bordes). 
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Filtro Paso-Banda 

• “Filter Large Structures Down to”: Las variaciones suaves de la imagen con tamaños típicos de 
manchas brillantes u oscuras mayores que el valor seleccionado son suprimidas. 

• “Filter Large Structures Up to”: Determina la cantidad de suavizado. Los objetos en la imagen 
menores que este tamaño son fuertemente atenuados. Hay que hacer notar que esos valores son 
ambos la mitad de las frecuencias espaciales del límite actual. El límite es muy suave, por lo que 
el filtro paso-banda atenuará notablemente incluso las frecuencias espaciales en el centro del 
paso-banda a menos que la diferencia entre los dos valores sea grande (es decir, más de un factor 
de 5 aproximadamente). 

• “Suppress Stripes”: Seleccionar para eliminar rayas horizontales o verticales. La eliminación de 
rayas horizontales es similar a restar una imagen que haya sido suavizada únicamente en la 
dirección horizontal de la imagen original. 

• “Tolerance of Direction”: Esto es para “Suppress Stripes”; valores más altos eliminan rayas más 
cortas y/o rayas que se ejecuten por debajo de un ángulo con respecto a la dirección horizontal 
(vertical). 

• “Autoscale After Filtering”: Si está seleccionado, pone las intensidades más bajas a 0 y las más 
altas a 255, preservando todas las intensidades. 

• “Saturate Image when Autoscaling”: Si está seleccionado, permite saturar algunas intensidades, 
y proporciona un mejor contraste visual. “Saturate Image when Autoscaling” solo tiene efecto 
cuando la opción “Autoscale After Filtering” está activada. 

• “Display Filter”: Si se selecciona muestra el filtro generado 

 

Los filtros Prewitt y Sobel sirven para determinar cambios de intensidad a lo largo la dirección 
definida por el filtro. Hay que mencionar que en los bordes de los objetos se produce un cambio más 
o menos brusco de la intensidad de la imagen por lo que estos filtros se utilizan para la detección de 
bordes. Matemáticamente, la cantidad de una variable (intensidad) con respecto a otra (dirección) 
es lo que se denomina derivada por lo que se puede decir que con estos filtros estamos calculando la 
derivada de la imagen con respecto a la dirección indicada por el filtro. 

Para nuestra comodidad ambas operaciones ya vienen implementadas en Fiji.  

Process > Find Edges (utiliza los filtros de Sobel)  

Process > Filters > Differentials > Gradient Magnitude  

Process > Filters > Differentials > Gradient Direction  

El comando Process > Shadows utiliza versiones del filtro de Sobel en las que el valor central es uno 
para crear sombras sobre la imagen. 

Si con los filtros de Sobel o Prewitt se calcula la primera derivada de la imagen con el filtro de 
Laplace se calcula la segunda derivada de la imagen. Esta se utiliza para mejorar el contraste de las 
imágenes ya que toma valores positivos a uno de los lados de los bordes de los objetos y positivos al 
otro lado del mismo borde. La mejora de contraste o sharpening se consigue restando a la imagen 
original un porcentaje de la obtenida mediante la aplicación de este filtro. La fuerza o intensidad de 
la mejora del contraste depende del porcentaje que se reste. 

En Fiji: Process > Differential > Laplace  
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También existe otra técnica para mejorar el contraste denominada USM o Unsharp Mask y que 
también viene implementada en imageJ. Consiste restar a la imagen original una versión suavizada 
con un filtro gaussiano para obtener lo que se denomina máscara. Luego en un segundo paso se añade 
un porcentaje de esta máscara a la imagen original para obtener la imagen con el contraste mejorado. 

Process > Filters > Unsharp Mask… hay que especificar el valor σ (sigma) de la gaussiana y el 
porcentaje. 

Process > Sharpen. Emplea un filtro de 3x3 píxeles con valor central de 12 y -1 en el resto 

 
Figura Mejora de contraste utilizando el filtro de Unsharp Mask 

Tanto los filtros basados en primeras como en segundas derivadas son muy sensibles al ruido en la 
imagen y el resultado que se obtiene con ellos en general mejora bastante si las imágenes son 
previamente suavizadas por otro filtro como por ejemplo un gaussiano. 

Interesantemente como ambos filtros son lineales y tienen la propiedad de asociatividad y 
separatibilidad el resultado de utilizar un filtro gaussiano seguido de uno de Laplace es el mismo que 
el de realizar un filtrado combinado que resulta de la convolución de Laplace con el gaussiano. Este 
nuevo filtro es conocido como Mexican Hat y es muy eficaz no solamente en la detección de bordes 
sino también a la hora de destacar estructuras puntuales.  

Este tipo de filtro, aunque no se encuentra por defecto en Fiji, viene implementado en uno de los 
pluging de Fiji: 3D Fast Filters6 

La alternativa a la segmentación mediante un umbral es la segmentación mediante máscaras ( 
contornos activos o snakes), que como acabamos de mencionar pueden ser creadas mediante un 
umbral, pero también manualmente. 

Contornos activos o SNAKES, son curvas paramétricas que tienen unos puntos de control que se 
pueden mover para ajustarse a la forma del órgano o tejido. Los movimientos de dichos puntos son 
dirigidos normalmente por condiciones de máximo gradiente y restricciones de continuidad y 
curvatura (Xu & Prince, 20007). Suelen emplearse para la segmentación de estructuras concretas 
(ventrículos, lesiones, etc.) y la posición inicial de los puntos de control suele ser manual (fig ). 

 
6 http://imagejdocu.tudor.lu/doku.php?id=plugin:filter:3d_filters_with_jni:start 
7 Xu C., Prince J. L. 2000. Gradient Vector Flow Deformable Models. Handbook of Medical Imaging, 

Academic Press 
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Ejemplo de segmentación mediante snakes. A la izquierda se muestra la curva inicial y a la derecha 
el resultado final en una delimitación  

El crecimiento de regiones (Region Growing) es una técnica muy sencilla que suele utilizarse, al 
igual que la umbralización, como apoyo en la segmentación manual de imágenes.  

Esta técnica consiste en la selección de un punto semilla en la imagen alrededor del cual se van 
añadiendo nuevos píxeles que cumplen un determinado predicado tal como estar en contacto 
geométrico con otros píxeles clasificados como de interés y tener una intensidad dentro de un rango 
determinado (Adams y Bischof, 19948).  

Suele emplearse para la selección de regiones homogéneas en las imágenes, tales como placas de 
esclerosis múltiple o tumores de bajo grado. 

 
Ejemplo de crecimiento de regiones. A la izquierda se puede ver la semilla inicial y a la derecha el 
resultado del crecimiento de la región entorno a dicha semilla en un caso en el que se delimita el área 
quística central de una lesión cerebral. 

Este tipo de segmentación es por lo tanto un poco más laboriosa ya que como mínimo requiere de 
dos pasos (establecer el umbral y crear la imagen binaria que utilizaremos para delimitar las regiones 
de interés), pero es más precisa ya nos permite realizar operaciones lógicas (sumar, restar, 
diferencia, rellenar huecos, watershed) con las imágenes binarias y por lo tanto nos da un nivel de 
control adicional.  

Finalmente cuando conseguimos obtener una máscara que delimita fielmente a los objetos de interés 
tenemos que establecer un umbral sobre ella para seleccionar la región de interés. En ImageJ/Fiji las 
imágenes binarias tienen un valor de 0 (fondo) o 255 (objeto).  

Para una imagen binaria o máscara: Process > Binary > Make Binary ó Process > Binary > 
Convert to Mask. Alternativamente también es posible crear máscaras con un umbral. Image > 

Adjust > Threshold… Apply.  

 
8 Adams R.y Bischof L.1994. Seeded region growing. IEEE Trans. on PAMI, 6(6): 641-647 
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Una vez creadas las máscaras se pueden editar mediante las herramientas de dibujo si se selecciona 
el mismo color que el de la máscara (blanco o negro) y también se pueden combinar entre sí con la 
calculadora de imágenes. Process > Image Calculator… Add, Substract, Difference. Finalmente 
se establece un umbral a la máscara entre 1 y 255 (el fondo tendría valor 0) y se crea una selección 
que se añade al ROI Manager. 

Una estrategia alternativa a los umbrales o las máscaras es la segmentación mediante semillas . 
conviene saber que esta estrategia de segmentación se basa en a partir de uno o más píxeles 
(semillas) seleccionados dentro del objeto a segmentar se van incorporando paulatinamente píxeles 
vecinos en función de unos criterios de similitud (si la diferencia con el píxel vecino es menor que un 
valor de tolerancia). Un ejemplo de segmentación de este tipo seria la herramienta de selección de la 
barita mágica (doble clic sobre la barita para ajustar el nivel de tolerancia). En Imagej/Fiji existen 
herramientas más avanzadas para realizar este tipo de segmentación a partir de múltiples semillas. 

En las web de los desarrolladores de los pluging se pueden encontrar instrucciones detalladas de 
cómo utilizarlos. 

Plugings > Segmentación > Levels Set 

Plugings > Segmentacion > Simple Neurite Tracker 

 

Plugins interesantes estudiados 

Un plugin es código escrito en Java que sirve para ampliar la lista de funcionalidades nativas de la 
aplicación. Al ser clases de Java podemos usar todas las características del lenguaje, acceder a la API 
de ImageJ y a otras API estándar y externas a ImageJ. Esto nos abre un campo amplio de posibilidades 
a realizar. 

El uso más común para los plugins es el de crear filtros para el análisis o procesamiento de imágenes 
o stacks/pilas. También para leer y escribir sobre formatos no soportados por la aplicación. 

Existen dos diferentes tipos de plugins: 

• PlugInFilter: requiere una imagen abierta y activa, el plugin se ejecutar sobre dicha imagen. 
• PlugIn: no requiere de una imagen abierta para iniciar el plugin. 

Para empezar a desarrollar un plugin de este tipo sólo se necesita indicar que la clase de Java 
implementa la interfaz PlugIn y se debe añadir un método denominado run. 

 
Este método ejecuta el plugin, así que lo que se implemente aquí es lo que el pluing hace. 

La variable del parámetro “arg” es un String que se le pasa al método como argumento de 
entrada al plugin, y puede estar vacío. 

Si fuese necesario, se pueden añadir más métodos a la clase, aparte de este método “run”, y 
conseguir así extender las tareas que podemos realizar con un mismo plugin. 

Se pasarán a describir algunos de los plugins realizados por terceros que fueron estudiados para la 
realización de este Proyecto a la hora de barajar posibilidades en los pasos del algoritmo. Finalmente, 
aunque no se implementaron todos ellos en el mismo, son lo suficientemente interesantes como para 
dedicarles un apartado. 
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1 MorphoLibJ 

MorphoLibJ es una colección de plugins y métodos de morfología matemática para ImageJ, creados 
en el INRA-IJPB Modeling and Digital Imaging Lab. [12] 

La librería implementa varias funciones que se encontraban ausentes en ImageJ y que no habían sido 
cubiertos, o sólo parcialmente, por otros plugins.  

• Filtros morfológicos para 2D/3D e imágenes binarias o en escala de grises: erosión & dilatación, 
apertura & cierre, gradiente morfológico & Laplaciano, top-hat… 

• Reconstrucción morfológica para imágenes 2D/3D y binarias o en escala de grises, permitiendo 
la detección rápida de regiones o extremos ampliada, la eliminación de bordes, el relleno de 
bordes, filtrado de atributos… 

• Segmentación Watershed + GUI (Graphical User Interface), haciendo posible segmentar 
imágenes 2D/3D de, por ejemplo, tejidos celulares. 

• Medidas 2D/3D: Medidas fotométricas (intensidad) y morfométricas tales como el volumen, área 
de superficie, elipse/elipsoide de inercia… 

• Utilidades para imágenes binarias para eliminar o mantener el mayor componente conectado, 
realizar la apertura de tamaño, rellenado de huecos, eliminación de bordes… 

A continuación, se irán describiendo las funciones que han sido estudiadas de este plugin. 
Los filtros morfológicos son filtros muy comunes que, combinados entre ellos, pueden aportar una 
gran variedad de soluciones. Son filtros locales, en el sentido de que consideran la vecindad para cada 
píxel/voxel.  

Los filtros morfológicos son definidos de acuerdo al elemento de estructura de un tamaño y forma 
dada. En los elementos de estructura comunes se incluyen cuadrados, discos discretos y octógonos. 
Elementos de estructura lineales con varias orientaciones pueden ser usados para evaluar la 
orientación local de las estructuras. 

• Erosión y Dilatación: Los filtros morfológicos más básicos son la dilatación morfológica y la 
erosión morfológica. La dilatación morfológica calcula para cada píxel el máximo dentro de su 
vecindad (definido por el elemento de estructura), mientras que la erosión morfológica considera 
el valor mínimo dentro de la vecindad. La aplicación de una dilatación o una erosión cambia el 
tamaño de las estructuras en la imagen: los granos en el resultado de la imagen dilatada son 
mayores. La erosión morfológica puede también ser usada en imágenes binarias para ayudar a 
separar partículas pegadas. La erosión y dilatación morfológica pueden ser también aplicadas a 
imágenes en escala de grises. En ese caso, la dilatación morfológica calcula para cada píxel el 
máximo dentro de su vecindad (definida por el elemento de estructura), mientras que la erosión 
morfológica considera el mínimo dentro de la vecindad 

• Apertura y Cierre: La dilatación y erosión morfológicas son a menudo usadas en combinación. 
Por ejemplo, el resultado de una dilatación seguida de una erosión es denominada como un cierre 
morfológico, y elimina estructuras oscuras menores que el elemento de estructura. También 
puede conectar estructuras brillantes que estuviesen separadas por un espacio delgado negro. 
De manera simétrica, el resultado de una erosión seguida de una dilatación se denomina apertura 
morfológica, y elimina las estructuras brillantes menores que el elemento de estructura. Hay que 
tener en cuenta que, aunque la apertura y cierre preservan mejor el tamaño de estructura en la 
imagen original, la forma es ligeramente modificada. Por ejemplo, el resultado de un cerrado 
morfológico en la imagen superior crea conexiones artificiales entre granos. Elegir el mejor 
tamaño para el elemento de estructura es a menudo un compromiso entre la eliminación de ruido 
y la conservación de la forma de la estructura. 

• Gradientes morfológicos: Pueden ser usadas combinaciones más complicadas de las operaciones 
elementales. El gradiente morfológico, calculado como la diferencia del resultado de una 
dilatación morfológica con el resultado de una erosión morfológica, revela los bordes de las 
estructuras dentro de la imagen. El Laplaciano morfológico es definido como la mitad de una 
suma de una dilatación morfológica y una erosión morfológica con el mismo elemento de 
estructura, menos la imagen original. Esto resulta en una mejora de los bordes de la imagen. 

• “Top-Hat”: El Top-hat blanco primero calcula una apertura morfológica (consistente en la 
eliminación de estructuras brillantes menores que los elementos de estructura), y elimina el 
resultado de la imagen original. Cuando es aplicado con un elemento de estructura grande, el 



Informe de Avance y/o Final 2020 Anexo 01 CCUTIME0005279TC 

 

CESARI Matilde Inés 26 
 
 

resultado es una homogenización del fondo, haciendo las estructuras brillantes más fáciles de 
segmentar. De la misma forma, el Top-hat oscuro puede ser usado para mejorar estructuras 
oscuras observadas sobre un fondo no homogéneo 

• Filtros direccionales: Para imágenes que contengan estructuras curvilíneas muy delgadas (por 
ejemplo vasos sanguíneos o secciones de pared celular), la aplicación de los filtros comunes 
puede ser complicada debido al reducido tamaño de las estructuras. Incluso para elementos de 
estructura pequeños, la aplicación de una apertura o cerrado morfológico provocan la 
desaparición de la estructura. Por otra parte, puede ser difícil preservar el espesor total de la 
estructura. Una alternativa puede ser aplicar un filtrado direccional. El principio se basa en 
considerar un elemento de estructura orientado tal como un segmento de línea de una longitud 
dada, y realizar operaciones morfológicas para varias orientaciones del elemento de estructura. 
Por ejemplo, aplicar un filtro de mediana o una apertura morfológica con orientación horizontal 
resulta en la mejora de las partes horizontales de las estructuras brillantes. De forma similar, usar 
un elemento de estructura vertical produciría como resultado la mejora de las porciones 
verticales de las estructuras. 

Los resultados de los filtrados orientados para cada dirección pueden ser combinados calculando 
el valor máximo sobre todas las orientaciones. La figura anterior muestra el resultado obtenido 
cuando se combinan dos o cuatro direcciones. En este ejemplo, se utilizaron 32 orientaciones de 
línea con una longitud de 25. Esto da como resultado la mejora de la imagen conservando el 
espesor de las estructuras brillantes. 

Resultados similares pueden ser obtenidos para la mejora de estructuras curvilíneas oscuras, 
mediante el cerrado morfológico o filtrado de media, y combinando los resultados calculando el 
mínimo sobre todas las direcciones. 

La colección de filtros morfológicos está disponible en el menú Plugins>MorphoLibJ. Los filtros son 
aplicables tanto para imágenes 2D como 3D, y funcionan para imágenes binarias, imágenes en escala 
de grises o imágenes en color (RGB). 

Los filtros morfológicos para imágenes planares se encuentran en 

 Plugins>MorphoLibJ>Morphological filters.  

El cuadro de diálogo permite al usuario elegir la forma del elemento de estructura, su radio, y 
finalmente una vista previa del resultado. A continuación se muestra una lista de las operaciones que 
pueden ser elegidas: 

• La erosión mantiene el mínimo valor dentro de la vecindad definida por el elemento de 
estructura. 

• La dilatación mantiene el máximo valor dentro de la vecindad definida por el elemento de 
estructura. 

• El cierre consiste en una dilatación seguida por una erosión. Un cierre morfológico consigue que 
las estructuras oscuras más pequeñas que el elemento de estructura desaparezcan. 

• La apertura consiste en una erosión seguida de una dilatación. Una apertura morfológica consigue 
que las estructuras brillantes más pequeñas que el elemento de estructura desaparezcan. 

• El gradiente morfológico es definido como la diferencia de una dilatación morfológica y una 
erosión morfológica con el mismo elemento de estructura y mejora los bordes de la imagen 
original. 

• El laplaciano morfológico es definido como la mitad de la suma de una dilatación morfológica y 
una erosión morfológica con el mismo elemento de estructura, menos la imagen original, y 
mejora los bordes de la imagen. 

• El Top-hat negro consiste en la sustracción de la imagen original del resultado de un cierre 
morfológico y da como resultado la mejora de estructuras oscuras menores que el elemento de 
estructura. 

• El Top-hat blanco consiste en la sustracción de la imagen original del resultado de una apertura 
morfológica y da como resultado la mejora de estructuras brillantes menores que el elemento de 
estructura. 
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Los siguientes elementos de estructura pueden ser usados para imágenes 2D: 

o Disco. 
o Cuadrado. 
o Octágono 
o Diamante. 
o Línea con un ángulo de 0, 45, 90 o 135 grados. 

Los filtros morfológicos para imágenes 3D se encuentran disponibles en 

Plugins>MorphoLibJ>Mofphological filters (3D). El cuadro de diálogo permite al usuario elegir la 
forma y el radio del elemento de estructura. Se pueden emplear la misma lista de operaciones que 
para las imágenes planares. Los elementos de estructura planares pueden ser utilizados (la operación 
simplemente es repetida sobre cada diapositiva), así como elementos de estructura cúbicos o 
esféricos. Para la mayoría de los elementos de estructuras el tamaño puede ser elegido para cada 
dirección. 

Reconstrucción morfológica 

Los filtros morfológicos clásicos presentados en la sección previa transforman una imagen de 
entrada mediante el uso de valores de píxeles o vóxeles en una vecindad cerrada, definida por el 
elemento de estructura. Tales filtros pueden ser vistos como “locales”, ya que el resultado en una 
posición dada no depende de los valores de la imagen localizados a una suficiente distancia. 

Los operadores de componentes conectados son más generales, ya que propagan información dentro 
de la imagen basándose en la conexión entre píxeles o vóxeles. Más detalles pueden encontrarse en 
la revisión de Breen et al. (1996).  

Los operadores de componentes conectados abarcan operadores potentes, tales como la 
reconstrucción morfológica que permite reconstruir una imagen marcadora mediante la limitación 
de ésta a una máscara. Una extensión de la reconstrucción morfológica es la detección de los máximos 
y los mínimos extendida, que puede ser útil como detector de marcadores para segmentación. 
Finalmente, los algoritmos de filtrado y atributos de apertura pueden filtrar imágenes basándose en 
el tamaño o en el rango de características, con una mejor preservación de bordes que el filtrado 
clásico. 

La reconstrucción morfológica es la base de muchos algoritmos útiles, tales como el de la eliminación 
de bordes, rellenado de huecos, o detección de regiones máximas o mínimas en imágenes de escala 
de grises. 

El principio de la reconstrucción geodésica es repetir dilataciones o erosiones condicionales hasta la 
condición idempotencia. Las dilataciones condicionales son el resultado de una dilatación, 
combinado con una imagen máscara usando una operación lógica. Las dilataciones condicionales son 
repetidas hasta que no se produzca ninguna modificación más (condición idempotencia). 

La siguiente figura muestra varios pasos de una reconstrucción geodésica mediante dilatación sobre 
un par de imágenes binarias. La imagen máscara se muestra en gris, y la imagen marcadora es 
mostrada en negro en la primera imagen. Las imágenes reconstruidas en cada paso son mostradas 
en negro. Los marcadores se propagan dentro de la imagen hasta que rellenan la zona elegida 

• Aplicación a imágenes binarias: Al escoger la imagen marcador, varias operaciones pueden ser 
automatizadas. Por ejemplo, calcular la reconstrucción geodésica con una imagen de bordes, y 
combinándola con la imagen original eliminará partículas o regiones pegadas a los bordes. De 
forma similar, el cálculo de la reconstrucción geodésica mediante el uso de los bordes del 
complemento de la imagen hace posible rellenar agujeros que podrían aparecer en partículas. 

• Aplicación a imágenes en escala de grises: La reconstrucción geodésica puede ser aplicada a 
imágenes en escala de grises. Mediante la elección manual de marcadores binarios de tal forma 
que se superpongan a las estructuras específicas, y después de aplicar una reconstrucción 
geodésica mediante dilatación, es posible obtener una imagen en escala de grises que contenga 
solo las estructuras elegidas. La operación de eliminación de bordes puede también ser aplicada 
en imágenes en escala de grises, haciendo posible eliminar rápidamente estructuras que limiten 
con los bordes de la imagen. El algoritmo de reconstrucción geodésica es a menudo usado junto 
con otros operadores. En MorphoLibJ, éste es sin embargo proveído como plugin para permitir 
su inclusión en macros o plugins propios del usuario o diseñador: 
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• Reconstrucción Geodésica: calcula la reconstrucción geodésica mediante dilatación o erosión 
usando una imagen marcador y una máscara, y una conectividad específica. 

• Reconstrucción Geodésica Interactiva: calcula la reconstrucción geodésica mediante erosión o 
dilatación tomando la imagen actual 2D como máscara, creando la imagen marcador de ROIs 
definidas por el usuario (por ejemplo con la herramienta Point Selection) y utilizando una 
conectividad específica. El plugin permite previsualizar el resultado. 

• Reconstrucción Geodésica 3D: calcula la reconstrucción geodésica mediante dilatación o erosión 
en una imagen 3D. 

• Reconstrucción Geodésica Interactiva 3D: calcula la reconstrucción geodésica mediante erosión 
o dilatación utilizando la imagen 3D actual como máscara y creando una imagen marcador a 
partir de selecciones de puntos realizadas por el usuario.  

Las operaciones de eliminación de bordes y rellenado de huecos son también proveídas como 
plugins. Ambas funcionan para imágenes 2D y 3D de 8, 16 y 32 bits. 

• Eliminación de Bordes: Elimina las partículas pegadas a los bordes en una imagen binaria o en 
escala de grises. 

• Rellenado de Huecos: Elimina agujeros dentro de partículas en imágenes binarias, o elimina 
regiones oscuras rodeadas por crestas brillantes en imágenes en escala de grises. 

Regiones y extremos extendidos 

Las regiones mínimas son definidas como regiones conectadas de elementos (píxeles o vóxeles) con 
el mismo valor, y cuyos elementos de vecindad tienen todos valores mayores que aquellos de la 
región. Similarmente, las regiones máximas son regiones de píxeles o vóxeles conectados con el 
mismo valor, cuya vecindad tiene todos los valores menores. 

Un problema derivado con regiones mínimas o máximas es que son muy sensibles al ruido. A menudo 
es más conveniente usar los llamados “extremos extendidos”. El principio es definir un valor de 
tolerancia para filtrar los extremos. Por ejemplo, los máximos extendidos son definidos como una 
región conectada conteniendo elementos tales que la diferencia de cada elemento dentro de la región 
con el máximo valor dentro de la región es menor que la tolerancia, y tales que las vecindades de las 
regiones tengan todas valores menores que los máximos dentro de la región menos la tolerancia. Esta 
definición permite la identificación de los extremos grandes, que mejor tienen en cuenta el ruido de 
la imagen. Los mínimos extendidos son definidos de una forma similar, y son eficientemente usados 
como un paso de preprocesamiento para la segmentación watershed. 

Ambos mínimos y máximos extendidos son calculados usando el algoritmo de reconstrucción 
geodésica. Se pueden encontrar más detalles en el libro de Soille (2003) 

Las siguientes operaciones están disponibles en el menú Plugins>MorphoLibJ: 

• Regional Min/Max: calcula la región mínima o extremos en escala de grises o imágenes binarias, 
con una conectividad especificada. 

• Regional Min/Max 3D: calcula la región mínima o extremos en escala de grises 3D o imágenes 
binarias, con una conectividad especificada. 

• Extended Min/Max: calcula la extensión de mínimos o extremos en imágenes en escala de grises, 
con una conectividad especificada. 

• Extended Min/Max 3D: calcula la extensión de mínimos o extremos en imágenes 3D en escala de 
grises o imágenes binarias, con una conectividad especificada. 

• Impose Min/Max: impone mínimos o máximos en una imagen en escala de grises. 
• Impose Min/Max 3D: impone mínimos o máximos en una imagen 3D en escala de grises 

Filtrado de atributos 

El filtrado de atributos aspira a la eliminación de componentes de una imagen basado en un 
determinado criterio de tamaño, en lugar de la intensidad. El criterio más común y útil es el número 
de píxeles/vóxeles (i.e., el área o volumen). Por ejemplo, una operación de apertura morfológica de 
tamaño con un valor umbral de 20 eliminará todas las manchas que contengan menos de 20 vóxeles. 
La longitud de la diagonal del cuadro delimitador también puede ser de interés para discriminar 
formas alargadas de formas redondeadas. 



Informe de Avance y/o Final 2020 Anexo 01 CCUTIME0005279TC 

 

CESARI Matilde Inés 29 
 
 

✓ Aplicación a imágenes binarias: Cuando se aplica a imágenes binarias, la apertura de atributos 
consiste en la identificación de cada componente conectada, calculando la medida del atributo de 
cada componente y conservando únicamente las componentes conectadas cuyas medidas estén 
por encima de un valor especificado. Este tipo de procesamiento es a menudo usado para limpiar 
resultados de una segmentación. 

✓ Aplicación a imágenes en escala de grises: Cuando se aplica a una imagen en escala de grises, la 
apertura de atributos consiste en generar una serie de imágenes binarias mediante la 
umbralización para cada nivel de gris distinto en la imagen. La apertura de atributos binaria 
descrita arriba es entonces aplicada independientemente para cada imagen binaria y la salida en 
escala de grises es calculada como la unión de los resultados binarios. La salida final es una 
imagen en escala de grises cuyas estructuras brillantes con el atributo por debajo de un valor 
dado han desaparecido. Una gran ventaja de este filtro es que el contorno de las estructuras del 
área están mejor preservadas que una apertura con un elemento de estructura. 

Como para filtros morfológicos clásicos, el cerrado de atributos en escala de grises o top-hat pueden 
ser definidos. El cerrado de atributos en escala de grises consiste en eliminar componentes oscuros 
conectados cuyo tamaño es menor que un valor especificado. El Top-hat de atributo blanco (negro) 
considera la diferencia de la apertura (cerrado) de atributos con la imagen original, y puede ayudar 
a la identificación de estructuras brillantes (oscuras) de tamaño pequeño. 

De momento, los siguientes plugins de filtrado de atributos están disponibles dentro de MorphoLibJ 
(Plugins>MorphoLibJ): 

• Filtrado de Atributos en Escala de Grises: abre un cuadro de diálogo para llevar a cabo entre 
apertura de atributo, cerrado, y Top-hat negro o blanco en una imagen planar (2D) en escala de 
grises. 

Dos criterios de tamaño pueden ser usados: el área (número de píxeles), o el diámetro (longitud de 
la diagonal del cuadro delimitador). 

• Filtrado de Atributos en Escala de Grises 3D: abre un diálogo para elegir realizar entre una 
apertura de atributo, cerrado, Top-hat negro o blanco en una imagen 3D en escala de grises. El 
criterio de tamaño es el número de vóxeles. 

 

2. Segmentación Watershed 

El algoritmo watershed asimila la imagen en escala de grises a un modelo digital de elevación, y tiene 
como objetivo detectar las diferentes cuencas de captación. En la imagen en escala de grises, las 
cuencas de captación corresponden a regiones oscuras rodeadas por estructuras brillantes (las 
“crestas”). Es una técnica muy popular especialmente usada para objetos que se están tocando. La 
suite MorphoLibJ contiene varias implementaciones del algoritmo y plugins que hacen uso de él: 

• Clasic Watershed: implementación del plugin original del algoritmo watershed por Pierre Soille 
y Luc M. Vincent (1990) para segmentar imágenes 2D/3D en escala de grises. 

• Marked-controlled Watershed: un plugin que lleva a cabo una watershed mediante inundación a 
partir de puntos semilla específicos o marcadores realizado por Meyer and Beucher. 

• Morphological Segmentation: un plugin con una interfaz gráfica de usuario para segmentar 
imágenes 2D/3D basándose en operaciones morfológicas y el algoritmo de watershed. 

Únicamente se verá con más detalle el plugin “Marked-controlled Watershed” por resultar el más 
interesante. 

El “Marker-Controlled Watershed” es un plugin del ImajeJ para segmentar imágenes en escala de 
grises de cualquier tipo (8, 16 y 32 bits) en 2D y 3D basado en el algoritmo del mismo nombre. Este 
algoritmo considera la imagen de entrada como una superficie topográfica (donde un valor de píxel 
más alto se traduce en más altitud) y simula su inundación a partir de puntos semilla específicos o 
marcadores. Una elección común para los marcadores son los mínimos locales del gradiente de la 
imagen, pero el método funciona sobre cualquier marcador específico, ya sean seleccionados 
manualmente por el usuario o determinados automáticamente por otro algoritmo. 



Informe de Avance y/o Final 2020 Anexo 01 CCUTIME0005279TC 

 

CESARI Matilde Inés 30 
 
 

 
Entradas de Marker-controlled Watershed 

El plugin necesita al menos dos imágenes de entrada para funcionar: 

• “Input Image”: Una imagen 2D o 3D en escala de grises para inundar, normalmente el gradiente 
de la imagen. 

• “Marker Image”: Una imagen de las mismas dimensiones que la de la entrada conteniendo los 
puntos semilla o marcadores como regiones conectadas de vóxeles, cada una de ellas con una 
etiqueta diferente. Se corresponden normalmente con los mínimos locales de la imagen de 
entrada, pero se pueden establecer arbitrariamente. 

• “Mask Image”: Una imagen binaria de las mismas dimensiones que la entrada y el marcador que 
puede ser usada para restringir el área de aplicación del algoritmo. Seleccionar “None” para 
aplicar el algoritmo a toda la imagen de entrada. 

Resto de parámetros: 

• “Calculate dams”: Seleccionar para activar el cálculo de las líneas de watershed. 
• “Use diagonal connectivity”: Seleccionar para permitir la inundación en direcciones diagonales. 

Salida: Imagen etiquetada que contiene las cuencas de captación y (opcionalmente) las líneas de 
watershed (dams) 

 
Ejemplo en la segmentación 

 

3. Fuzzy Set Intensity Transformations 

"Conjunto difuso" es un complemento implementado a través de un pluing en Fii, cuya teoría detrás 
de la aplicación, se detalla en el texto Procesamiento Digital de Imágenes, de Rafael González (9). 

La aplicación emplea el principio de conjuntos borrosos para transformar píxeles con la esperanza 
de mejorar una imagen.  

El complemento Fuzzy Set ingresa los píxeles de una imagen en una matriz. El usuario proporciona, 
mediante el uso de una ventana de entrada, números que corresponden a valores (excepto z0) en la 
siguiente ecuación: 

 

 
9 Thompson, M. (1981). Digital Image Processing by Rafael C. Gonzalez and Paul 
Wintz. Leonardo, 14(3), 256-257. 
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Todas las imágenes utilizan los niveles de gris de la imagen; por lo tanto, limitando el rango de 
valores de salida de “0-255” (“0” corresponde a totalmente negro, así mismo “255” corresponde a 
totalmente blanco). 

Una vez que el usuario ingresa los valores, la aplicación analiza los valores de salida para cada píxel 
"z0". Cada píxel de la imagen se transforma píxel a píxel.  

El programa muestra la nueva imagen modificada en su propia ventana. Aparecen dos ventanas que 
muestran un histograma tanto para la imagen original como para la imagen modificada.  

Aparece la imagen modificada final que ilustra la transformación delineada por el usuario. El usuario 
podrá transformar imágenes en muchos resultados posibles utilizando las funciones del 
complemento Fuzzy Set.  

Con la práctica, el usuario podrá adaptar la aplicación para satisfacer sus respectivas necesidades o 
simplemente divertirse explorando el concepto de usar conjuntos borrosos en el procesamiento de 
imágenes. 

 

4. Trainable Weka Segmentation 

WEKA es una plataforma de software libre para el aprendizaje automático y la minería o exploración 
de datos (proceso que intenta descubrir patrones en grandes volúmenes de conjuntos de datos) 
escrito en Java y desarrollado en la Universidad de Waikato (Hall, y otros, 200910) 

El Trainable Weka Segmentation es un plugin de Fiji que combina una colección de algoritmos de 
autoaprendizaje con un conjunto de características seleccionadas de imágenes para producir una 
segmentación basada en píxeles. Weka puede ser llama a sí mismo desde el plugin. Contiene una 
colección de herramientas de visualización y algoritmos para el análisis de datos y modelado 
predictivo, junto a una interfaz gráfica para un fácil acceso a esta funcionalidad. Como se describe en 
su sitio de Wikipedia, las ventajas de Weka son: 

• Disponibilidad gratuita bajo licencia GNU General Public License. 
• Portabilidad, ya que está totalmente implementado en lenguaje de programación Java y, por lo 

tanto, corre en la mayoría de plataformas de computación modernas. 
• Una colección comprensiva de pre-procesamiento de datos y técnicas de modelado. 
• Facilidad de uso debido a su interfaz gráfica. 

Weka soporta varias tareas de minería estándar de datos, más específicamente, pre-procesamiento 

de datos, clustering, clasificación, regresión, visualización y selección de características (Azoumana, 
201311). 

El principal objetivo de este plugin es trabajar como puente entre los campos del autoaprendizaje y 
el procesamiento de imágenes. Provee el marco de referencia para usar y, más importante aún, 
comparar cualquier clasificador disponible para realizar la segmentación de imágenes basada en 
clasificación de píxeles. 

Interfaz gráfica de usuario 

Trainable Weka Segmentation funciona con cualquier imagen 2D o pila de imágenes 2D (de cualquier 
tipo). 

Por defecto, el plugin comienza con dos clases, i.e. producirá una clasificación binaria de píxeles. El 
usuario puede añadir trazas de ambas clases utilizando el conjunto completo de herramientas para 
dibujo de ROI (Region Of Interest) disponible en Fiji. Esto incluye las selecciones rectangulares, 
circulares, ovaladas, elípticas y selección libre. Por defecto, la herramienta de selección libre (de 1 
píxel de ancho) es automáticamente seleccionada. 

 
10 Hall, M., Frank, E., Holmes, G., Pfahringer, B., Reutemann, P., & Witten, I. (2009). The WEKA 

Data Mining Software: An Update. SIGKDD Explorations, 10-18. 
11 Azoumana, K. (2013). Análisis de la deserción estudiantil en la Universidad Simón Bolívar, 

facultad Ingeniería de Sistemas, con técnicas de minería de datos. Pensamiento Americano, 41-
51. 
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El usuario puede desplazar, hacer zoom para aumentar o disminuir, o moverse entre las imágenes (si 
la imagen de entrada es una pila) en el lienzo principal como si se tratara de cualquier otra ventana 
Fiji.  

En la parte izquierda del lienzo hay dos paneles de botones, uno para el entrenamiento y otro para 
las opciones generales. En la parte derecha del lienzo de la imagen tenemos un panel con la lista de 
trazas para cada clase y un panel para añadir la ROI actual a esa clase específica. Todos los botones 
incluyen una explicación corta de su funcionalidad que es mostrada cuando el cursor permanece 
encima de alguno de ellos. 

Panel de entrenamiento 

• “Train classifier”: Este botón activa el proceso de entrenamiento. Una traza para cada una de las 
dos clases es el requisito mínimo para comenzar el entrenamiento. La primera vez que este botón 
es presionado, las características de la imagen de entrada serán extraídas y convertidas en un 
conjunto de vectores de valores flotantes, que es el formato que los clasificadores de Weka 
esperan. Este paso puede tomar algo de tiempo dependiendo del tamaño de las imágenes, el 
número de características y el número de núcleos de la máquina donde Fiji está corriendo. El 
cálculo de características es realizado completamente en forma de multi-hilos (multiproceso). 
Las características serán calculadas sólo la primera vez que entrenemos después de haber 
arrancado el plugin o después de haber modificado alguna de las opciones de las características. 
Si el entrenamiento termina correctamente, entonces la imagen mostrada estará completamente 
segmentada y el resultado será superpuesto con los correspondientes colores asociados a cada 
clase. Ahora todos los botones están disponibles, ya que todas sus funcionalidades son posibles 
después del entrenamiento. Durante el entrenamiento, este botón mostrará la etiqueta “STOP”. 
Clicando en él, todo el proceso de entrenamiento será interrumpido y se reseteará el plugin al 
estado previo al entrenamiento. 

• “Toggle Overlay”: Este botón activa y desactiva la superposición de la imagen resultado. La 
transparencia de la imagen superpuesta puede ser ajustada en el diálogo de Opciones. 

• “Create Result”: Crea y muestra la imagen resultado. Esta imagen es equivalente a la imagen 
superpuesta (color de 8 bits con los mismos colores que las clases para la clasificación). Cada 
píxel es establecido al valor de índice de la clase más probable (0, 1, 2…). 

• “Get Probability”: Basado en el clasificador actual, la probabilidad que cada píxel tiene de 
pertenecer a cada clase es mostrada en una hyperstack de 32 bits. 

• “Plot Result”: Este botón llama al código de Weka para generar el gráfico del rendimiento del 
modelo, i.e., las curvas basadas en los datos de entrenamiento. Estas curvas permiten visualizar 
la actuación del clasificador basado en los diferentes umbrales que pueden ser aplicados a los 
mapas de probabilidad. 

Panel de opciones 

• “Apply classifier”: Clicando en este botón podemos aplicar el clasificador actual a cualquier 
imagen 2D o pila de imágenes que tengamos en nuestro sistema de ficheros. Aparecerán dos 
cuadros de diálogo para, primero, preguntar al usuario la imagen o pila de imágenes de entrada 
y, segundo, para preguntar si los resultados se mostrarán como un mapa de probabilidades o 
como una segmentación (clases finales)12. Después el plugin llevará a cabo la segmentación de 
imágenes basándose en el clasificador actual y, consecuentemente, las características 
seleccionadas. Esto puede llevar un tiempo dependiendo en el número y tamaño de las imágenes 
de entrada y el número de núcleos de la máquina. Después de terminar, la imagen o pila de 
entrada y su correspondiente segmentación será mostrada. 

•  “Load classifier”: Aquí se puede cargar cualquier clasificador guardado anteriormente. El plugin 
comprobará y ajustará las características seleccionadas con los atributos de este nuevo 
clasificador. El formato de archivo del clasificador es el usado en Weka (.model). 

 
12 Para convertir un mapa de probabilidades en una segmentación, se puede utilizar el siguiente 

Beanshell scrip de github: Convert-TWS-probabilities-to-segmentation.bsh  
(https://gist.github.com/iarganda/c7fc0a88b8d2737c9d3d) 
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• “Save classifier”: Guarda el clasificador actual en un fichero, bajo el formato estándar de Weka 
(.model). Esto nos permite almacenar clasificadores y aplicarlos después en diferentes sesiones 
(opción no disponible en el plugin simple Trainable Segmentation). 

• “Load data”: Aquí podemos cargar los datos (en formato Weka) de trazos previos en la misma u 
otra imagen o pila. De nuevo, el plugin comprobará y forzará la consistencia entre los datos 
cargados y la imagen actual, características y clases. El formato del archivo de entrada es el 
formato estándar Weka: ARFF. Los trazos (regiones de interés seleccionadas por el usuario) no 
se guardan, sino sus vectores de características correspondientes. 

• “Save data”: Con este botón podemos guardar los trazos de información actuales en un archivo 
de datos que podemos manejar después con el plugin. El plugin guardará los vectores 
característicos derivados de los píxeles pertenecientes a cada trazo en un archivo ARFF en una 
localización elegida por el usuario. 

• “Create new class”: El número por defecto de clases en el plugin es dos, pero a través de este 
botón podemos incrementarlo hasta 5 clases. El nombre de las nuevas clases puede ser 
modificado en el diálogo “Settings” 

Opciones 

El resto de parámetros ajustables del plugin pueden ser cambiados en el diálogo “Settings”, el cual es 
mostrado cuando se presiona este botón. 

• “Training features”: Aquí podemos seleccionar y deseleccionar las características de 
entrenamiento, que son la clave del procedimiento de aprendizaje. El plugin crea una pila de 
imágenes (una imagen para cada característica). Por ejemplo, si solo es seleccionado “Gaussian 
blur” como característica, el clasificador será entrenado en la imagen original y algunas versiones 
desenfocadas de ésta con un parámetro diferente de sigma para la Gaussiana. El valor de mínimo 
de sigma por defecto es 1, y su valor máximo por defecto es 16, y por lo tanto 𝑛 = 5. 

Si la imagen de entrada está en escala de grises, las características serán calculadas usando doble 
precisión (imágenes de 32 bits). En el caso de que la entrada sean imágenes RGB, las características 
serán RGB también. 

Las diferentes características disponibles son: 

• “Gaussian blur”: realiza n convoluciones individuales con kernels Gaussianos con las normales n 
variaciones de 𝜎 (𝑠𝑖𝑔𝑚𝑎). Cuanto más grande sea el radio, más borrosa (más desenfocada) se 
hará la imagen hasta que los píxeles sean homogéneos. 

• “Sobel filter”: calcula el gradiente en cada píxel. 
• “Hessian”: calcula la matriz Hessiana en cada píxel. Antes de la aplicación de ningún filtro, un 

“Gaussian blur” con sigma variante es realizado. Las características finales usadas para la 
clasificación de píxeles, dada la matriz hessiana son: módulo, traza, determinante, primer 
autovalor, segundo autovalor, orientación o ángulo devuelto en radianes en el rango; diferencia 
autovalores normalizados de gamma al cuadrado, y cuadrado de la diferencia de los autovalores 
normalizados de gamma. 

• “Diferencia de gaussianas”: calcula dos imágenes Gaussian blur a partir de la imagen original y 
resta una de la otra 

• “Membrane projections”: el kernel inicial para esta operación está codificado (hardcored) como 
una matriz cero 19x19 con la columna central rellena de 1s. Múltiples kernels son creados 
mediante la rotación del kernel original mediante 6 grados hasta una rotación total de 180 
grados, dando 30 kernels. Cada kernel es convolucionado con la imagen y después el conjunto de 
30 imágenes son Zproyectadas en una única imagen mediante 6 métodos: o suma de los píxeles 
en cada imagen, media de los píxeles en cada imagen, desviación estándar de los píxeles en cada 
imagen, mediana de los píxeles en cada imagen, máximo de los píxeles en cada imagen, mínimo 
de los píxeles en cada imagen. Cada una de las 6 imágenes resultantes es una característica. Por 
lo tanto los píxeles en líneas de píxeles de similar valor en la imagen que son diferentes de la 
intensidad media de la imagen serán resaltados en las Z-proyecciones. 

• “Mean, Variance, Median, Minimum, Maximum”: los pixeles dentro de un radio de sigma píxeles 
desde el píxel objetivo son sometidos a la operación pertinente (mean/min, etc.) y el píxel 
objetivo se ajusta a ese valor. 
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• “Anisotropic diffusion”: el filtro de difusión anisótropo de Fiji con 20 iteraciones, 𝜎 suavizados 
por iteración, 𝑎1 = 0.10, 0.35, 𝑎2 = 0.9, y un umbral de borde fijado al tamaño de la membrana. 

• “Bilateral filter”: es muy similar al filtro de Media, pero preserva mejor los bordes 
promediando/desenfocando otras partes de la imagen. El filtro logra esta tarea únicamente 
promediando los valores alrededor del píxel actual que está más cercano en valor de color al píxel 
actual. La “cercanía” de otra vecindad de píxeles al píxel actual es determinada por el umbral 
específico, i.e., para un valor de 10 cada píxel que contribuye a la media actual tiene que estar 
entre 10 valores del píxel actual. En nuestro caso, combinamos radios espaciales de 5 y 10, con 
un rango del radio de 50 y 100.  

• “Lipschitz filter”: del plugin de Mikulas Stencel [15]. Este plugin implementa la envolvente 
(cover) de Lipschitz de una imagen que es equivalente a una abertura en escala de grises por un 
cono. La envolvente de Lipschitz puede ser aplicada para la eliminación de una imagen de fondo 
que varía lentamente mediante la sustracción de la envolvente de Lipschitz más baja (un 
procedimiento tophat). Se usa un algoritmo de doble escaneado secuencial. Usamos una 
combinación de down y tophats, con inclinación (slope) 𝑠 = 5, 10, 15, 20, 25. 

• “Kuwahara filter”: otro filtro de reducción de ruido que preserva bordes. Esta es una versión del 
filtro Kuwahara que usa kernels lineales en lugar de cuadráticos. Utilizamos el tamaño del parche 
de membrana (membrane patch) como tamaño del kernel, 30 ángulos y los tres criterios 
diferentes (𝑉𝑎𝑟𝑖𝑎𝑛𝑧𝑎, 𝑉𝑎𝑟𝑖𝑎𝑛𝑧𝑎/𝑀𝑒𝑑𝑖𝑎 𝑦 𝑉𝑎𝑟𝑖𝑎𝑛𝑧𝑎/𝑀𝑒𝑑𝑖𝑎^2). 

• “Gabor filter”: por el momento esta opción puede tomar algo de tiempo y memoria porque genera 
un rango de filtros de Gabor muy diversos (22). Esto puede sufrir cambios en el futuro. El filtro 
Gabor es un filtro de detección de bordes, que convoluciona varios kernels en diferentes ángulos 
con la imagen. Los filtros Gabor son filtros pasos de banda y por lo tanto implementan una 
transformación en frecuencia. 

• “Derivatives filters”: calcula las derivadas de mayor orden de la imagen de entrada, usando 
FeatureJ 

• “Laplacian filter”: computa el Laplaciano de la imagen de entrada usando FeatureJ. Utiliza una 
escala de suavizado 𝜎. 

• “Structure filter”: calcula, para todos los elementos de la imagen de entrada, los autovalores 
(mayores y menores) de la llamada tensor estructura usando FeatureJ. Se utiliza una escala de 
suavizado 𝜎 y una escala de integración 1 y 3. 

• “Entropy”: dibuja un círculo de radio r alrededor de cada píxel; consigue el histograma de ese 
círculo dividido en numBins pedazos; después calcula la entropía. 

• “Neighbors”: cambia la imagen en 8 direcciones por un cierto número de píxeles, que es 𝜎. Por lo 
tanto crea 8𝑛 imágenes de características. 

Cuando se usan imágenes en escala de grises, la imagen de entrada será también como una 
característica. En el caso de imágenes en color (RGB), el Tono, Saturación y Brillo serán así parte de 
las características. La implementación detallada de los filtros puede verse en el código fuente. 

Opciones de características: 

• “Membrane thickness”: valor esperado del espesor de la membrana, 1 píxel por defecto. Cuanto 
más preciso sea, más precisión se conseguirá en el filtro. 

• “Membrane patch size”: esto representa el tamaño NxN del campo de visión para los filtros de 
proyección de la membrana. 

• “Minimum sigma”: radio mínimo de los filtros usados para crear las características. Por defecto 1 
píxel. 

• “Maximum sigma”: radio máximo de los filtros usados para crear las características. Por defecto 
16 píxeles. 

 

TrackMate-Weka 

Módulo detector para TrackMate que se basa en el complemento Trainable Weka Segmentation para 
segmentar objetos en 2D o 3D. 
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Una vez construido el modelo de clasificación con Weka, este complemento permite usarlo para 
clasificar nuevas imágenes, permite el ingreso del fichero con el modelo, se indica la salida o clase y 
se establece la probabilidad de umbral. 

 
 

API ImageJ 

Una API (Application Programming Interface) es un conjunto de reglas (código) y especificaciones 
que las aplicaciones pueden seguir para comunicarse entre ellas, sirviendo de interfaz entre 
programas diferentes, de la misma manera en que la interfaz de usuario facilita la interacción 
humano-software. 

Las APIs son valiosas, ante todo, porque permiten hacer uso de funciones ya existentes en otro 
software (o de la infraestructura ya existente en otras plataformas) para no estar constantemente 
trabajando sobre lo mismo, reutilizando así código que se sabe que está probado y que funciona 
correctamente. En el caso de herramientas propietarias (es decir, que no sean de código abierto), son 
un modo de hacer saber a los programadores de otras aplicaciones cómo incorporar una 
funcionalidad concreta sin por ello tener que proporcionar información acerca de cómo se realiza 
internamente el proceso. 
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1. Paquete ij 

Este paquete es el más básico y esencial que posee ImageJ. Dentro hay clases que sirven tanto para 
gestionar las comunicaciones entre la aplicación y el usuario como para dar forma en estructuras de 
datos específicos a las imágenes que abrimos o creamos. 

De la variedad de clases que se pueden encontrar en este paquete sólo hemos estudiado estas cuatro: 

▪ ImageJ: es la clase principal de ImageJ. Esta clase contiene el punto de acceso principal al 
programa, y la ventana principal de ImageJ. 

▪ ImagePlus: los objetos de esta clase sirven para la representación de una imagen en ImageJ. 
Esta clase depende de otra que veremos más adelante, ImageProcessor. 

▪ ImageStack: son los objetos conocidos como pilas, que almacenan una matriz extensible de 
imágenes. 

▪ WindowManager: esta clase gestiona la lista de ventanas abiertas en ImageJ. 

 

2. Paquete ij.gui 

Este paquete permite crear nuevas ventanas, ventanas emergentes y cuadros de dialogo diferentes a 
la venta principal y el menú del programa. 

Las clases más utilizadas de este paquete son: 

▪ ImageCanvas: esta clase se utiliza para crear un lienzo que sirva para mostrar imágenes en 
una ventana. 

▪ StackWindow: esta clase hereda de ImageWindow y sirve para mostrar una pila de imágenes. 

Se suele utilizar estas clases como superclases de unas clases creadas por nosotros mismos y poder 
así manipular los comportamientos de éstas. 

 

3. Paquete ij.plugin 

La mayoría de los comandos de menú ImageJ se implementan como plugins, por lo que se pueden 
encontrar en el paquete de ij.plugin y sus subpaquetes. Además debemos utilizar este paquete 
cuando queremos implementar un plugin por nosotros mismos. Si no, utilizamos la interfaz PlugIn 
que sirve para indicar que el plugin que vamos a desarrollar no requiere de una imagen de entrada. 

 

4. Paquete ij.process 

Este paquete se utiliza para trabajar con la imágenes desde el nivel más bajo y próximo a la imagen 
en sí que existe. En concreto se suele usar para utilizar la clase ImageProcessor que sirve de soporte 
para los objetos ImagePlus 
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Análisis De Imágenes Médicas con Fii ImageJ 

INTRODUCCIÓN 

El procesamiento digital de imágenes se ha consolidado dentro de las áreas de ingeniería como un 
amplio campo de investigación en el cual participan investigadores pertenecientes a diversas ramas 
de la ciencia y la tecnología [1].  

En un comienzo existían grandes limitaciones para llevar a cabo la gran cantidad de cálculos que 
requiere la mayoría de los métodos del procesamiento digital de imágenes, sin embargo, actualmente 
con la introducción de nuevas tecnologías en el área de la computación es posible realizar una parte 
considerable del cálculo asociado al procesamiento digital de imágenes en un accesible computador 
personal.  

Segmentación de Imágenes 

La mayoría de los métodos de segmentación desarrollados no se han validado en ambientes clínicos 
y se han quedado en los laboratorios de donde nunca salieron. Solo unos pocos se han aplicado de 
forma rutinaria en la práctica médica y, al hacerlo, han puesto de manifiesto sus carencias y 
limitaciones [2;3;4].  

Las técnicas de segmentación actuales se pueden clasificar de acuerdo a diversos criterios: I- Grado 
de interacción del usuario, automáticas y semiautomáticas o manuales. II- Tipo de datos utilizado 
Monoespectrales y Multiespectrales. Otra clasificación posible hace referencia al uso de atlas 
anatómicos para incluir información a priori sobre la localización de los distintos tejidos o a métodos 
de extracción del espacio intracraneal mediante una serie de operaciones generalmente basadas en 
operadores de morfología matemática y deformación de contornos. 

Dentro de los enfoques de segmentación de imagen en la detección de semejanza, una imagen se 
segmenta en regiones basadas en la similitud, las técnicas que caen bajo este enfoque son; técnicas 
de umbral, técnicas de cultivo de región y fusión de regiones. Las técnicas de agrupación también 
utilizan esta metodología, dividen la imagen en un conjunto de clústeres que tienen criterios 
similares basados en algunos criterios predefinidos [5]. 

Dentro del procesamiento de imágenes una característica importante es la textura. El análisis de 
textura se la puede considerar como la distribución de los valores de niveles de gris entre los píxeles 
que forman una región de interés en una imagen. Este concepto planteado se puede representar 
como un mapa tridimensional basado en los valores de los pixeles. Es por tanto que el análisis de 
textura es una herramienta utilizada para evaluación de la intensidad y la posición de los pixeles en 
una imagen [6;7]. 

La segmentación manual de objetos de interés se ha realizado durante largo tiempo para estimar de 
forma objetiva distintas características de los objetos estudiados. Esta tarea se basa en la selección 
de los píxeles que pertenecen al objeto de interés de forma interactiva, bien seleccionando píxel por 
píxel de dicho objeto o bien usando herramientas semiautomáticas como la umbralización y el 
crecimiento de regiones. 

Imagen Médica 

La imagen médica puede ser definida como el conjunto de técnicas y procesos que representan 
espacialmente una o más propiedades físicas o químicas dentro del cuerpo humano [8]. Éstas 
mapean, siendo esta visualización obviamente cualitativa. Contienen más información de la que 
revela la simple inspección ocular y las técnicas de análisis permiten la obtención de nuevas 
características o parámetros medibles, que también pueden ser representadas sobre el mapeo de la 
imagen realizada. 

Principalmente en neurología se manejas imágenes provenientes de Tomografías Computadas (TC): 
usa combinación de radiografías (Radiaciones ionizantes) y técnicas computarizadas para obtener 
cortes transversales. Y Resonancia Magnética por Imágenes (RMI): método no funcional para producir 
imágenes tomográficas precisas de los órganos internos del cuerpo; mediante radiaciones no 
ionizantes. La resonancia magnética ofrece excelentes detalles anatómicos debido a su alto contraste 
entre tejidos blandos y la posibilidad de realzar diferentes tipos de tejidos empleando distintos 
protocolos de adquisición [9]. 
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En cuanto a los formatos de imagen, el más utilizado y reconocido para la adquisición y 
almacenamiento es el formato DICOM (Digital Imaging and Communication On Medicine [10], 
caracterizado por estar compuesto por una cabecera de metadatos con información de la adquisición, 
datos del paciente, del dispositivo y del hospital, entre otros; y por otra parte con los datos propios 
de la imagen en forma de cadena de valores codificados que contienen la información de los píxeles 
que componen la imagen. 

Herramientas 

En los últimos años, una de las aplicaciones que más se ha extendido en el campo del procesamiento 
de imagen biológica ha sido ImageJ. Esta aplicación, de dominio público, fue desarrollada por Wayne 
Rasband en el National Institutes of Health [11].  

ImageJ es un programa de procesamiento y análisis de imágenes basado en lenguaje Java creado por 
el National Institute of Mental Health (NIMH) del U.S. Department of Health & Human Services en 
1997 y ampliamente utilizado en investigación y diagnóstico médico, si bien los antecedentes se 
basan en los trabajos del Jet Propulsion Laboratory del California Institute of Technology de la NASA, 
que aplicaba la técnica para el procesado de imágenes aéreas y espaciales, como por ejemplo, las de 
la sonda Mars Rover en Marte. 

Se puede obtener de forma gratuita desde la página web http://rsbweb.nih.gov/ij/ index.html del 
propio NIMH. La capacidad de trabajo en diferentes plataformas operativas (Windows, Linux, Mac 
OS X), lo convierte en una herramienta muy versátil y con amplias capacidades de procesado y 
análisis. De algunas ventajas de ImageJ, destaca que permite extender su funcionalidad mediante 
plugins, macros y scripts. Todo esto puede desarrollarse ya sea mediante el editor incluido en ImageJ 
y un compilador Java, o con algún otro IDE como Netbeans o Eclipse [12]. 

Además, soporta multitud de formatos de imagen, permitiendo mostrar, editar, analizar, procesar, 
guardar, e imprimir imágenes de 8 bits (256 ´colores), 16 bits (miles de colores) y 32 bits (millones 
de colores), pudiendo leer diversos formatos de imagen como TIFF, PNG, GIF, JPEG, BMP, DICOM, 
FITS, así como formatos RAW. También soporta stacks (pilas) de imágenes; es multiproceso, de forma 
que las operaciones que requieren mucho tiempo se pueden realizar en paralelo en hardware multi-
CPU.  

Los plugin, hacen posible resolver muchos y variados problemas de procesado y análisis de imágenes, 
desde imágenes en vivo de las células en tres dimensiones [13], procesado de imágenes radiológicas 
[14], comparaciones de múltiples datos de sistemas de imagen [15], hasta sistemas automáticos de 
hematología [16]. También se usa como herramienta de [17], [18]. 

El software libre Fiji, de reciente aparición como una versión moderna y mejorada de ImageJ, fue 
pensado originalmente para los neurocientíficos, que acumuló una funcionalidad suficiente para 
atraer a científicos de una variedad de campos, como la biología celular, parasitología, genética, 
ciencias de la vida en general, la ciencia de materiales, etc. El objetivo principal de Fiji es proporcionar 
una distribución de ImageJ con muchos paquetes de plugins.  

En este trabajo se realiza un estudio de las técnicas de análisis de imagen y del software para su 
empleo en temas como el filtrado y la segmentación, que son de gran importancia en el 
procesamiento digital de imágenes, para lograr de esta manera su aprovechamiento en las prácticas 
de los laboratorios referentes a estos temas. 

 

METODOLOGÍA 

Imágenes 

Las imágenes que se han empleado provienen del repositorio wed de datos: kaggle datasets, 
Br35H :: Detección de tumores cerebrales 2020 de Ahmed Hamada19 

El conjunto de datos contiene 3 carpetas: sí, no y pred que contiene 3060 imágenes de 
resonancia magnética cerebral. La carpeta sí contiene 1500 imágenes de resonancia 
magnética cerebral que son tumorales. La carpeta no contiene 1500 imágenes de resonancia 
magnética cerebral que no son tumorales. 
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El software 

Para la visualización de las imágenes de resonancia magnética se ha utilizado un visualizador 
de imágenes DICOM (Digital Imaging and Communication in Medicine). DICOM es el estándar 
utilizado para el intercambio, visualización, almacenamiento, impresión y transmisión de 
imágenes médicas [Wikipedia]. Se ha empleado el visualizador Radiant Dicom Viewer, la 
descarga del visualizador es gratuita a través de la página web oficial: 
http://www.radiantviewer.com/es/ . [RadiAnt] 

La implementación del método propuesto se llevó a cabo de la mano de dos grandes 
plataformas de procesamiento de imagen, estas son la distribución FIJI de ImageJ empleada 
para el pre-procesamiento de las imágenes y para las tareas de extracción de características 
y KNIME, para el aprendizaje, clasificación y evaluación del modelo. Ambos programas son 
libres, multiplataforma, bastante conocidos y su uso está muy extendido en todo el mundo. 
Es precisamente esa la razón de su elección en un intento por facilitar la reproducibilidad 
del experimento ante la comunidad científica. 

ImageJ es un programa de procesamiento de imagen digital de código abierto, además de 
multiplataforma al estar escrito en Java, fue desarrollado inicialmente el National Institut of 
Health [20]. Soporta la mayoría de tipos conocidos de imágenes por lo que sus usos son 
diversos aunque se enfoca principalmente en el análisis y procesamiento de imagen bio-
médica. ImageJ es altamente extensible, con miles de complementos y scripts para realizar 
una amplia variedad de tareas. Su gran comunidad de usuarios se encarga de mantenerlo y 
actualizarlo. Otro aspecto que destaca es su integración con herramientas de procesamiento 
de imagen como Matlab, KNIME o ITK.  

Fiji ImageJ, es una distribución de ImageJ que viene con muchos plúgins incluidos (que por 
otro lado algunos podrían instalarse manualmente en ImageJ) con el objetivo de facilitar las 
tareas de análisis y procesamiento de la imagen [21]. Fiji ha sido el programa que se ha 
empleado en los experimentos para la etapa de pre-procesamiento y extracción de 
caracterísitcas. Fiji es fácil de instalar y tiene una función de actualización automática, 
agrupa una gran cantidad de plugins y ofrece una documentación completa. Se puede 
encontrar más información en la web imagej.net/Fiji. 

ImageJ no solo es de fácil acceso sino que permite la adición de plugins y macros 
personalizados mediante herramientas que proporcionan las librerías lo que hace a la 
plataforma de ImageJ la utilidad versátil en el tratamiento de imagen, igualmente exporta 
datos para su respectivo análisis mediante una hoja de cálculo. 

El Konstanz Information Miner (KNIME) es un plataforma modular que permite un fácil 
montaje visual y ejecución interactiva de flujos de datos. Está diseñado como una 
herramienta de enseñanza, investigación y colaboración, que permite la integración sencilla 
de nuevos algoritmos y herramientas, así como métodos de manipulación o visualización de 
datos en forma de nuevos módulos o nodos [22].  

Su interfaz de usuario es potente e intuitiva, permitiendo la exploración interactiva de 
resultados de análisis o modelos entrenados.  KNIME fue desarrollado por el departamento 
de bioinformática y minería de datos de la Universidad de Constanza, Alemania, y 
actualmente está a cargo de la empresa KNIME.com GmbH radicada en Zurich, Zuiza. Esta 
herramienta puede ser descargada y utilizada gratuitamente bajo los términos de la licencia 
GPLv3. KNIME cuenta con un complemento de procesamiento de imagen que contiene 
alrededor de 100 nodos para tratar diversos tipos de imágenes (2D y 3D) y videos, además 
de aplicar métodos comunes como pre-procesamiento, segmentación, extracción de 
características, seguimiento y clasificación. Actualmente esta extensión se puede utilizar con 
diversas herramientas de procesamiento de imágenes como BioFormats, SCFIO, ImageJ, 
Omero y SciJava 
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A continuación, se va a detallar la metodología empleada para la realización del análisis de 
textura en imágenes médicas con el fin de establecer diferencias entre tejido sano y tejido 
patológico. El proceso de análisis y clasificación entendido de manera global puede definirse 
con las siguientes etapas básicas: 

 
Para facilitar la explicación primero se deben tener en cuenta tres aspectos sobre el método 
propuesto: Primero, se pasa de un plano tradicional de procesamiento de pixeles a uno de 
superpixeles; estos son desplegados como una estrategia de captura de redundancia de la 
imagen que consiste en agrupar píxeles (vecinos) con características comunes (brillo, color, 
textura) facilitando el posterior procesamiento. Segundo, el método aborda el problema de 
segmentación de la imagen como un problema de clasificación supervisada de 
superpixeles. Tercero, el método se construyó de forma dinámica mediante la comparativa 
entre  algoritmos de clasificación supervisada, donde finalmente se eligió la mejor técnica 
y el mejor algoritmo para configurar el método final de segmentación. 

Método propuesto se compone de 3 fases. en la primera (pre-procesamiento) se toman las 
imágenes originales y se aplica técnica de mejoramiento de la imagen (ecualización del 
histograma). Luego a partir de las imágenes mejoradas, se aplica el Simple Linear Iterative 
Clustering (SLIC) para obtener las imágenes de superpixeles. En la segunda fase (Extracción 
de características) se extrajeron características de textura, más 1 variable de clase que se 
obtuvo empleando las imágenes etiquetadas (marcadas manualmente). Cuando el dataset 
estuvo listo, se pasó a la tercera fase (aprendizaje de máquina) en dónde se clasificó 
comparando algoritmos diferentes. Los superpixeles clasificados fueron reagrupados 
obteniendo finalmente las imágenes segmentadas. 
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Al abrir el programa, aparece la barra de ImageJ. Para abrir una imagen, arrástrala hasta la 
barra de ImageJ. En la parte inferior de la barra de ImageJ aparecen las coordenadas (x e y) 
del cursor, así como el valor del pixel que señala. Para no abrir las imágenes una por una, 
ImageJ nos permite abrirlas todas juntas poniéndolas en lo que se llama una secuencia o, en 
inglés, “stack”. Para ello arrastramos la carpeta que contiene las imágenes del video sobre la 
barra de tareas del ImageJ, al soltar la carpeta sobre la barra del ImageJ. Ahora, en la parte 
inferior de la ventana vemos una barra de desplazamiento que nos permiten pasar de una 
imagen a otra de la secuencia 

Los principales métodos observados para el procesamiento de imágenes neuronales son: 

A. Extracción del espacio intracraneal  

El primer paso, es eliminar de las imágenes todos aquellos tejidos que se encuentran fuera 
del espacio intracraneal y que tienen brillos similares. Entre estos tejidos son de especial 
importancia el hueso, la grasa y la piel.  

La eliminación de fondo (en inglés background removal) habitualmente es parte de un 
algoritmo general para la clasificación de objetos y extracción de características a partir de 
una imagen de entrada [23]. En los últimos años se han desarrollado numerosos métodos de 
segmentación intracraneal. La mayoría de ellos se basa en la aplicación de umbrales y 
operaciones de morfología matemática aplicados a imágenes 3D potenciadas en T1 (3D-T1) 

Los métodos de mejoramiento de la imagen se han convertido en un factor indispensable 
dentro de la imagen médica [24,25]. En el trabajo de [26], se compararon 3 técnicas de 
mejoramiento de la imagen: normalización, ecualización del histograma y histogram 
matching. Finalmente se seleccionó la mejor para la fase de segmentación, dichas técnicas se 
aplicaron por separado produciendo 3 nuevos conjuntos de imágenes, 1 por cada 
transformación.  

Nuestra propuesta, para el tratamiento de corrección y de mejora de la imagen que facilite el 
procesado según los resultados y los algoritmos disponibles en la herramienta son: 

– Eliminación de fondo.  

La imagen ha de ser de 8 bit, es decir que se trabaja con 256 niveles de grises (únicamente 
enteros). Para cambiarlo, ir a: Image/Type/8 bit. Para eliminar el fondo se utilizará la función 
incorporada en ImageJ Subtract Background (menú Process/Substract Background…).  

  
Función Subtract Background… 

Esta función elimina fondos continuos lisos de geles y otras imágenes. Se basa en el algoritmo 
de Rolling Ball descrito en el artículo de Sternberg. Se puede comprender imaginando una 
superficie 3D, siendo los valores de los píxeles de la imagen la altura, entonces la esfera que 
recorre la parte baja de la imagen crea el fondo. El algoritmo actual (desde la versión 1.39f) 
utiliza una aproximación de un paraboloide de rotación en lugar de una esfera. 
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La función trae como único parámetro ajustable el radio de curvatura del paraboloide a 
utilizar: 

– “Rolling Ball radius”. Como regla de oro, para imágenes de 8 bits o imágenes RGB debería 
ser al menos tan grande como el radio del objeto más grande en la imagen que no forme 
parte del fondo. Valores más altos también funcionarán, al menos que el fondo de la 
imagen sea demasiado desigual. Para imágenes con valores de píxeles muy diferentes, hay 
hacer notar que el radio deberá ser inversamente proporcional al rango de valores de los 
píxeles. Por ejemplo, los valores típicos de los radios están entre 0.2 y 5 para imágenes de 
16 bits (valores de los píxeles entre 0 y 65535). En este proyecto se ha comprobado que 
un valor para este parámetro que arroja unos resultados aceptables es 50 píxeles. 

Las otras opciones que ofrece esta función son: 

– La casilla “Light Background”, que permite el procesado de imágenes con fondo brillante 
y objetos oscuros, y que por tanto deberá ser seleccionada para la aplicación del 
algoritmo. 

– La opción “Separate Colors” sólo está disponible para imágenes RGB (que será nuestro 
caso, al no presentar ningún canal en particular una ventaja sobre el resto). Al 
seleccionarla, la operación afectará tanto al brillo de la imagen como al tono y saturación 
de la misma, en lugar de únicamente a la primera característica si estuviese 
deseleccionada. 

– Con la opción “Create Background”, la salida no será la imagen con el fondo sustraído, sino 
más bien el propio fondo. Esta opción es útil para examinar el fondo creado (en 
combinación con la opción de vista previa “Preview”). “Create Background” también 
puede ser utilizado para algoritmos de sustracción de fondo personalizados donde la 
imagen es duplicada y filtrada (por ejemplo eliminando “agujeros” en el fondo) antes de 
crear el fondo y finalmente sustraerlo con Process>Image>Calculator. En este caso se ha 
optado por no utilizar esta opción ya que no aporta una mejoría suficientemente notable 
como para añadir otro paso más en el algoritmo. 

– Si la opción “Sliding Paraboloid” está seleccionada, la “rolling ball” será reemplazada por 
un paraboloide que tendrá la misma curvatura en el vértice que la esfera de ese radio. Esta 
opción permite cualquier valor de radio > 0.0001 (el algoritmo “rolling ball” requiere un 
radio de al menos1). El “sliding paraboloid’”típicamente produce correcciones más 
fidedignas que el “rolling ball”, un algoritmo heredado (sólo se mantiene por 
compatibilidad de versiones), es propenso a defectos de bordes. 

– Para calcular el fondo (“rolling the ball”), las imágenes son normalmente suavizadas para 
reducir ruido (media por encima de 3x3 píxeles). Con la opción de “Disable Smoothing”, 
los datos de la imagen sin modificar son usados para crear el fondo. Seleccionar esta 
opción para asegurarse de que la imagen de datos después de la sustracción nunca estará 
por debajo del fondo. 

También podemos utilizar la varita mágica (método inteligente de Selección Wand) para 
seleccionar el fondo y utilizar Edit/Fill para retirarlo. O, podemos obtener un valor medio 
del ruido de fondo con herramienta de selección dibujar un rectángulo en la zona del fondo; 
presionamos ctrl + M, para tomar el valor medio; luego ingresamos al menú 
Process/Math/Substract…, y restar dicho valor a la imagen (ver Figura ). 

        

run("Wand Tool...", "tolerance=30 
mode=Legacy"); 

run("Make Inverse"); 

run("Cut"); 

run("Make Inverse"); 

run("Auto Crop (guess background color)"); 

Figura: Eliminación del fondo. 
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– Un retoque mínimo para mejorar la imagen 

El software ImageJ incorpora una función específica para este paso, la función “Enhance Contrast”. 
Dicha función mejora el contraste de la imagen mediante el uso tanto de la extensión del histograma 
como de la ecualización del histograma. Ambos métodos se describen en detalle en la “Hypermedia 
Image Processing Reference – Contrast Stretching and Histogram Equalization”.  

La expansión del histograma consiste en aumentar el rango de niveles de gris de la imagen, lo cual se 
puede conseguir aplicando una transformación de las intensidades mediante una función a trozos. 
Por otra parte, la ecualización del histograma mejora el contraste de la imagen, repartiendo de forma 
más o menos uniforme los valores del histograma. De esta forma se pasará de tener un histograma 
estrecho (imagen de bajo contraste) a un histograma ancho (imagen de alto contraste). 

 
Función Enhance Contrast 

Este comando no altera el valor de los píxeles siempre que “Normalize”, “Equalize Histogram” o 
“Normalize All n Slices” (en el caso de pilas) no estén seleccionadas. Esta función, al igual que la 
anterior, sólo permite ajustar un parámetro, que es el de “Saturated pixels”. Este valor determina el 
número de píxeles en la imagen que podrán ser saturados. Incrementando este valor se incrementará 
el contraste. Deberá ser mayor que cero para prevenir algunos píxeles periféricos causando que el 
estiramiento del histograma no funcione como se espere. 

– Si la opción “Normalize” está seleccionada, ImageJ recalculará los valores de los píxeles de la 
imagen de modo que el rango sea igual al rango máximo para el tipo de dato, o 0-1.0 para 
imágenes float. La expansión del contraste realizado en la imagen es similar a la opción “Auto” en 
el apartado “Birghtness/Contrast…”, excepto que, con pilas, cada diapositiva en la pila es ajustada 
independientemente, acorde con el óptimo para esa diapositiva individual (si “Use Stack 
Histogram” está deseleccionado). El máximo rango es 0-255 para imágenes de 8 bits y 0-65535 
para imágenes de 16 bits. En el algoritmo implementado se ha visto que saturando un 1% de los 
píxeles de la imagen se obtiene una mejora en el contraste suficiente para el resto de pasos. Si se 
están utilizando pilas de imágenes se mostrarán otras casillas de selección: 

– “Normalize All n Slices”. Si es seleccionada, se aplicará una normalización a todos los elementos 
de la pila. Hay que hacer notar que la normalización de imágenes RGB no está soportada, y por lo 
tanto está opción no estará disponible en pilas RGB. 

– Otra opción que aparecería sería “Equalize Histogram” la cual, si es seleccionada, hace que ImageJ 
mejore la imagen usando la ecualización del histograma. Si se crea una selección la ecualización 
se basará en el histograma de esa selección. Utiliza un algoritmo modificado que toma la raíz 
cuadrada de los valores del histograma. Presionar “Alt” para usar el algoritmo de ecualización de 
histograma estándar. Los parámetros “Saturated Pixels” y “Normalize” son ignorados cuando 
“Equalize Histogram” está seleccionado. 

– La última casilla, si se utilizan pilas de imágenes, sería “Use Stack Histogram”. Si esta opción está 
seleccionada, ImageJ utilizará el histograma total de la pila en lugar de los histogramas 
individuales de cada imagen, lo que permite ajustes óptimos para cada imagen individual. Esta 
opción puede ser especialmente relevante cuando se están realizando mejoras basadas en una 
ROI. 

Una vez llegados a este punto será necesario el ajuste del brillo de la imagen para conseguir 
resaltar únicamente las partes que nos interesan. 
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El software ImageJ incluye un apartado denominado “Math” (Process>Math), en el cual se 
incluyen las diversas transformaciones matemáticas que es posible aplicar a la imagen. Estas 
operaciones actúan en la imagen o en la parte seleccionada píxel a píxel. La opción “Preview” 
está disponible para la mayoría de las operaciones. 

En el caso de estar trabajando con una pila de imágenes aparecerá un diálogo en el que se 
podrá decidir si se desea que la operación se aplique a la imagen actual o a todo el conjunto. 

Para el algoritmo implementado se hará uso exclusivamente de la operación “Multiply…”, la 
cual en este caso multiplicará la imagen completa por una constante real definida. Con 
imágenes de 8 bits los resultados mayores que 255 se truncan a 255. Trabajando con 
imágenes de 16 bits, los resultados superiores a 65535 son fijados a 65535. En este caso se 
multiplicará la imagen por un valor de 1.25, el cual se ha comprobado que elimina de nuevo 
bastante el fondo y realza lo suficiente el brillo del cerebro. 

El retoque más común es menú Image/adjust/ Brightness - contrast. La opción Auto da un 
resultado aceptable. El gráfico que se muestra es el “histograma” y representa en X los 
valores posibles de los pixeles (desde 0 a 255) y en Y el número de pixeles que tienen un 
determinado valor. Esta herramienta se utiliza para alterar interactivamente el brillo y el 
contraste de la imagen activa.  

Esta herramienta se utiliza para alterar interactivamente el brillo y el contraste de la imagen 
activa. Con imágenes de 8 bits, el brillo y el contraste son cambiados mediante la 
actualización de la LUT de la imagen, por lo que el valor de los píxeles permanece inalterado. 
El brillo y contraste de imágenes RGB es cambiado mediante la modificación del valor de los 
píxeles. 

 
Ajuste del Brillo y Contraste 

• “Histogram”: El gráfico de líneas en la parte superior de la ventana, el cual es superpuesto 
sobre el histograma de la imagen, muestra cómo son mapeados los píxeles a valores de 8 
bits (0-255). Los dos números debajo de la gráfica son el valor mínimo y máximo de los 
píxeles mostrados. Esos dos valores definen el rango de visualización o ventana. ImageJ 
muestra imágenes mediante el mapeado lineal del valor de los píxeles en el rango de 
visualización al rango de valores 0-255. Los píxeles con un valor menor que el mínimo 
son mostrados como negro y aquellos con un valor mayor que el máximo son mostrados 
como blancos. 

• “Minimum and Maximum sliders”: Controlan los valores límites mínimos y máximos del 
rango de visualización. Al presionar “Shif’” se ajustarán simultáneamente todos los 
canales de una imagen compuesta. 
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• “Brightness slider”: Incrementa o decrementa el brillo de la imagen mediante el 
desplazamiento del rango de visualización. Si se presiona “Shift” se ajustarán 
simultáneamente todos los canales de una imagen compuesta. 

• “Contrast slider”: Incrementa o decrementa el contraste mediante la variación de la 
anchura del rango de visualización. Cuanta menor anchura tenga, mayor será el 
contraste. Al presionar “Shift” se ajustarán simultáneamente todos los canales de una 
imagen compuesta. 

• “Auto”: ImageJ optimizará automáticamente el brillo y el contraste basándose en un 
análisis del histograma de la imagen. Si se crea una selección, la imagen entera será 
optimizada en base a un análisis de esa selección. La optimización se realiza permitiendo 
que un pequeño porcentaje de píxeles en la imagen sean saturados (mostrados como 
blanco o negro). Cada clic adicional en “Auto” incrementa el número de píxeles saturados 
y por lo tanto la cantidad de optimización. Una llamada a una macro run(“Enhance 
Contrast”, “saturated=0.35”) es generada si el comando de registro (Plugin>Macro 
>Record…) se está ejecutando. 

• “Reset”: Reestablece las configuraciones de brillo y contraste original. El rango de 
visualización se establece al rango de valores de píxeles completos de la imagen. Una 
llamada a la macro resetMinAndMax() es generada si el comando de registro se está 
ejecutando. Presionando “Shift” se reestablecen las configuraciones originales en todos 
los canales de una imagen compuesta. 

• “Set”: Permite introducir los valores mínimo y máximo del rango de visualización en un 
cuadro de diálogo. Una llamada a la macro setMinAndMax() es generada si el comando de 
registro se está ejecutando 

Una imagen de 16 bits consiste en 65536 valores de grises posibles. La mayoría de las veces, 
sin embargo, la información relevante de la imagen está contenida sólo dentro de un rango 
estrecho de la escala de grises. Este es el caso, p.e., en microscopía de luz reducida, en la que 
la señal está restringida en el extremo inferior de la escala de grises. El diálogo “Set Display 
Range” permite elegir cómo escalar el rango de los niveles de gris en imágenes de 16 bits. 

 
Configuración del rango de visualización 

• “Automatic”: Automáticamente se selecciona el mejor rango dados los valores de 
intensidad de la imagen basándose en el porcentaje del número total de valores píxeles 
desde el valor de píxel más bajo al más alto. 

− “8-bit (0-255)”: Nivel de grises de 0-255. 
− “10-bit (0-1023)”: Nivel de grises de 0-1023. 
− “12-bit (0-4095)”: Nivel de grises de 0-4095. 
− “15-bit (0-32767)”: Nivel de grises de 0-32767. 
− “16-bit (0-65535)”: Nivel de grises de 0-65535. 
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Seleccionar “Propagate to all open images” para aplicar estos valores al resto de las 
imágenes actualmente abiertas. Con imágenes multicanal, la opción para propagar el rango 
específico al resto de canales también está disponible. 

• “Apply”: Aplica la función de mapeo del rango de visualización actual a los datos de 
píxeles. Si hay una selección, solo los píxeles dentro de la selección serán modificados. 
Esta opción actualmente solo funciona con imágenes de 8 bits, pilas de 8 bits y pilas RGB. 
Esta es la única opción de B&C que altera los datos de los píxeles de imágenes no RGB. 

Este commando y Brightness/Contrast… (B&C) son redundantes, pero Window/Level… (W&L) se 
comporta de una manera más cercana al aplicado en terminales de imágenes médicas 
mediante el ajuste interactivo de “Window” -el rango del mínimo y el máximo (contraste)- y 
“Level” –la posición de ese rango en el espacio de la intensidad de escala de grises (brillo). 

Si la ventana B&C está abierta, se cerrará y en su lugar aparecerá la ventana W&L. 

 
Window/Level… 

También existe otra técnica para mejorar el contraste denominada USM o Unsharp Mask y que 
también viene implementada en imageJ. se encuentra en el menú Process/Filters/Unsharp 
Mask… hay que especificar el valor σ (sigma) de la gaussiana y el porcentaje. Consiste restar a 
la imagen original una versión suavizada con un filtro gaussiano para obtener lo que se 
denomina máscara. Luego en un segundo paso se añade un porcentaje de esta máscara a la 
imagen original para obtener la imagen con el contraste mejorado. 

El programa ImageJ incorpora la función “Gaussian Blur…” Este filtro emplea una convolución 
con una función Gaussiana para el suavizado. “Radius” hace referencia al radio de 
decrecimiento de 𝑒−0.5 (≈ 61%), i.e. la desviación estándar (𝜎) de la Gaussiana (esto es 
diferente para las versiones de ImageJ anteriores a la 1.38u, en las cuales el valor “Radius” 
era2.5 × 𝜎). Como todas las operaciones de convoluciones en ImageJ, se asume que los píxeles 
de fuera de la imagen tienen un valor igual al píxel de borde más cercano. 

 
Función filtro Gaussiano 

Esto da más peso a los píxeles de borde que a los píxeles en el interior de la imagen, y mayor 
peso a los píxeles en las esquinas que a los píxeles de borde. En consecuencia, cuando se está 
suavizando con un valor de radio de suavizado muy alto, la salida será dominada por los 
píxeles de borde y especialmente los píxeles de las esquinas (en el caso extremo, con un radio 
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de suavizado de por ejemplo 1200, la imagen será reemplazada por el valor medio de los 
cuatro píxeles de las esquinas).  

Para incrementar la velocidad, excepto para valores de radio de suavizados pequeños, las 
líneas (filas o columnas de la imagen) se reducen de escala antes de la convolución y son 
reescaladas a su longitud original después de eso. En el algoritmo implementado se propone 
como solución un valor 𝜎 = 5, el cual permite que en las células en las cuales aparecen 
destacados varios nucléolos se difuminen entre ellos, lo cual será crítico para el paso 
siguiente a la hora de localizar los máximos de la imagen. 

Localización de Máximos, la idea es centrarse en localizar los máximos de la imagen con el 
objetivo ideal de obtener un único máximo por cada tejido en la imagen. Para ello se hará 
uso de la función “Find Maxima…”. 

 
Función Find Maxima… 

Esta función determina el máximo local en una imagen y crea una imagen binaria (máscara) del 
mismo tamaño con los máximos, o una partícula segmentada por máximo, marcados. El análisis es 
realizado sobre la selección rectangular existente o sobre la imagen entera si no hay presente 
ninguna selección. 

Para imágenes RGB, se seleccionan los máximos de luminancia, con la luminancia definida como la 
media ponderada o no ponderada de los colores dependiendo en cómo “Weighted RGB to 
Grayscale Conversion” esté configurada en Edit>Options>Conversions… 

El parámetro ajustable en esta función es “Noise Tolerance”. Los máximos se ignoran si no 
destacan de los alrededores por más de este valor (unidades calibradas para imágenes calibradas). 
En otras palabras, se fija un umbral en el valor máximo menos la tolerancia de ruido, y el área 
contigua alrededor del máximo sobre el umbral es analizado. Para aceptar un máximo, esta área no 
debe contener ningún punto con un valor mayor que el máximo. Sólo un máximo dentro de esta área 
es aceptado. 

A continuación en “Output type” se puede seleccionar entre varios tipos de salida: 

– “Single Points”: Da como resultado a un único punto por máximo. 

– “Maxima Within Tolerance”: Todos los puntos dentro de “Noise Tolerance” para cada 
máximo. 

– “Segmented Particles”: Asume que cada máximo pertenece a una partícula y segmenta la 
imagen mediante un algoritmo watershed aplicado a los valores de la imagen (en contraste con 
Process>Binary>Watershed, el cual usa el mapa de distancia Euclídeo - EDM). Ver 
Process>Binary>Voronoi para segmentación de imágenes binarias basadas en la 
segmentación EDM. 

– “Point Selection”: Muestra una selección multipunto con un punto en cada máximo. 

– “List”: Muestra las coordenadas de cada máximo en la ventana Resultados. 

– “Count”: Muestra el número de máximos en la ventana Resultados. 

La opción “Exclude Edge Maxima” excluye los máximos si el área dentro del contorno de la 
tolerancia de ruido de un máximo toca el borde de la imagen (el borde de la selección no importa). 
Se ha decidido en este proyecto incluir como válidas aquellas células que se encuentren en los bordes 
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de las imágenes y, por ende, habrá que aceptar la posibilidad de que sea posible que aparezcan 
máximos en los bordes de las imágenes. 

Para imágenes umbralizadas, la opción “Above Lower Threshold” encontrará el máximo solo sobre 
el umbral más bajo. El umbral más alto de la imagen es ignorado. Si “Segmented Particles” está 
seleccionado como “Output Type”, el área bajo el umbral más bajo es considerada como fondo. Esta 
opción no puede ser usada buscando máximos (imagen con fondo brillante y LUT invertida). En el 
caso de este algoritmo esta casilla permanecerá desmarcada, debido a que la imagen aún no ha sido 
umbralizada. 

Para los casos en los que el fondo de la imagen sea más brillante que los objetos que se quieren 
resaltar, como es el caso en este trabajo, se deberá marcar la opción “Light Background”. 

El comando “Find Maxima…” proporciona como salida una imagen binaria, con las partículas 
destacadas con un valor de 255 y un fondo con valor 0, usando una LUT (Look Up Table) normal o 
invertida dependiendo en si la opción “Black Background” en Process>Binary>Options… está 
seleccionada o no. 

El número de partículas (como las que se obtienen mediante Analyze>Analyze Particles…) en 
la imagen de salida no depende de lo que se haya seleccionado en “Output Type”. Hay que observar 
que “Segmented Particles” dará como resultado por norma general partículas que toquen el 
borde si “Exclude Edge Maxima” está seleccionado, ya que esta última opción se aplica al máximo, 
no a la partícula. 

La ecualización adaptativa del histograma (AHE) es una técnica de procesamiento de imágenes por 
computadora utilizada para mejorar el contraste en las imágenes. Se diferencia de la ecualización del 
histograma ordinario en el sentido de que el método adaptativo calcula varios histogramas, cada uno 
correspondiente a una sección distinta de la imagen, y los utiliza para redistribuir los valores de 
ligereza de la imagen. Por lo tanto, es adecuado para mejorar el contraste local y mejorar las 
definiciones de bordes en cada región de una imagen.  

Sin embargo, AHE tiene una tendencia a sobreamplificar el ruido en regiones relativamente 
homogéneas de una imagen.  

Una variante de la ecualización adaptativa del histograma llamada ecualización del histograma 
adaptativo limitado por contraste (CLAHE) evita esto al limitar la amplificación.  

      

 

Menú:  

Process>Enhance Local Contrast 
(CLAHE) 

 

run("Enhance Local Contrast 
(CLAHE)", "blocksize=127 
histogram=256 maximum=3 
mask=*None* 
fast_(less_accurate)"); 

Ecualización del histograma adaptativo. 

Una propuesta muy interesante para mejorar la imagen es a través del complemento Fuzzy Set, 
emplea el principio de conjuntos borrosos para transformar píxeles con la esperanza de mejorar una 
imagen, en la Figura podemos ver como se normaliza el histograma de la imagen; cuya teoría detrás 
de la aplicación, se detalla en el texto Procesamiento Digital de Imágenes, de Rafael González. 
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Trasformación de las intensidades a través de Fuzzy Set . Imagen original y mejorada 

– Cambio de color (LUT)  

Para sustituir el blanco y negro por un pseudocolor (LUT, Look Up Table). Cambiar escala de colores: 
Image/Lookup Table/ICA2. Una escala muy recomendable para usar es la: 6 shade porque indica en 
azul los píxeles de la imagen que no tienen señal (es decir: nivel 0) y en rojo los píxeles que saturan 
(que tienen el nivel máximo de cada escala, si es de 8bit satura con nivel 255) (ver Figura 3). 

Con imágenes de 8 bits, el brillo y el contraste son cambiados mediante la actualización de la LUT de 
la imagen, por lo que el valor de los píxeles permanece inalterado. Se aplica la LUT’s o paletas de color 
para visualizar los valores de una sola banda en color facilitando el análisis visual. Consiste en una 
tabla o matriz en la que cada nivel digital aparece asociado al nivel con el que se visualiza [27]. 

Las LUT se pueden editar y personalizar desde el menú: Image/Color/Edit LUT… o 
Image/Color/Channels Tool… /Edit LUT…Guardar la imagen previamente) se puede cambiar a RGB, 
corregir niveles, elegir el formato adecuado, etc 

Original 

 

6 shade 

 

16 colours 

 

ICA2 

 

5 ramps 

 

Edges 

 

Algunas escalas de color (LUT) aplicadas sobre una imagen en escala de grises. 
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B. Segmentación 

En Boesen [28] se presenta una comparativa de los métodos más utilizados para la resolución de este 
problema. A continuación, citaremos algunos de los más importantes: BET (Brain Extraction Tool): 
Desarrollado por Stephen Smith. Se basa en la deformación de una superficie paramétrica formada 
por miles de triángulos que se adapta a los límites craneales [29].  

BSE (Brain Surface Extraction): Desarrollado por David Shattuck. Es parte de un software de 
segmentación cerebral llamado BrainSuite. Se basa en la utilización de operadores morfológicos [30]. 

McStrip (Minneapolis Consensus Strip): Desarrollado por Kelly Rehn en IDL. Este método se basa en 
el registro de los datos a un atlas cerebral combinado con operaciones de morfología matemática 
[31]. Todos estos métodos se aplican a imágenes potenciadas en T1 adquiridas en 3D ya que son las 
más fáciles de segmentar debido a su alto contraste. 

 

– El ROI manager, gestor de las regiones de interés  

Cualquiera que haya sido la estrategia elegida para llevar a cabo la segmentación el resultado final es 
una selección formada por una o varias regiones de interés o ROI que discrimina los objetos del fondo. 
Estas ROI se pueden gestionar gracias a una herramienta que es el ROI manager. La podemos 
encontrar en: Edit/Selección/Add to Manager ó (Ctr + T). 

El ROI manager no solo nos permite crear una lista de ROI a la que podemos ir añadiendo elementos 
(Add) sino que también nos permite salvarlas (more/save…) a un archivo, ya sea de forma individual 
o si seleccionamos varias simultáneamente, y volver a abrirlas en el futuro (more/open…) sobre la 
misma imagen que hemos analizado.  

Además, el ROI manager nos permite seleccionar una o varias regiones simultáneamente, cambiarles 
el nombre (Rename), realizar operaciones lógicas de conjuntos entre ellas (more/AND, OR, XOR) y 
finalmente cuantificarlas (more/multimeasure).  

Esto es muy importante ya que, si vamos a presentar un trabajo con datos cuantitativos, además de 
conservar el archivo de imagen original también deberíamos de conservar las regiones que hemos 
cuantificado. También permite aplicar la misma ROI a los diferentes canales de una Stack (secuencia 
de imágenes).  

ROI manager de ImageJ, es una herramienta para trabajar con múltiples selecciones, las que pueden 
ser de diferentes ubicaciones en una imagen, de diferentes segmentos o de diferentes imágenes. 
Todos los tipos de selección, incluyendo puntos, líneas y texto, son compatibles. Se accede de varias 
maneras: Menú Edit> Selection> Add to Manager, o desde Menú Analize > Tools> ROI Manager. 

Para mostrar los resultados de la segmentación presentamos algunos enfoques:  

▪ Contornos superpuestos: simplemente dibuje los contornos en los superpíxeles resultantes en la 
imagen por el color elegido. 

▪ Exportar segmentos como ROI: todos los superpíxeles se exportan como polígonos al Roi Manager. 
▪ Mostrar segmentación final: agregue una pila más y llene cada superpíxel con un color aleatorio.  
▪ Guardar segmentación en archivo: exporte la segmentación de superpixeles a un archivo de texto 

como matriz de segmentación con etiquetas. 
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– Segmentación de imágenes en general 

La segmentación manual se basa en la selección de los píxeles que pertenecen al objeto de interés de 
forma interactiva, bien seleccionando píxel por píxel dicho objeto o bien usando herramientas 
semiautomáticas como la umbralización y el crecimiento de regiones. 

La forma más sencilla e intuitiva de realizar la segmentación seria simplemente perfilar los objetos 
con las herramientas de dibujo (polígono) e ir añadiéndolos al manager de regiones de interés o ROI: 
Edit/Selection/Add to Manager. Elegir una región del fondo (background) en una de las imágenes y 
dibujar un rectángulo (u otra figura). Con M aparece la información de la región, como por ej. el área, 
el promedio de la intensidad, la std, el max y el min. 

El problema de esta técnica es que es muy tediosa y además algo subjetiva ya que depende del criterio 
del investigador. Por ello lo más habitual es o bien realizar la segmentación basándose en un umbral 
o bien utilizar máscaras binarias. En el primer caso se establece un nivel de intensidad que separa 
los objetos del fondo mientras que en el segundo se parte de una o varias imágenes binarias que 
pueden ser creadas mediante un umbral, pero también manualmente o mediante semillas y que se 
someten a operaciones lógicas (suma, resta, diferencia) o se filtran con filtros morfológicos (dilatar, 
erosionar, rellenado de huecos, watershed, Voroni) para obtener como resultado otra imagen binaria 
que delimite lo más precisamente posible a los objetos. 

La segmentación mediante un umbral es un procedimiento muy rápido que el investigador puede 
realizar de manera arbitraria estableciendo visualmente el valor de intensidad, pero que también se 
puede realizar de forma objetiva estableciendo el umbral como aquel valor en el que se encuentra el 
objeto a reconocer.  

Esta herramienta es utilizada para configurar automática o interactivamente los valores bajos y altos 
del umbral, segmentando las imágenes en escala de grises en características de interés y el fondo. 
Usar Analyze>Measure… (con “Limit to Threshold” en Analyze>Set Measurements… seleccionado) 
para medir el conjunto de las características seleccionadas. Ir a Analyze>Analyze Particles… para 
medir las características individualmente. Utilizar la herramienta “Wand Tool” para seleccionar una 
única característica. 

 
Umbralización 

• “Upper slider”: Ajusta el mínimo valor del umbral. Mantener pulsado “Shift” mientras se ajusta el 
mínimo para mover una ventana de umbralización de ancho fijo a lo largo del rango de los niveles 
de grises. 

• “Lower slider”: Ajusta el máximo valor de umbralización. 

• “Method”: Permite seleccionar cualquiera de los 16 métodos diferentes de umbralización 
automática. El método “Default” es el algoritmo modificado IsoData usado en las versiones de 
ImageJ 1.41 y anteriores. Hay que hacer notar que estos son métodos globales de umbralización 
que típicamente no pueden trabajar con imágenes iluminadas de forma desigual. En estos casos 
los algoritmos locales son más apropiados, permitiendo el umbral para variar suavemente la 
imagen. Estos son implementados en el plugin “Auto Local Threshold”, preinstalado en Fiji. 

• “Display”: Permite seleccionar uno de los tres modos de visualización: 
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– Red: Muestra los valores umbralizados en rojo. 

– B&W: Las características se muestran en negro con el fondo en blanco. Este modo tiene en 
cuenta la casilla “Black background” seleccionada en Process>Binary>Options… 

– Over/Under: Muestra los valores que quedan por debajo del umbral en azul, los píxeles 
umbralizados en escala de grises, y los que quedan por encima del umbral en verde. Estos 
colores pueden ser cambiados a partir de una macro mediante la llamada a los métodos 
ImageProcessor.set.setOverColor() y setUnderColor(). 

• “Dark background”: Se selecciona cuando las características que se quieren resaltar son más 
brillantes que el fondo. El estado de esta casilla no cambia después del reinicio. 

• “Stack histogram”: Si está seleccionado, ImageJ primero calculará el histograma de una pila 
entera (o hiperpila) y después computará el umbral basado en ese histograma. Debido a ello, 
todas las diapositivas son binarizadas utilizando un único valor calculado. Si no está seleccionada, 
el umbral para cada diapositiva es calculado de forma individual 

• “Auto”: Utiliza el método de umbralización actualmente seleccionado para, automáticamente, 
configurar los valores del umbral basado en un análisis del histograma de la imagen o selección 
actual. 

• “Apply”: Configura los píxeles umbralizados a negro y el resto de píxeles a blanco. Para imágenes 
flotantes de 32 bits “Apply” ejecutará también Process>Math>NaN Background. 

• “Reset”: Desactiva la umbralización y actualiza el histograma a su estado original. 

• “Set”: Los nuevos valores del umbral pueden introducirse en este cuadro de diálogo. 

Umbraliza imágenes RGB de 24 bits basadas en componentes HSB, RGB, CIE Lab o YUV. Los rangos 
de los filtros pueden ser configurados manualmente o basándolos en el valor de los píxeles de las 
componentes de una ROI definida por el usuario. Este comando, implementado en la versión 1.43l, 
es una versión experimental que se incluye del plugin “Threshold Color” y no está aún integrada 
completamente en ImageJ. 

• “Pass”: Si está seleccionado, los valores dentro del rango son umbralizados y mostrados (filtro 
pasobanda), en caso contrario, los valores fuera del rango seleccionado son umbralizados (filtro 
rechazobanda). 

• “Thresholding Method”: Permite seleccionar cualquiera de los 16 métodos automáticos de 
umbralización. 

• “Threshold Color”: Selecciona el umbral de color: ya sea Red, Black, White o Black & White. 

• “Color Space”: Selecciona el espacio de color: HSB, RGB, CIE Lab o YUV. 

• “Dark background”: Debe ser seleccionado cuando las características de la imagen son más 
brillantes que el fondo. El estado de esta casilla no cambia después del reinicio. 

• “Original”: Restaura la imagen origina y actualiza el buffer cuando se cambie a otra imagen. 

• “Filtered”: Muestra la imagen filtrada. Hay que hacer notar que el tipo de la imagen final 
umbralizada es RGB, no de 8 bits en escala de grises. 

• “Select”: Crea una selección ROI basándose en la configuración actual. La selección se realiza de 
acuerdo a las opciones definidas en el diálogo Process>Binary>Options… 

• “Sample”: (Experimental) Configura el rango de los filtros basándose en los valores de los píxeles 
de las componentes de una ROI definida por el usuario. 

• “Stack”: Procesa las diapositivas restantes de la pila (si las hubiese) utilizando la configuración 
actual. 

• “Macro”: Crea una macro basada en la configuración actual la cual es mandada a la ventana 
“Macro Recorder” (Plugins>Macros>Record…) si está abierta. 

• “Help”: Abre un cuadro de diálogo de ayuda. 
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Umbralización de color 

Otra posibilidad sería la de utilizar el histograma de la imagen para establecer el umbral de tal forma 
que este se establezca en función del análisis de la forma de este. Por ejemplo, en ImageJ/Fiji la opción 
default establece automáticamente el umbral al valor de intensidad en que se encuentra el mínimo 
entre dos máximos relativos del histograma. 

Para probar simultáneamente y comparar entre si todos los algoritmos disponibles, vamos al menú: 
Image/Adjust/Auto_Threshold…Try All. Y para establecer el umbral manualmente o 
automaticamente mediante el algoritmo seleccionado, desde: Image/Adjust/Threshold… Si 
queremos crear una ROI que incluye únicamente los píxeles con un valor de intensidad igual o mayor 
que el umbral: .Edit/Selection/Create Selection. Añade la ROI seleccionada al ROI Manager desde: 
Edit/Selection/Add to Manager. 

Alternativamente, una vez establecido el umbral también podemos seleccionar ROI mediante la 
herramienta de encontrar partículas. Analyze/Analyze Particles… Size & Circularity, Add to Manager. 
Esta herramienta nos permite seleccionar individualmente objetos con un área que nosotros vamos 
a especificar (en micras si la imagen esta calibrada y en píxeles si no lo está) y con un cierto grado de 
circularidad (entre 1 que sería un círculo prefecto y 0). 

Las técnicas basadas en la detección de contornos utilizan las fronteras de separación entre distintos 
tejidos para llevar a cabo la segmentación. Existen muchos detectores de contornos, desde los más 
sencillos, como los de Sobel, Prewitt, Gradiente o Laplaciano, hasta los más elaborados, como los 
filtros de Canny, Marr/Hildreth y de congruencia de fase. Todos ellos tienen como objetivo 
seleccionar aquellos píxeles de la imagen que delimitan la frontera del objeto/s de interés. 

Un ejemplo de segmentación de este tipo seria la herramienta de selección de la barita mágica (doble 
clic sobre la barita para ajustar el nivel de tolerancia). En Imagej/Fiji existen herramientas más 
avanzadas para realizar este tipo de segmentación a partir de múltiples semillas. En el menú 
Plugings/Segmentación, podemos encontrar dos: Levels Set y Simple Neurite Tracker En la web de 
los desarrolladores de los pluging se pueden encontrar instrucciones detalladas de cómo utilizarlos.  

jSLIC superpixel segmentation (sólo 2D images)32 es una implementación de código abierto basada 
en Java, para clúster de super píxeles con mejor rendimiento que el clúster iterativo lineal simple 
original [33]. 

Las herramientas CMP-BIA34 son un paquete para ImageJ / Fiji que realizará la segmentación y el 
registro de imágenes. El Centro de Percepción de Máquinas (CMP)es un centro de investigación 
universitario que realiza investigación fundamental y aplicada en visión por computadora, robótica, 
aprendizaje automático, reconocimiento de patrones y matemáticas. El grupo de Algoritmos de 
Imagen Biomédica (BIA)dirigido por  Jan Kybic  desarrolla nuevos algoritmos para el procesamiento 
de imágenes biomédicas. 

http://cmp.felk.cvut.cz/
http://www.fel.cvut.cz/vv/tymy/mip.html
http://cmp.felk.cvut.cz/~kybic/
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Éste es un método de segmentación para agrupar regiones similares - superpíxeles - en una imagen 
dada que generalmente se utilizan para otras técnicas de segmentación. Los únicos dos parámetros 
son el tamaño promedio (inicial) de cada superpíxel y el parámetro de rigidez en el rango <0,1> ( ver 
figura 4). El rango es de 0 (superpíxeles muy elásticos) a 1 (los superpíxeles son casi cuadrados). 
Experimentalmente, establecemos como valor óptimo 0.2 para la mayoría de los casos 

Los únicos dos parámetros son el tamaño promedio (inicial) de cada superpíxel y el parámetro de 
rigidez en el rango <0,1>. El rango es de 0 (superpíxeles muy elásticos) a 1 (los superpíxeles son casi 
cuadrados). Experimentalmente, establecemos como valor óptimo 0.2 para la mayoría de los casos. 

run("jSLIC superpixels 2D", 
"init.=40 regularisation=0.20 
export overlap=none save"); 

 

  

Agrupar superpíxeles. 

En la experimentación se probó con distintos valores y combinaciones, teniendo en cuenta que los 
superpixeles resultantes deberían presentar un tamaño adecuado a las estructuras patológicas 
además de una apropiada segmentación para diferenciar el tejido normal del anormal. Finalmente se 
optó por establecer los valores por defecto ya que se comprobó que produjeron superpixeles que 
cumplieron con las condiciones mencionadas.  

Aunque es beneficioso que los superpixeles se hayan ajustado distinguiendo anticipadamente las 
distintas zonas, es necesario aclarar que son los algoritmos de clasificación supervisada quienes 
realizan la clasificación y segmentación final, de modo que los superpixeles se corresponden a una 
pre-segmentación como estrategia para optimizar la fase de clasificación. 

La aplicación de jSLIC al conjunto de imágenes, produjo como resultado imágenes de superpixeles 
que contienen por cada superpixel una etiqueta. El propósito de ellas es señalar el área de cada 
superpixel la cual fue necesaria para la siguiente la fase de extracción de características. El primer 
paso para construir un modelo es agrupar los superpixels que componen la primera imagen en 
grupos, que llamaremos clusters, del modelo. 

A partir de este trabajo se puede decir que el pre-procesamiento basado en SLIC superpixeles captura 
la redundancia de la imagen reduciendo la complejidad del procesado. Las características de textura 
extraídas de los superpixeles, producen buenos descriptores de las clases. Esto finalmente optimiza 
la etapa de clasificación. 
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C. Clasificación de tejidos  

Una vez extraído el espacio extracraneal (con todos sus componentes de piel, tejido celular 
subcutáneo y cráneo) de las imágenes, el problema de la segmentación de imágenes cerebrales se 
convierte en un problema de clasificación de tejidos.  

Esta clasificación se puede realizar tanto sobre datos monoespectrales como multiespectrales [35] , 
[36]. Se han utilizado distintos algoritmos de clustering para la clasificación de imágenes de RM 
cerebral. El conocido FCM con modificaciones para su adaptación al problema concreto de la 
segmentación se ha empleado numerosas veces [37] , [38] , [39] , [40].  

El algoritmo EM con sus numerosas variantes también se ha utilizado extensamente para la 
clasificación paramétrica de tejidos cerebrales, sólo [41] , [42] o en conjunto con otras técnicas como 
MRF o atlas anatómicos [43] , [44]. 

Otro enfoque que se ha utilizado en la segmentación de imágenes de RM cerebral son las Redes 
Neuronales Artificiales (RNA) donde el proceso de segmentación se resuelve tras un proceso de 
aprendizaje, en el caso de redes supervisadas, o a través de redes no supervisadas como redes 
competitivas [45] , [46]. 

 

– Cuantificación de los segmentos 

Cuando ya tenemos nuestros objetos de interés seleccionados como ROI, que como acabamos de 
comentar podemos gestionar con el ROI manager, realizar la cuantificación es trivial. Primero 
escogemos que parámetros deseamos cuantificar y luego los medimos. Para esto, ir a: Analyze/Set 
Measurements… y luego, Analyze/Measure.  

Esta etapa consistió en obtener una representación de la imagen (en forma de datos) que ayudara a 
discriminar entre las distintas clases (tumor, no-tumor y fondo). Según Rafabel Llovet [47] el 
rendimiento de un sistema de CAD depende más de la extracción y selección de características que 
del método de clasificación. 

El enfoque basado en histograma para el análisis de textura se enfoca en las concentraciones de 
intensidad en la totalidad o parte de una imagen representada como histograma. Las características 
comunes incluyen momentos tales como media, varianza, dispersión, valor cuadrático medio o 
energía media, entropía, asimetría y curtosis. La variación del nivel de gris en una región cercana a 
un superpíxel es una medida de la textura [48]. 

Variables ecogénicas: son variables de primer orden, que se calculan a partir del histograma de 
nivel. Se obtienen de utilizar los momentos del histograma respecto a la intensidad de un segmento 
de la imagen dada. Estos descriptores no repercuten mucho gasto computacional.  

• Ecogenicidad media: es el valor medio del nivel de gris calculado a partir del histograma de 
la imagen correspondiente a un superpíxel. 

• Desviación típica ecogenicidad: es la medida de dispersión de los niveles de gris, 
• Coeficiente de variación: es un índice de variabilidad que nos permite evitar la 

dimensionalidad de las variables y tiene en cuenta la relación existente entre medias y 
desviación típica 

 

ImageJ Measure…  

Según el tipo de selección, calcula y muestra en la tabla de resultados↑ estadísticas de área, longitudes 
de línea y ángulos, o coordenadas de puntos. Para realizar las mediciones con los estadísticos de 
primer orden con ImageJ, primero se le tiene que indicar al programa, los parámetros que se 
requieren medir. Esto se realiza solamente durante la primera medición, posteriormente los ajustes 
quedarán guardados para futuras sesiones. Para realizar esto, ir a “Analyze” | “Set Measurements…” 
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En esta ventana se pueden seleccionar los parámetros 
que se requieran cuantificar; permite medir estadísticas 
de intensidad (Media, Moda, Mediana, Mínimo y Máximo 
Valor de Gris, Desviación Estándar y Densidad 
Integrada), o las estadísticas de forma (Área, Centro de 
Masa, Centroide, Perímetro, Rectángulo Acotado, Forma 
de Descriptores, Elipse Adecuada, Diámetro de Feret, 
Asimetría, Kurtosis y Fracción de Área; con las 
selecciones de línea, pueden medirse Longitud, Ángulo, y 
Rectángulo Acotado. La Media, la Desviación Estándar, 
etc. son calculadas para los valores de los pixeles a lo 
largo de la línea).  

Por ejemplo, para mediciones morfológicas, 
regularmente se seleccionan “Area”, “Perimeter”, “Shape 
descriptors” y “Area fraction”.  

Los resultados pueden ser obtenidos directamente en 
micras si se realizó la calibración antes de realizar el 
análisis. Si no es el caso, los valores se obtendrán en 
pixeles.  

El cuadro de diálogo contiene dos grupos de casillas de 
verificación: el primer grupo controla el tipo de 
mediciones que se imprimen en la tabla Resultados [49]. 
El segundo grupo controla la configuración de medición.  

Las dieciocho casillas de verificación del primer grupo son: 

Area Área de selección en pixeles al cuadrado o en unidades al cuadrado calibradas  
(mm2, um2, etc.), las cuales se fijan utilizando la opción Set Scale 

Mean gray value Promedio del valor gris dentro de la selección, el cual no es más que la suma de 
los valores de grises en todos los pixeles de la selección dividida por el número de 
pixeles. Para las imágenes en RGB, la media se calcula convirtiendo cada pixel a 
escala de gris usando la fórmula gris = (rojo + verde + azul)/3   ó   
 gris = 0.299*rojo + 0.587*verde + 0.114* azul 

Standard deviation Desviación estándar de los valores grises usados para generar la media del valor 
gris..  
Utiliza como etiqueta de columna en la Tabla de resultados: StdDev 

Modal gray value Valor gris que más frecuentemente ocurre dentro de la selección.  
Corresponde al pico más alto dentro del histograma.  
Utiliza como etiqueta de columna en la Tabla de resultados: Mode. 

Min & max gray level Valores de gris mínimos y máximos dentro de la selección. 

Centroid Punto central dentro de la selección (equivalente al centro de gravedad).  
Esto es el promedio de las coordenadas X y Y de todos los píxeles en la imagen o  
selección.  
Utiliza los encabezados X e Y. 

Center of mass Promedio del brillo de las coordenadas X y Y de todos los píxeles en  
la imagen o selección.  
Estas coordenadas son los momentos espaciales de primer orden 
Utiliza los encabezados XM e YM.  

Perimeter Longitud del recorrido a través del límite externo de la selección. El perímetro de 
una selección compuesta es calculado descomponiéndolo en las selecciones 
individuales. El perímetro compuesto y la suma de los perímetros individuales 
pueden ser diferentes debido al uso de métodos de cálculo diferentes.  
Utiliza como etiqueta de columna Perim.  

Bounding rectangle Rectángulo más pequeño que adjunta la selección.  
Utiliza como etiqueta de columna BX, BY, Width y Height, dónde BX y BY son las 
coordenadas de la esquina superior izquierda del rectángulo 

Fit ellipse Adecuar una elipse a la selección.  
Utiliza los encabezados Major, Minor y Angle.  
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Mayor y Menor representan el eje primario y secundario de la elipse más 
adecuada. El Ángulo es el ángulo entre el eje primario y una línea paralela al eje X 
de la imagen. Las coordenadas del centro de la elipse son mostradas como X y Y 
si el centroide se especifica.  
Tenga en cuenta que ImageJ no puede calcular las longitudes de los ejes mayor y 
menor si Pixel Aspect Ratio en Analyze▷Set Scale…  es 1.0.  

Shape descriptors Calcula y despliega los siguientes descriptores de forma: 
− Circularity con un valor de 1.0 que indica un círculo perfecto. A medida que 

el valor se acerca a 0.0, indica una forma cada vez más alargada. Los valores 
pueden no ser válidos para partículas muy pequeñas. Utiliza el 
encabezado Circ. 

− Aspect ratio  La relación de aspecto (alto/ancho) de las partículas de la elipse 
adecuada. Si Fit Ellipse se selecciona en los encabezados Major y Minor se 
muestran los ejes. Utiliza el encabezado AR 

− Roundness la inversa de Relación de aspecto. Utiliza el encabezado Round.  
− Solidity; Tenga en cuenta que el Edit▷Selection▷Convex Hull,  hace que una 

selección de área sea convexa. 
Feret’s diameter La distancia más larga entre dos puntos cualesquiera a lo largo del  

límite de la selección. El encabezado utilizado en la Tabla de Resultados para  
representar este parámetro es Feret.  
El ángulo (0--180 grados) del diámetro del Feret se muestra como FeretAngle, 
así como el diámetro mínimo de la pinza (MinFeret).  
También se muestran las coordenadas iniciales del diámetro de Feret (FeretX y 
FeretY) 

Integrated density La suma de los valores de los pixeles en la imagen o selección.  
Esto es equivalente al producto de Área y el Valor de Gris Medio. La Densidad  
Integrada Cruda (la suma de valores del pixel) se despliega bajo el título 
RawIntDen 
cuando se habilita la opción Densidad Integrada 

Median El valor central de los pixeles en la imagen o selección. 

Skewness Asimetría: El tercer momento estándar sobre la media. Esta proporciona una idea 
sobre si las desviaciones de la media son positivas o negativas. Una asimetría 
positiva implica que hay más valores distintos a la derecha de la media. 
La documentación para el plugin Moment Calculator explica cómo interpretar los 
momentos espaciales.  
Utiliza el encabezado Skew. 

Kurtosis Las medidas de curtosis tratan de estudiar la proporción de la varianza que se 
explica por la combinación de datos extremos respecto a la media en 
contraposición con datos poco alejados de la misma. Una mayor curtosis implica 
una mayor concentración de datos muy cerca de la media de la distribución 
coexistiendo al mismo tiempo con una relativamente elevada frecuencia de datos 
muy alejados de la misma. Esto explica una forma de la distribución de 
frecuencias con colas muy elevadas y con un centro muy apuntado (grado de 
esbeltez de las distribuciones, como por ejemplo en un histograma).  
Además es el cuarto momento estándar sobre la media..  
Utiliza el encabezado Kurt. 

Area fraction Para las imágenes umbralizadas es el porcentaje de pixeles en la imagen o 
selección que se han resaltado en rojo empleando Image/Adjust/Threshold.  
Para las imágenes no umbralizadas es el porcentaje de píxeles que no son cero 
Utiliza el encabezado %Area. 

Stack position La posición (slice, canal y frame) en la pila o hyperstack de la selección.  
Utiliza los encabezados Slice, Ch y Frame.  
n.b.: Para las selecciones de línea, el encabezado Length se crea.  
Para selecciones en línea recta, Angle se graba incluso si Fit Ellipse no está 
marcado. Además, tenga en cuenta que las mediciones que no se aplican a ciertos 
tipos de selección pueden enumerarse como NaN, Infinity o  − Infinity. 
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La segunda parte del cuadro de diálogo controla el escenario de mediciones:  

Limit to threshold Sólo los píxeles umbralizados son incluidos en los cálculos de la  
medida. Utilizando la opción Image/ Adjust/ Threshold se fijan los límites del 
umbral.  
Este escenario afecta solamente imágenes umbralizadas 

Display label El nombre de la imagen y el número de la lasca (para las pilas) se  
muestran en la primera columna de la Tabla de Resultados.  
A través de la opción Edit/ Selection/ Properties se pueden renombrar las 
selecciones, así como ajustar el color y el ancho de la línea de selección. 

Invert Y coordinates Si está marcado, se supone que el origen XY es la esquina inferior izquierda de la 
ventana de la imagen en lugar de la esquina superior izquierda  

Scientific notation Si se comprueba, las mediciones se muestran en notación científica, por ejemplo, 
1.48E2. 

Add to Overlay Si se marca, los ROI medidos se agregan automáticamente a la superposición de 
imágenes. Cada selección medida se desplegará acompañada con una etiqueta 
numérica, coincidente con su fila en la Tabla de Resultados. Los colores de la línea 
de selección, fondo y primer plano pueden cambiarse mediante la opción Edit/  
Options/ Colors 

Redirect to La imagen seleccionada de este menú emergente se utilizará como objetivo para 
los cálculos estadísticos realizados por los comandos Analyze▷Measure… [m] 
y Analyze▷Analyze Particles… 
Esta función le permite delinear una estructura en una imagen y medir la 
intensidad de la región correspondiente en otra imagen. 

Decimal places Éste es el número de dígitos a la derecha del punto decimal en los números reales 
desplegado en la Tabla de Resultados y en las ventanas del Histograma 

Fijar Escala: Esta opción es la encargada de definir la escala espacial de la imagen activa a tal punto 
que pueden presentarse los resultados de las mediciones en unidades calibradas, como son mm o 
µm. 

En caso de tener una imagen que presente una recta con una escala, antes de usar este comando, es 
necesario utilizar la herramienta de selección de línea recta para trazar una línea sobre la recta de la 
escala de la imagen. Es necesario cerciorarse que la línea trazada sea del mismo largo que la recta de 
la escala.  

Finalmente se convierte la línea trazada en un dibujo (Edit/Draw) o de forma equivalente mediante 
Ctrl+D. Quedará entonces dibujada una línea negra que será tomada como la escala (Analyze/Set 
Scale). Entonces en la ventana de Fijar Escala, se introduce la distancia conocida y la unidad de 
medida. Luego se activa la opción Global, para que la magnificación seleccionada se asigne a todas 
las imágenes abiertas hasta que Fiji se cierre, y se presiona OK. Pero si se tiene una imagen sin escala 
Fiji rellenará automáticamente la Distancia en Pixeles basado en el campo de la longitud de la 
selección de la línea. 

 

Figura. Ventana para fijar la escala 

La Relación de Aspecto del Pixel para un valor distinto de 1.0 habilita el apoyo para las diferentes 
escalas espaciales horizontales y verticales, por ejemplo, 100píxeles/cm horizontalmente y 
95píxeles/cm verticalmente. Para poner la Relación de Aspecto del Pixel: 
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1- Medir la anchura y altura (en pixeles) de un objeto digitalizado con una relación de aspecto 
conocida 1:1. 

2- Entre el ancho medido (en píxeles) en la Distancia en los Pixeles. Entre la anchura conocida 
en La Distancia conocida.  

3- Calcular la relación de aspecto dividiendo la anchura por la altura e introduzca este valor en 
la Proporción de Aspecto del Píxel. 

Para restablecer los valores del campo de la Distancia en Píxeles y la Distancia Conocida a cero, y la 
Unidad de Longitud a píxel se utiliza la opción de Remover Escala. 

Variables texturales: Así mismo se calcularon las variables de segundo orden a partir de las 
matrices de co-ocurrencia del nivel de gris (GLCM), que se construyen a partir del análisis de parejas 
de píxeles para una distancia y orientaciones dadas entre ellos. Se define la matriz Co-ocurrente 
como aquella que establece la relación entre cada pixel con otro pixel de su entorno a una distancia 
determinada. Este cálculo conocido por sus siglas en inglés GLCM (Gray Level Co-occurrence Matrix) 
se emplea para mejorar los resultados obtenidos de los descriptores de primer orden utilizando para 
ello la información de la posición relativa de los pixeles de la imagen. El gasto computacional es un 
poco superior al necesario por los descriptores de primer orden.  

La matriz de co-ocurrencia es una técnica muy utilizada debido a que permite extraer información 
estadística gracias a la distribución de pares de pixeles en una imagen. Para calcular la matriz de co-
ocurrencia se debe de definir una distancia y una dirección, además de los pares de pixel separados 
esa distancia.  

A partir de la matriz de co-ocurrencia se pueden calcular una serie de parámetros como por ejemplo 
la entropía y el contraste. El contraste se puede definir como la diferencia que existe entre los valores 
de nivel de gris de diferentes objetos en una imagen. La entropía hace referencia a la homogeneidad 
de la distribución de los pixeles, por tanto, si la distribución de los pixeles es al azar se tendrá un 
valor mayor de entropía. En otras palabras, la entropía mide la cantidad de desorden que hay en una 
imagen [50]. 

• Energía (ASM, Angular Second Moment), da   una   idea   de   la suavidad  de  la  textura y es una 
medida de la homogeneidad local de una imagen. Presenta altos valores cuando la frecuencia de 
aparición de las parejas de pixeles en la matriz de co-ocurrencia tiene la misma intensidad de nivel 
de gris. A mayor ASM, mayor uniformidad (menos variación en los niveles de gris), si la ASM es 1, 
la imagen es completamente uniforme. 

• Contraste (CON, Contrast), es una medida de la variación local del nivel de gris. Aumenta a medida 
que el nivel de gris de la pareja de pixeles se aleja hacia los extremos de la escala en una imagen 
de 8 bits. [51]. Cuanto mayor es la variación de los tonos de gris, mayor es el contraste. Si el 
contraste es 0, los niveles de gris son constantes a lo largo de la imagen 

• Correlación (COR, Correlation), es una medida  de  la probabilidad    que    mide    la    relación    
entre    las diferentes  intensidades  presentes  en  el  entorno definido en la matriz de coocurrencia, 
determina la dependencia lineal de los tonos de gris en la imagen. Si la correlación es 0, no existe 
correlación lineal entre los niveles de gris. 

• Homogeneidad (IDM, Inverse Difference Moment), proporciona información sobre la regularidad 
local de la textura, es una medida de la diferencia en la intensidad de gris entre pixeles vecinos. La 
IDM aumenta cuando el contraste entre las parejas de píxeles desciende. Es opuesta al contraste, 
y al ser una relación inversa, si hubiese una única intensidad de gris en los pixeles de la imagen, el 
valor de la homogeneidad sería 1 y la imagen tendría un bajo contraste. 

• Entropía (ENT, Entropy), es una propiedad que está relacionada con el orden o desorden que tiene 
una imagen y es usada para caracterizar la textura de las imágenes. Es una medida de la 
complejidad de la imagen, a mayor entropía mayor complejidad. La entropía puede tener un valor 
de cero cuando todos los pixeles de la imagen presenten un solo nivel de gris 

En Tamura et al. [52], se introducen seis características de textura que aprovechan a la percepción 
visual humana: rigurosidad, aspereza, contraste, direccionalidad, linealidad y regularidad. La 
efectividad de estas características visuales ha sido demostrada en Francesco et al. [53], ayudando a 
los clasificadores a alcanzar tasas de acierto de hasta 97 % sobre imágenes histopatológicas.  
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Por desgracia en ImageJ aun no tenemos un pluing para medir estas catacterísitcas pero si podemos 
hacerlo con Knimer con la imagen segmentada y etiquetada. 

Extracción de características con ImageJ 

Las imágenes RGB se convirtieron a 8-bits y se analizaron mediante el algoritmo de la Matriz de Co-
ocurrencia en escala de grises (GLCM, Gray Level Co-Ocurrence Matrix) para determinar las 
características de textura superficial a partir de imágenes en escala de grises. Este algoritmo es de 
segundo orden y considera la relación entre parejas de pixeles. Se evaluaron los siguientes cuatro 
parámetros texturales, de los catorce que se puede obtener según Ranjit [54]. 

Fii ImageJ permite usar el plugins  GLCM_Texture [55], que calcula varios de los parámetros de 
textura descritos por Haralick (Haralick, R.M., Shanmugam, K., y Dinstein, I. (1973). Parámetros de 
textura para la clasificación de imágenes, IEEE Trans SMC 3, 610-621). El único parámetro calculado 
de manera diferente es "Correlación", que ahora se calcula según lo descrito por Walker y 
colaboradores [56]. Se debe tener en cuenta que los cálculos realizados en este plugin están 
normalizados por área: dos ROI de diferente tamaño, pero la misma textura darán como resultado 
resultados similares para sus parámetros de textura.  

Por ahora, solo calcula los ROI cuadrados. Incluso cuando funciona con ROI multiforma, siempre 
calcula una región cuadrada basada en esos ROI. 

 
Figura Parámetros texturales extraídos con el ImageJ 

Angular Second 
Moment ASM 

Da   una   idea   de   la suavidad de la textura  
A mayor ASM, mayor uniformidad (menos variación en los niveles de gris), si la ASM es 
1, la imagen es completamente uniforme 

Contrast Medida de la variación local del nivel de gris 
Cuanto mayor es la variación de los tonos de gris, mayor es el contraste. Si el contraste 
es 0, los niveles de gris son constantes a lo largo de la imagen 

Correlation Es una medida de la probabilidad    que    mide    la    relación    entre    las diferentes 
intensidades   
Si la correlación es 0, no existe correlación lineal entre los niveles de gris 

Inverse 
Difference 
Moment 

Proporciona información sobre la regularidad local de la textura, aumenta cuando el 
contraste entre las parejas de píxeles desciende. Es opuesta al contraste, y al ser una 
relación inversa, si hubiese una única intensidad de gris en los pixeles de la imagen, el 
valor de la homogeneidad sería 1 y la imagen tendría un bajo contraste 

Entropy Es una propiedad que está relacionada con el orden o desorden que tiene una imagen  
Es una medida de la complejidad de la imagen,  
Puede tener un valor de cero cuando todos los pixeles de la imagen presenten un solo 
nivel de gris 
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1. Selección de superpixel 

 

roiManager("Select", 17); 

2. Descriptores de primer orden 

 

 

roiManager("Measure
"); 

3. Descriptores de textura de segundo orden 

 

 

> run(“8-bit”); 

run("GLCM 
Texture", 
"enter=1 
select=[0 
degrees] angular 
contrast 
correlation 
inverse 
entropy"); 

 

Asignación de clases 

En este paso se creó y asignó la variable clase (tumor, no-tumor o fondo) a cada vector de 
características (superpixel). Pensamos en tres regiones: 

1. región heterogénea, aquella que selecciona el tumor 
2. región homogénea o fondo 
3. región mixta, dentro del cerebro 
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La opción “etiquetado o Label” etiqueta el área seleccionada con el número de la medición que se 
está realizando, es decir, el número que aparece en las filas dentro de la Tabla de Resultados; por 
tanto para que las selecciones sean etiquetadas se necesita que hayan sido analizadas previamente, 
ya sea mediante Mediciones. 

Una vez se asignaron las clases a todos los superpixeles, estas fueron añadidas como una nueva 
variable al vector de características dejando listo el dataset para la fase de clasificación. 
 

– Clasificación de imágenes 

Esta etapa consistió en la construcción y comparación de modelos de clasificación supervisada, de 
los cuales se eligió el mejor para luego emplearse en la segmentación de las imágenes. 

WEKA (Waikato Environment for Knowledge Analysis) es una herramienta utilizada con mucha 
frecuencia en proyectos relacionados con la minería de datos. Esta herramienta ha sido diseñada por 
un grupo de desarrolladores de la universidad de Waikato en Nueva Zelanda, y se distribuye bajo 
licencia GNU, es decir que es posible modificar el código fuente para adicionar nuevas 
funcionalidades [57]. La herramienta WEKA permite realizar tareas de clasificación, regresión, 
clustering, asociación y visualización. Una de las características más atractivas es su capacidad de 
extensibilidad, es decir, que añadir nuevas funcionalidades es una tarea sencilla [58]. 

El Trainable Weka Segmentation es un plugin de Fiji que combina una colección de algoritmos de 
autoaprendizaje con un conjunto de características seleccionadas de imágenes para producir una 
segmentación basada en píxeles. Weka puede ser llama a sí mismo desde el plugin. Contiene una 
colección de herramientas de visualización y algoritmos para el análisis de datos y modelado 
predictivo, junto a una interfaz gráfica para un fácil acceso a esta funcionalidad.Por defecto, el plugin 
comienza con dos clases, i.e. producirá una clasificación binaria de píxeles. El usuario puede añadir 
trazas de ambas clases utilizando el conjunto completo de herramientas para dibujo de ROI (Region 
Of Interest) disponible en Fiji.  

Esto incluye las selecciones rectangulares, circulares, ovaladas, elípticas y selección libre. Por defecto, 
la herramienta de selección libre (de 1 píxel de ancho) es automáticamente seleccionada. 

El usuario puede desplazar, hacer zoom para aumentar o disminuir, o moverse entre las imágenes (si 
la imagen de entrada es una pila) en el lienzo principal como si se tratara de cualquier otra ventana 
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Fiji. En la parte izquierda del lienzo hay dos paneles de botones, uno para el entrenamiento y otro 
para las opciones generales. En la parte derecha del lienzo de la imagen tenemos un panel con la lista 
de trazas para cada clase y un panel para añadir la ROI actual a esa clase específica. Todos los botones 
incluyen una explicación corta de su funcionalidad que es mostrada cuando el cursor permanece 
encima de alguno de ellos. 

 
Figura . Trainable Weka Segmentation 

Interfaz gráfica de usuario 

Trainable Weka Segmentation funciona con cualquier imagen 2D o pila de imágenes 2D (de cualquier 
tipo). 

Por defecto, el plugin comienza con dos clases, i.e. producirá una clasificación binaria de píxeles. El 
usuario puede añadir trazas de ambas clases utilizando el conjunto completo de herramientas para 
dibujo de ROI (Region Of Interest) disponible en Fiji. Esto incluye las selecciones rectangulares, 
circulares, ovaladas, elípticas y selección libre. Por defecto, la herramienta de selección libre (de 1 
píxel de ancho) es automáticamente seleccionada. 

El usuario puede desplazar, hacer zoom para aumentar o disminuir, o moverse entre las imágenes (si 
la imagen de entrada es una pila) en el lienzo principal como si se tratara de cualquier otra ventana 
Fiji. En la parte izquierda del lienzo hay dos paneles de botones, uno para el entrenamiento y otro 
para las opciones generales. En la parte derecha del lienzo de la imagen tenemos un panel con la lista 
de trazas para cada clase y un panel para añadir la ROI actual a esa clase específica. Todos los botones 
incluyen una explicación corta de su funcionalidad que es mostrada cuando el cursor permanece 
encima de alguno de ellos. 

Panel de entrenamiento 

• “Train classifier”: Este botón activa el proceso de entrenamiento. Una traza para cada una de las 
dos clases es el requisito mínimo para comenzar el entrenamiento. La primera vez que este botón 
es presionado, las características de la imagen de entrada serán extraídas y convertidas en un 
conjunto de vectores de valores flotantes, que es el formato que los clasificadores de Weka 
esperan. Este paso puede tomar algo de tiempo dependiendo del tamaño de las imágenes, el 
número de características y el número de núcleos de la máquina donde Fiji está corriendo. El 
cálculo de características es realizado completamente en forma de multi-hilos (multiproceso). 
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Las características serán calculadas sólo la primera vez que entrenemos después de haber 
arrancado el plugin o después de haber modificado alguna de las opciones de las características. 
Si el entrenamiento termina correctamente, entonces la imagen mostrada estará completamente 
segmentada y el resultado será superpuesto con los correspondientes colores asociados a cada 
clase. Ahora todos los botones están disponibles, ya que todas sus funcionalidades son posibles 
después del entrenamiento. Durante el entrenamiento, este botón mostrará la etiqueta “STOP”. 
Clicando en él, todo el proceso de entrenamiento será interrumpido y se reseteará el plugin al 
estado previo al entrenamiento. 

• “Toggle Overlay”: Este botón activa y desactiva la superposición de la imagen resultado. La 
transparencia de la imagen superpuesta puede ser ajustada en el diálogo de Opciones. 

• “Create Result”: Crea y muestra la imagen resultado. Esta imagen es equivalente a la imagen 
superpuesta (color de 8 bits con los mismos colores que las clases para la clasificación). Cada 
píxel es establecido al valor de índice de la clase más probable (0, 1, 2…). 

• “Get Probability”: Basado en el clasificador actual, la probabilidad que cada píxel tiene de 
pertenecer a cada clase es mostrada en una hyperstack de 32 bits. 

• “Plot Result”: Este botón llama al código de Weka para generar el gráfico del rendimiento del 
modelo, i.e., las curvas basadas en los datos de entrenamiento. Estas curvas permiten visualizar 
la actuación del clasificador basado en los diferentes umbrales que pueden ser aplicados a los 
mapas de probabilidad. 

Panel de opciones 

• “Apply classifier”: Clicando en este botón podemos aplicar el clasificador actual a cualquier 
imagen 2D o pila de imágenes que tengamos en nuestro sistema de ficheros. Aparecerán dos 
cuadros de diálogo para, primero, preguntar al usuario la imagen o pila de imágenes de entrada 
y, segundo, para preguntar si los resultados se mostrarán como un mapa de probabilidades o 
como una segmentación (clases finales)1. Después el plugin llevará a cabo la segmentación de 
imágenes basándose en el clasificador actual y, consecuentemente, las características 
seleccionadas. Esto puede llevar un tiempo dependiendo en el número y tamaño de las imágenes 
de entrada y el número de núcleos de la máquina. Después de terminar, la imagen o pila de 
entrada y su correspondiente segmentación será mostrada. 

•  “Load classifier”: Aquí se puede cargar cualquier clasificador guardado anteriormente. El plugin 
comprobará y ajustará las características seleccionadas con los atributos de este nuevo 
clasificador. El formato de archivo del clasificador es el usado en Weka (.model). 

• “Save classifier”: Guarda el clasificador actual en un fichero, bajo el formato estándar de Weka 
(.model). Esto nos permite almacenar clasificadores y aplicarlos después en diferentes sesiones 
(opción no disponible en el plugin simple Trainable Segmentation). 

• “Load data”: Aquí podemos cargar los datos (en formato Weka) de trazos previos en la misma u 
otra imagen o pila. De nuevo, el plugin comprobará y forzará la consistencia entre los datos 
cargados y la imagen actual, características y clases. El formato del archivo de entrada es el 
formato estándar Weka: ARFF. Los trazos (regiones de interés seleccionadas por el usuario) no 
se guardan, sino sus vectores de características correspondientes. 

• “Save data”: Con este botón podemos guardar los trazos de información actuales en un archivo 
de datos que podemos manejar después con el plugin. El plugin guardará los vectores 
característicos derivados de los píxeles pertenecientes a cada trazo en un archivo ARFF en una 
localización elegida por el usuario. 

• “Create new class”: El número por defecto de clases en el plugin es dos, pero a través de este 
botón podemos incrementarlo hasta 5 clases. El nombre de las nuevas clases puede ser 
modificado en el diálogo “Settings” 

  

 
1 Para convertir un mapa de probabilidades en una segmentación, se puede utilizar el siguiente Beanshell scrip 

de github: Convert-TWS-probabilities-to-segmentation.bsh  
(https://gist.github.com/iarganda/c7fc0a88b8d2737c9d3d) 
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Opciones 

El resto de parámetros ajustables del plugin pueden ser cambiados en el diálogo “Settings”, el cual es 
mostrado cuando se presiona este botón. 

• “Training features”: Aquí podemos seleccionar y deseleccionar las características de 
entrenamiento, que son la clave del procedimiento de aprendizaje. El plugin crea una pila de 
imágenes (una imagen para cada característica). Por ejemplo, si solo es seleccionado “Gaussian 
blur” como característica, el clasificador será entrenado en la imagen original y algunas versiones 
desenfocadas de ésta con un parámetro diferente de sigma para la Gaussiana. El valor de mínimo 
de sigma por defecto es 1, y su valor máximo por defecto es 16, y por lo tanto 𝑛 = 5. 

Si la imagen de entrada está en escala de grises, las características serán calculadas usando doble 
precisión (imágenes de 32 bits). En el caso de que la entrada sean imágenes RGB, las características 
serán RGB también. 

Las diferentes características disponibles son: 

• “Gaussian blur”: realiza n convoluciones individuales con kernels Gaussianos con las normales n 
variaciones de 𝜎 (𝑠𝑖𝑔𝑚𝑎). Cuanto más grande sea el radio, más borrosa (más desenfocada) se 
hará la imagen hasta que los píxeles sean homogéneos. 

• “Sobel filter”: calcula el gradiente en cada píxel. 

• “Hessian”: calcula la matriz Hessiana en cada píxel. Antes de la aplicación de ningún filtro, un 
“Gaussian blur” con sigma variante es realizado. Las características finales usadas para la 
clasificación de píxeles, dada la matriz hessiana son: módulo, traza, determinante, primer 
autovalor, segundo autovalor, orientación o ángulo devuelto en radianes en el rango; diferencia 
autovalores normalizados de gamma al cuadrado, y cuadrado de la diferencia de los autovalores 
normalizados de gamma. 

• “Diferencia de gaussianas”: calcula dos imágenes Gaussian blur a partir de la imagen original y 
resta una de la otra 

• “Membrane projections”: el kernel inicial para esta operación está codificado (hardcored) como 
una matriz cero 19x19 con la columna central rellena de 1s. Múltiples kernels son creados 
mediante la rotación del kernel original mediante 6 grados hasta una rotación total de 180 
grados, dando 30 kernels. Cada kernel es convolucionado con la imagen y después el conjunto de 
30 imágenes son Zproyectadas en una única imagen mediante 6 métodos: o suma de los píxeles 
en cada imagen, media de los píxeles en cada imagen, desviación estándar de los píxeles en cada 
imagen, mediana de los píxeles en cada imagen, máximo de los píxeles en cada imagen, mínimo 
de los píxeles en cada imagen. Cada una de las 6 imágenes resultantes es una característica. Por 
lo tanto los píxeles en líneas de píxeles de similar valor en la imagen que son diferentes de la 
intensidad media de la imagen serán resaltados en las Z-proyecciones. 

• “Mean, Variance, Median, Minimum, Maximum”: los pixeles dentro de un radio de sigma píxeles 
desde el píxel objetivo son sometidos a la operación pertinente (mean/min, etc.) y el píxel 
objetivo se ajusta a ese valor. 

• “Anisotropic diffusion”: el filtro de difusión anisótropo de Fiji con 20 iteraciones, 𝜎 suavizados 
por iteración, 𝑎1 = 0.10, 0.35, 𝑎2 = 0.9, y un umbral de borde fijado al tamaño de la membrana. 

• “Bilateral filter”: es muy similar al filtro de Media, pero preserva mejor los bordes 
promediando/desenfocando otras partes de la imagen. El filtro logra esta tarea únicamente 
promediando los valores alrededor del píxel actual que está más cercano en valor de color al píxel 
actual. La “cercanía” de otra vecindad de píxeles al píxel actual es determinada por el umbral 
específico, i.e., para un valor de 10 cada píxel que contribuye a la media actual tiene que estar 
entre 10 valores del píxel actual. En nuestro caso, combinamos radios espaciales de 5 y 10, con 
un rango del radio de 50 y 100.  

• “Lipschitz filter”: del plugin de Mikulas Stencel. Este plugin implementa la envolvente (cover) de 
Lipschitz de una imagen que es equivalente a una abertura en escala de grises por un cono. La 
envolvente de Lipschitz puede ser aplicada para la eliminación de una imagen de fondo que varía 
lentamente mediante la sustracción de la envolvente de Lipschitz más baja (un procedimiento 



Informe de Avance y/o Final 2020 Anexo 02 CCUTIME0005279TC 

 

CESARI Matilde Inés 30 
 

tophat). Se usa un algoritmo de doble escaneado secuencial. Usamos una combinación de down 
y tophats, con inclinación (slope) 𝑠 = 5, 10, 15, 20, 25. 

• “Kuwahara filter”: otro filtro de reducción de ruido que preserva bordes. Esta es una versión del 
filtro Kuwahara que usa kernels lineales en lugar de cuadráticos. Utilizamos el tamaño del parche 
de membrana (membrane patch) como tamaño del kernel, 30 ángulos y los tres criterios 
diferentes (𝑉𝑎𝑟𝑖𝑎𝑛𝑧𝑎, 𝑉𝑎𝑟𝑖𝑎𝑛𝑧𝑎/𝑀𝑒𝑑𝑖𝑎 𝑦 𝑉𝑎𝑟𝑖𝑎𝑛𝑧𝑎/𝑀𝑒𝑑𝑖𝑎^2). 

• “Gabor filter”: por el momento esta opción puede tomar algo de tiempo y memoria porque genera 
un rango de filtros de Gabor muy diversos (22). Esto puede sufrir cambios en el futuro. El filtro 
Gabor es un filtro de detección de bordes, que convoluciona varios kernels en diferentes ángulos 
con la imagen. Los filtros Gabor son filtros pasos de banda y por lo tanto implementan una 
transformación en frecuencia. 

• “Derivatives filters”: calcula las derivadas de mayor orden de la imagen de entrada, usando 
FeatureJ 

• “Laplacian filter”: computa el Laplaciano de la imagen de entrada usando FeatureJ. Utiliza una 
escala de suavizado 𝜎. 

• “Structure filter”: calcula, para todos los elementos de la imagen de entrada, los autovalores 
(mayores y menores) de la llamada tensor estructura usando FeatureJ. Se utiliza una escala de 
suavizado 𝜎 y una escala de integración 1 y 3. 

• “Entropy”: dibuja un círculo de radio r alrededor de cada píxel; consigue el histograma de ese 
círculo dividido en numBins pedazos; después calcula la entropía. 

• “Neighbors”: cambia la imagen en 8 direcciones por un cierto número de píxeles, que es 𝜎. Por lo 
tanto crea 8𝑛 imágenes de características. 

Cuando se usan imágenes en escala de grises, la imagen de entrada será también como una 
característica. En el caso de imágenes en color (RGB), el Tono, Saturación y Brillo serán así parte de 
las características. La implementación detallada de los filtros puede verse en el código fuente. 

Opciones de características: 

• “Membrane thickness”: valor esperado del espesor de la membrana, 1 píxel por defecto. Cuanto 
más preciso sea, más precisión se conseguirá en el filtro. 

• “Membrane patch size”: esto representa el tamaño NxN del campo de visión para los filtros de 
proyección de la membrana. 

• “Minimum sigma”: radio mínimo de los filtros usados para crear las características. Por defecto 1 
píxel. 

• “Maximum sigma”: radio máximo de los filtros usados para crear las características. Por defecto 
16 píxeles. 

 

CONCLUSIONES 

Teniendo en cuenta la importancia de las imágenes en el sector salud, disponer un software que 
facilite la implementación de la minería de imágenes puede ayudar a mejorar la efectividad de los 
diagnósticos tempranos y a evitar remisiones innecesarias de pacientes 

Mediante un conjunto de experimentos en Fiji ImageJ, se demuestra que no existen deficiencias en la 
calidad de los algoritmos que ofrece el programa, a pesar de que se requiere en ImageJ la creación de 
plugins que faciliten y mejoren el trabajo en estos temas. Esta herramienta permite mediante el 
análisis cuantitativo de las imágenes DICOM (Digital Imaging and Communication in Medicine), de 
manera más simple la delimitación de las regiones de interés, con el objetivo de hacer una 
comparación de los resultados obtenidos de manera cuantitativa. 

Las Tablas de colores LUT’s son una herramienta muy útil para previsualización y segmentado de 
imágenes que no requieren modificar la imagen simplemente es como poner un filtro sobre la imagen 
para detectar segmentos de la mismas que permitan al observador identificar anomalías que no se 
ven a simple vista en la imagen original 
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Reconocimiento de tejidos en imágenes de resonancia magnética de 
cerebro a través de modelo basado en reglas borrosas 

 

1. INTRODUCCIÓN 

La principal ventaja de las imágenes de Resonancia Magnética (RM) es la discriminación de 
diferentes tipos de sustancias para una posterior cuantificación de las mismas y de esta manera 
asistir en el diagnóstico de diferentes patologías. La segmentación de este tipo de imágenes es un 
requerimiento constante en Medicina. Continuamente se proponen nuevas técnicas para lograr 
objetivos similares, cada una de ellas con sus ventajas y limitaciones.  

En general podría afirmarse que los diferentes métodos tienen en común el reconocimiento de 
diferentes sustancias presentes en el cuerpo mediante la interpretación de las imágenes que el 
equipo resonador entrega. Algunos métodos se basan en reconocimiento de patrones [1;2;3;4;5; 
6;7;8], tomando intensidades de gris o agregando información espacial como en el enfoque del 
análisis de las texturas presentes.  

Otros métodos se basan en procesos de diferentes dificultades, como simples umbralamientos, 
modelos deformables [9], métodos estadísticos [10;11;12], crecimiento de regiones y combinaciones 
de todos ellos [13; 14]. Se han aplicado también métodos que provienen de otras disciplinas, como el 
descubrimiento del conocimiento, para objetivos más específicos, como es la discriminación de 
diferentes tipos de patologías [15]. Otros paradigmas aprovechan la capacidad de discriminación de 
las Redes Neuronales con el fin de la clasificación de los píxeles según sus características (16;17; 18; 
19; 20) y la potencia de los sistemas basados en agentes para segmentaciones automáticas 
[21;22;23]. 

Una de las dificultades que se presenta en las imágenes de Resonancia Magnética es que hay un gran 
solapamiento entre las intensidades de gris que presentan diferentes sustancias. Es por eso que un 
enfoque con técnicas que trabajen con la modelización de la vaguedad parece ser adecuadas, como 
es el caso de la que se propone en este trabajo. En este sentido, la Lógica Borrosa ofrece un esquema 
de trabajo adecuado y ha sido empleada en este contexto [24;25;26], conjugando la ventaja de 
implementar conceptos inciertos con la posibilidad de manejar sentencias en lenguaje natural.  

Tradicionalmente, las tres características de bajo nivel más usadas para el análisis automático de 
imágenes son el color, la forma y la textura. Las dos primeras representan conceptos muy claros para 
el ser humano, siendo conocida su importancia en el análisis de imagen. La textura, sin embargo, es 
una característica más intuitiva y abstracta, aunque no por ello menos importante. El tipo de textura 
tratado en el ámbito de la visión por computador es el conocido como textura visual, que debe ser 
diferenciado del de textura táctil (aquella que se percibe al tocar la superficie de los objetos, 
produciendo así sensaciones como suavidad, dureza o rugosidad, entre otras). El análisis de textura 
visual es una de las ramas más importantes del campo de la visión por computador, pues todos los 
objetos tienen textura, siendo un factor fundamental para su reconocimiento y clasificación [27]. 

El análisis de textura es aplicado en numerosos problemas de clasificación y segmentación, entre los 
que se encuentran la detección de defectos en superficies en el campo industrial, la inspección de 
imágenes biomédicas, la segmentación y clasificación de imágenes por satélite, la segmentación de 
regiones en el análisis de documentos, o la recuperación de imágenes basada en contenido. 

Lo más usual para el ser humano es describir las texturas visuales de acuerdo a ciertas propiedades 
basadas en la percepción, como el grosor/finura, que está relacionado con el tamaño espacial de las 
primitivas de textura, la direccionalidad, que indica si estas primitivas poseen una orientación 
dominante, o la regularidad, que refleja si su disposición es ordenada y repetitiva. Así, por ejemplo, 
podemos describir intuitivamente la textura mostrada en la Figura 1 (a) como una textura gruesa, no 
direccional e irregular, mientras que la textura de la Figura 1(d) podría ser descrita como fina, 
direccional y regular. 
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Figura 1: Ejemplos de texturas [28]. 

Como suele ocurrir cuando el ser humano intenta describir conceptos intrínsecamente abstractos, 
como la textura, existe cierta vaguedad asociada a dichas descripciones, es decir, las propiedades 
utilizadas para ello son imprecisas por propia naturaleza. Esta imprecisión debe ser entendida en el 
sentido de que, en general, no es posible establecer de forma categórica un umbral preciso entre 
texturas que cumplen una propiedad y texturas que no la cumplen. En otras palabras, dada una 
textura, no podemos afirmar con total seguridad si es gruesa o no lo es, o si es regular o no (excepto 
en casos extremos), sino el mayor o menor cumplimiento de estas propiedades en la textura. 

Así, por ejemplo, podemos afirmar que la textura mostrada en la Figura 1(a) es gruesa y que la 
mostrada en la Figura 1(d) no lo es, pues representan casos extremos para la propiedad de grosor. 
Sin embargo, el cumplimiento o no de esta propiedad no está tan claro para las texturas de las figuras 
1(b) y 1(c). Lo mismo sucede con las propiedades de direccionalidad y regularidad: la textura de la 
Figura 1(d) es claramente direccional y regular, mientras que la textura de la Figura 1(a) no lo es. Sin 
embargo, no podemos precisar nada para las otras dos texturas, únicamente el mayor o menor 
cumplimiento de estas propiedades. 

Además de la imprecisión asociada a estas propiedades perceptuales, se debe tener en cuenta que 
cada persona que observa la textura puede tener una percepción particular acerca de dichas 
propiedades. Así, por ejemplo, a diferencia de lo que se acaba de comentar, un usuario concreto puede 
considerar que la textura mostrada en la Figura 1(b) es claramente direccional, o que la textura de la 
Figura 1(a) no es gruesa. Asimismo, el contexto de la imagen puede influir en la percepción global de 
las distintas propiedades. 

Un ejemplo de este fenómeno se puede apreciar en la Figura 2(b), donde se muestra una imagen 
natural similar a la de la Figura 2(a), pero donde se ha añadido una nueva textura. La presencia de 
esta textura, que es mucho más gruesa que el resto, puede llegar a inhibir a las demás, que pueden 
ser percibidas como más finas que en la Figura 2(a). 

Así, aparte de la imprecisión asociada a las propiedades perceptuales, hay que añadir que el mayor o 
menor cumplimiento de estas propiedades en una textura puede ser distinto para diferentes 
usuarios, y además depender del contexto de la imagen. 

La modelación de la vaguedad se logra a través de variables lingüísticas, lo que permite aprovechar 
el conocimiento de los expertos, al contrario de lo que ocurre en otros métodos más cercanos a las 
cajas negras y exclusivamente basados en datos, como son, por ejemplo, las redes neuronales. Se 
puede lograr un sistema que puede ser más fácilmente comprendido y aceptado por los profesionales 
que no dominan las ciencias matemáticas, como es el caso de los médicos, quienes finalmente serán 
los usuarios. 
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Figura 2: Ejemplo en el que se ilustra la influencia del contexto de la imagen en la percepción de la 

propiedad de finura. 

Por otro lado, además de emplear propiedades imprecisas para describir la textura, el ser humano 
suele introducir términos lingüísticos para categorizar dichas propiedades. De esta forma, es común 
el uso de términos como “muy fina”, “fina”, “medio gruesa” o “muy gruesa” para describir la textura 
en base a la propiedad de finura/grosor, o “muy regular”, “regular”, “irregular” o “muy irregular” para 
la propiedad de regularidad. Así, por ejemplo, las texturas mostradas en las figuras 1(a) y 1(d), que 
son casos extremos en cuanto al cumplimiento de las distintas propiedades, podrían ser descritas 
como “muy gruesa” y “muy irregular” la primera, y “muy fina” y “muy regular” la segunda. Las 
texturas de las figuras 1(b) y 1(c) serían descritas con términos más intermedios, acordes al grado 
de cumplimiento de cada propiedad. Asimismo, la interpretación de estos términos (entendida como 
el grado de cumplimiento) puede depender del usuario y/o del contexto. 

En este trabajo se utiliza la Lógica Borrosa para implementar las consideraciones que, implícitamente 
o no, utilizan los expertos cuando interpretan las imágenes multiespectrales de Resonancia 
Magnética. 

Se aborda el problema como uno correspondiente a la disciplina de asistencia en la toma de 
decisiones. En este contexto la decisión a tomar sería a qué sustancia asignar cada píxel de la imagen 
entre las que son factibles de presentarse. Para la implementación de los operadores lógicos borrosos 
se utilizan las operaciones que sugiere la Lógica Compensatoria, que ha demostrado ser muy eficiente 
en este contexto de la toma de decisiones. 

Se ha probado el sistema en imágenes de cerebro, para las que se encuentra gran cantidad de trabajos 
y técnicas desarrolladas específicamente, pero todo hace suponer que la idea no se agota en este tipo 
de imágenes, lo que dará lugar a futuros y prometedores trabajos. 

  

2 MATERIALES Y MÉTODOS 

2.1. Resonancia Magnética 

Las imágenes de Resonancia Magnética se basan en el fenómeno físico de la resonancia magnética 
nuclear. Consiste en medir parámetros que caracterizan la transición entre los estados de núcleos de 
ciertas moléculas con contenido de Hidrógeno (principalmente agua) ante la presencia de un campo 
magnético externo. El retorno del núcleo a su equilibrio se caracteriza con dos tiempos denominados 
T1 y T2, que asociados con la densidad de protones (PD) son característicos de los diferentes tipos 
de tejidos o sustancias. La excitación se lleva a cabo con un pulso de radiofrecuencia (RF) a una 
frecuencia específica y está relacionado con el campo magnético externo. 

Variando el campo magnético de una manera específica se produce un mapa de las ubicaciones 
espaciales de los núcleos y sus densidades. La imagen se logra luego de complejos procesos de 
detección, reconstrucción y transformaciones. 

Las intensidades de la imagen dependen de los parámetros con que se haya configurado el scanner y 
de la secuencia de pulsos de RF. Pueden compararse las intensidades de diferentes imágenes 
solamente si se han mantenido estos parámetros constantes (Storey, 2006). 
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2.2. Lógica Borrosa 

La lógica borrosa es una rama de la inteligencia computacional que se funda en la incertidumbre, lo 
cual permite manejar información vaga o de difícil especificación si se quiere utilizar objetivamente 
esta información con un fin especifico (29;30). Es una herramienta para modelar el conocimiento o 
la comprensión de conceptos. 

La lógica borrosa permite implementar un proceso por medio de predicados que generalmente se 
refieren a cantidades indefinidas o inciertas. Estos predicados pueden obtenerse con sistemas que 
“aprenden” al “procesar” datos reales o pueden también ser formulados por un experto humano o, 
mejor aún, por el consenso entre varios de ellos. 

La flexibilidad de la Lógica Borrosa la hace apropiada para los sistemas de asistencia en la toma de 
decisiones (31;32). Su capacidad para elaborar modelos lingüísticos la hacen muy útil para resolver 
problemas reales y brinda un esquema adecuado para una mejor comunicación con los que deben 
tomar las decisiones y los expertos. 

Se han realizado estudios basados en lógica multivaluada en los que se han presentado diversos 
operadores para las operaciones entre valores de verdad de sentencias (o entre conjuntos borrosos). 
Recientemente se ha propuesto un enfoque para aplicaciones de toma de decisiones con una 
capacidad práctica evidente, denominado Lógica Compensatoria (33;34), que ofrece nuevas 
operaciones para implementar los operadores lógicos conjunción y disyunción, entre otros. 

La Lógica Borrosa Compensatoria, es un sistema lógico que permite la modelación simultánea de los 
procesos deductivos y de toma de decisiones. Su uso en diversas aplicaciones (35;36) ha demostrado 
la capacidad que presenta para tener en cuenta simultáneamente predicados o afirmaciones que 
hasta pueden ser contradictorios. 

En los procesos que requieren toma de decisiones, el intercambio con los expertos lleva a obtener 
formulaciones complejas y sutiles que requieren de predicados compuestos. Los valores de verdad 
obtenidos sobre estos predicados compuestos deben poseer sensibilidad a los cambios de los valores 
de verdad de los predicados básicos. Esta necesidad se satisface con el uso de la Lógica 
Compensatoria, que renuncia al cumplimiento de las propiedades clásicas de la conjunción y la 
disyunción, contraponiendo a éstas la idea de que el aumento o disminución del valor de verdad de 
la conjunción o la disyunción provocadas por el cambio del valor de verdad de una de sus 
componentes, puede ser “compensado” con la correspondiente disminución o aumento de la otra. 

La Lógica Difusa Compensatoria LDC constituye una rama de la Lógica Difusa. Se trata de un nuevo 
sistema multivalente que rompe con la axiomática tradicional de este tipo de sistemas para lograr un 
comportamiento semánticamente mejor a los sistemas clásicos La LDC ha sido utilizada en el sector 
empresarial en diversos países como Alemania, España, Argentina, Brasil y Cuba. Se destacan 
aplicaciones recientes en este ámbito en la selección de proveedores, soluciones clásicas de juegos 
cooperativos n-personales y para determinar la confiabilidad de una empresa en términos 
económicos (37;38). 

La LDC utiliza la escala de la LD, la cual puede variar de 0 a 1 para medir el grado de verdad o falsedad 
de sus proposiciones, donde las proposiciones pueden expresarse mediante predicados (Ver Tabla 
1) 

 
Tabla 1: Valores de Verdad. 
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En los procesos que requieren toma de decisiones, el intercambio con los expertos lleva a obtener 
formulaciones complejas y sutiles que requieren de predicados compuestos. Los valores de verdad 
obtenidos sobre estos predicados compuestos deben poseer sensibilidad a los cambios de los valores 
de verdad de los predicados básicos. 

Esta necesidad se satisface con el uso de la LDC, que renuncia al cumplimiento de las propiedades 
clásicas de la conjunción y la disyunción, contraponiendo a éstas la idea de que el aumento o 
disminución del valor de verdad de la conjunción o la disyunción provocadas por el cambio del valor 
de verdad de una de sus componentes, puede ser “compensado” con la correspondiente disminución 
o aumento de la otra. Esta noción hace que la LDC sea una lógica sensible. Existen casos en los que la 
compensación no es posible. Esto ocurre cuando son violados ciertos umbrales y existe un veto que 
impide la compensación Estas propiedades hacen posible de manera natural el trabajo de traducción 
del lenguaje natural al de la lógica, incluidos los predicados extensos si éstos surgen del proceso de 
modelación.  
Se presentan a continuación los operadores propuestos por la Lógica Compensatoria. 

La operación para la conjunción (“and”) es la media geométrica y está dada por: 

 (1) 

La disyunción (“or”) es el operador dual de la media geométrica, que garantiza el cumplimiento de 
las reglas de De Morgan, y se calcula mediante la siguiente expresión: 

 (2) 

En ambas ecuaciones  corresponde al valor de verdad de los predicados básicos que se 
relacionan mediante los operadores presentados 

Utilizando las definiciones anteriores y la operación de negación (“not”): 

 (3) 

La implicación, con propiedades más deseables, es la implicación de Zadeh generalizada:  

 (4) 

La equivalencia, es definida a partir del operador i como: 

 (5) 

Los modificadores más utilizados son funciones de la forma f(x)=xa donde a es un exponente mayor 
o igual que cero. Suelen utilizarse por ejemplo los exponente 2 y 3 para modelar las palabras muy e 
híper, y el exponentes ½ para modelar las palabras algo y más o menos. 

 

2.3. Lógica Borrosa Compensatoria en procesamiento de imágenes de RM 

Los médicos especialistas en diagnóstico por imágenes suelen explicar la interpretación de las 
imágenes de RM enunciando algunas consideraciones basadas en inspecciones visuales de esas 
imágenes que luego aplican de forma automática. Para explicar cómo reconocer regiones en las que 
se encuentra agua o algún líquido suelen enunciar sentencias del tipo “el líquido se ve negro en T1, 
blanco en T2”. Implícitamente lo que se está explicando es que, cuando se trata de agua, en la 
secuencia T1 se verán regiones “oscuras” y las mismas regiones se verán “claras” en la secuencia T2. 

Se tienen entonces conceptos sencillos de interpretar visualmente, pero no adecuados para la 
implementación computacional con herramientas tradicionales de segmentación. 

Los primeros cuestionamientos que surgen son: ¿qué intensidades de gris presentan las regiones de 
la imagen consideradas “negras” u “oscuras”? ¿Cuáles intensidades representan la idea de “blanco” o 
“brillante”? 

En esta etapa resulta de suma importancia contar con imágenes previamente clasificadas, en lo 
posible por los mismos expertos que enuncian los predicados utilizados para la discriminación de las 
sustancias presentes, con el fin de hacer un análisis cuantitativo de estas ideas. 

En una etapa inicial de este trabajo fue de utilidad, dado un conjunto de imágenes segmentadas 
previamente, la representación con histogramas de las intensidades de gris para las regiones 
reconocidas de las diferentes sustancias. Con estas representaciones puede comprenderse que las 
ideas expresadas, como por ejemplo “negro” o “blanco”, en realidad representan intervalos de 
intensidades de grises a veces con gran diversidad de valores.  
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Esto se debe a la poca sensibilidad del ojo humano para detectar variaciones de intensidad pequeñas. 
Así es como, en el intervalo de valores de 0 a 255, los valores entre 0 y 20 son prácticamente iguales 
y visiblemente “negros” y los valores entre 230 y 255 son prácticamente “blancos”. 

De esta manera, a través de entrevistas con distintos expertos, investigando sobre distintos tipos de 
imágenes, reconociendo diferentes sustancias o tejidos en las imágenes, surgen cada vez más 
descripciones subjetivas, formales e informales, como por ejemplo “gris claro”, “intensidad 
constante”, “zonas brillantes”, “gris”, “gris intenso”, “regiones hipointensas”, “prácticamente negro”, 
“blanco”, “gris oscuro”, y todas sus combinaciones a través de conectivos lógicos. 

La lógica borrosa es un enfoque que suele resolver con éxito este tipo de situaciones, puesto que 
permite utilizar estas ideas expresadas lingüísticamente para efectuar cálculos matemáticos 
objetivos que reflejen el resultado razonado. 

Para formalizar un proceso de cálculo se requiere expresar predicados diferentes para cada sustancia 
que se desea detectar en un determinado tipo de imágenes.  

En especial las imágenes de RM son interesantes para este enfoque por la riqueza de la 
complementariedad de información que presentan las distintas secuencias de adquisición. 

En este trabajo se presenta un análisis de imágenes de RM píxel a píxel en el cual para cada sustancia 
a reconocer se ha definido un predicado que involucra las intensidades presentes en las secuencias 
T1, T2, y eventualmente, de ser necesaria, la secuencia PD en imágenes de cerebros. El objetivo es 
decidir a qué sustancia, dentro de las posibles, corresponde cada píxel de la imagen. Las sustancias a 
reconocer son: líquido cefalorraquídeo (CSF, Cerebro Spinal Fluid), materia gris (GM, Gray Matter), 
materia blanca (WM, White Matter) y se ha agregado un predicado explícito para el fondo. 

Se ha determinado el siguiente conjunto de predicados que describen las sustancias, establecido en 
conjunto con los expertos y expresados lingüísticamente: 

P1: El líquido cefalorraquídeo es Oscuro en T1, MuyIntenso en T2 y MuyIntenso en PD o también 
puede ser Blanco en T2. 

P2: La materia gris es Gris en T1, Intenso en T2 y MuyIntenso pero No-Blanco en PD. 

P3: La materia blanca es Intenso en T1, Gris en T2 e Intenso en PD. 

P4: El fondo es Negro en T1 y Negro en T2. 

Formalizando la expresión lingüística del Predicado 1 se tendrá: 

“el píxel corresponde a CSF” cuando “el píxel es Oscuro en T1” y “el píxel es MuyIntenso o 

Blanco en T2” y “el píxel es MuyIntenso en PD”. 

µA = µB AND (µC OR µD) AND µE 

donde: 

A = “el píxel representa CSF” B = “el píxel es Oscuro en T1” 

C = “el píxel es MuyIntenso en T2” 

D = “el píxel es Blanco en T2” 

E = “el píxel es MuyIntenso en PD” 

µX = grado de verdad de la sentencia X. 

El valor de verdad logrado en cada predicado no debe ser tomado como absoluto, sino que 
intervendrá como resultado parcial en la toma de decisión de la sustancia que se asignará a cada 
píxel. Tal es el uso apropiado de la lógica compensatoria (39;40). 

El procesamiento de la imagen consiste en un análisis de la misma píxel a píxel donde para cada uno 
se toma la decisión de la asignación a alguna de estas sustancias. 

Si un píxel correspondiera en realidad a una sustancia no descripta en los predicados anteriores, 
igualmente sería clasificado o reconocido como de una de ellas, pero en estos casos puede ser factible 
determinar que la clasificación no es demasiado confiable, dado que los valores de verdad hallados 
para todos los predicados serán pequeños, menores a un cierto umbral de tolerancia determinado. 
Debe tenerse presente que se está haciendo una asignación de las sustancias “explicadas” en los 
predicados y que no se busca encontrar nuevo conocimiento o agrupar los píxeles en diferentes 
clases como suele hacerse con la aplicación de otras técnicas. 

Para efectuar la cuantificación de los valores de verdad de los predicados se definieron conjuntos 
difusos sobre el rango de valores de gris (de 0 a 255). 
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Tomando algunas imágenes previamente clasificadas, se armaron vectores de intensidades de grises 
a los que corresponde cada una de las sustancias a detectar. Así se pudo observar los rangos de 
intensidades entre los que se encontraba cada sustancia en cada secuencia (T1, T2 o PD). 

En la Figura 3 pueden verse los histogramas correspondientes a las secuencias T1, T2 y PD para el 
WM (a), GM (b) y CSF (c). Puede concluirse que el CSF se encuentra mayormente en el rango de 
intensidades entre 20 y 60 para la secuencia T1, pero también hay unos pocos píxeles con 
intensidades entre 10 y 20 o entre 60 y 75. 

  

 
Figura 3: Histogramas de frecuencias relativas correspondientes a las intensidades de gris de las 

secuencias T1, T2 and PD correspondientes a sustancia blanca (a), sustancia gris (b) y líquido 
cefalorraquídeo (c). 

De los expertos se tenía el conocimiento de que el CSF se ve “oscuro en T2”, por lo que de este análisis 
surge que el concepto “oscuro” (un conjunto difuso) en este contexto podría ser representado por la 
función de pertenencia que se visualiza en la Figura 4, indicado con la etiqueta “Oscuro”. Así puede 
completarse el análisis para cada conjunto difuso que aparezca en cada uno de los predicados 
enunciados. 
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Figura 4: Funciones de pertenencia para definer los conjuntos difusos “Negro”, “Oscuro”, “Gris”, 

“Intenso”, “MuyIntenso”, y “Blanco”.. 

Las funciones de pertenencia obtenidas se simbolizan mediante: µNEGRO(x) , µOSCURO(x) , µGRIS(x) , 
µINTENSO(x) , µMUY INTENSO(x) , µBLANCO(x) donde x ∈ 0,255 representa el valor de intensidad de gris. 

La función de pertenencia que define el conjunto difuso “Negro” es de tipo “Z”. Esta función requiere 
2 parámetros (a y b) para quedar determinadas su posición y forma: 

 

(6) 

La función que define el conjunto difuso “Blanco” es de tipo “S”, también con 2 parámetros 
requeridos, y su expresión es la siguiente: 

 

(7) 

Las otras funciones de pertenencia son de tipo gaussianas asimétricas. Éstas permiten que en un 
determinado intervalo de grises, los grados de pertenencia tomen el valor máximo y luego 
desciendan en forma suave. Estas funciones requieren 4 parámetros cada una para quedar 
determinadas, e indican los puntos de comienzo de descenso y la velocidad del mismo (2 para el lado 
derecho y 2 para el lado izquierdo). La expresión es la siguiente: 

 

(8) 



Informe de Avance y/o Final 2020 Anexo 03 CCUTIME0005279TC 

 

CESARI Matilde Inés 9 
 
 

Algunas sustancias pueden requerir predicados más complejos para su reconocimiento, lo que no 
implica un problema puesto que la lógica difusa permite operar con cualquier conector lógico o 
implicaciones. El conector más usado en este caso es AND para relacionar lo que presentan las 
imágenes T1, T2 y PD. 

Una vez obtenidas funciones de pertenencia adecuadas, se procede al análisis de la imagen 

píxel a píxel. Dado un píxel con una intensidad x, la primera operación a efectuar es la obtención de 
un valor difuso entre 0 y 1 para cada uno de los conjuntos difusos que se aplicarán (“Gris”, “Intenso”, 
“Negro”, “Blanco”, etc.) mediante las ecuaciones (6), (7) y (8). Luego se debe calcular el valor también 
difuso de las operaciones lógicas realizadas entre los predicados básicos que forman el predicado 
compuesto que describe a cada sustancia. 

Por ejemplo, para asignar un valor de verdad a la expresión “el píxel corresponde a materia blanca” 
(P3) se analizaría el grado de verdad de µ1 = “el píxel es Intenso en T1”, µ2 =“el píxel es Gris en T2” y 
µ3 = “el píxel es Intenso en PD” a través de las funciones de pertenencia. Estos grados de verdad se 
combinarían con la operación AND para lograr un valor final mediante la expresión: 

 (9) 

El procedimiento se repite para cada uno de los predicados correspondientes a las distintas 
sustancias. Finalmente, el píxel se asigna a la sustancia con mayor valor de verdad. 

 

2.4. Implementación del método 

Primeramente, se arreglan en vectores los valores de intensidades de grises de las imágenes a 
analizar, donde cada elemento representa un píxel de la imagen. Luego se calculan los valores de 
pertenencia de todos los píxeles a los diferentes conjuntos difusos que intervienen en los predicados. 
Se efectúan las operaciones lógicas que indican los predicados para cada una de las sustancias para 
determinar su grado de verdad y tomar el mayor de ellos. Finalmente se construye una imagen que 
muestre diferentes colores según la sustancia indicada. 

 

A continuación, se presenta la formalización del método: 

Sea X un vector de dimensión N cuyos elementos son las intensidades de gris de la imagen Y: 

 (10) 

Donde, N representa la cantidad de píxeles a analizar. Por ejemplo, si se trabaja con imágenes de 256 
x 256 píxeles, N = 65536. 

Sean tres vectores: XT1, XT2 and XPD, definidos para representar las imágenes T1, T2 y PD. 

La pertenencia a cada conjunto difuso se calcula como: 

 (11) 

Donde , es la expresión de la función de pertenencia que define el conjunto difuso “fuzzySet” 
y Xy, es el vector de cualquiera de las imágenes consideradas. Se calculan tantos vectores  
(también de dimensión N) como conjuntos difusos se utilicen en los predicados. 

Los valores de verdad de los K predicados, se calculan operando con las pertenencias a los conjuntos 
difusos recién calculadas. Las operaciones serán diferentes, dependiendo de las definiciones de los 
predicados. 

Ejemplo #1: el predicado P1 declara que “El Tejido TEJ1 es Intenso en T1, es Oscuro 
en T2 y es MuyIntenso en PD”.  

Usando Lógica Compensatoria, se calcula la siguiente operación de conjunción (c): 

 

(12) 

Ejemplo #2: el predicado P2 declara que “El Tejido TEJ2 es Gris en T1, es Blanco o MuyIntenso en T2 
y es Intenso en PD”. En este caso se calcula la siguiente operación de conjunción (c) y disyunción (d): 
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(13) 

Finalmente, se construye una nueva matriz A de dimensión NxK con esos vectores. Cada columna 
será un vector de grados de verdad, correspondiendo a los K predicados. 

 (14) 

El objetivo de la matriz A es hallar la columna que contiene el máximo valor, operando fila por fila. El 
índice de la columna que contiene el máximo identifica al tejido que será asignado. Los resultados se 
almacenan en un nuevo vector D, también de N elementos. 

 (15) 

Donde la operación indicada como indiceColMax indica hallar el índice de la columna que contiene el 
valor máximo de cada fila. 

Finalmente, el vector D se reacomoda para construir una matriz del mismo tamaño de la imagen 
original, y contiene la clasificación obtenida. Los valores de esta matriz son los índices que identifican 
los tejidos, siendo estos enteros entre 1 y K. 

Todo el sistema fue implementado en ImageJ. Los operadores de Lógica Compensatoria, fueron 
programados para esta aplicación. En la etapa de prueba se diseñó una interfaz gráfica para testear, 
eligiendo un píxel por un operador: los valores de gris, las pertenencias a los diferentes conjuntos 
difusos y los valores de verdad de los predicados que definen a cada sustancia. Luego se automatizó 
el proceso completo. 

 

2.5. Validación del método 

El método propuesto se evaluó primeramente con imágenes provenientes de la Base de Datos: “Brain 
Tumor Classification (MRI)” [41], obtenido desde el repositorio www.kaggle.com. La resonancia 
magnética proporcionada en este conjunto de datos es una combinación de tipos T1, T2 y PD. 

Esto permitió evaluar la robustez del método en cuanto al ruido y a las no-uniformidades en la 
intensidad, utilizando imágenes con diferentes niveles de ruido y diferentes intensidades de no-
uniformidades 

En todos los casos, las imágenes se pre-procesaron para remover las regiones de tejidos indeseados, 
principalmente el cráneo. 

Para evaluar la calidad de la segmentación obtenida, se empleó el Coeficiente de Tanimoto (TC, 
Tanimoto Coefficient), que tomaría el valor 1 cuando la segmentación lograda coincide totalmente 
con la de referencia, que ha sido ampliamente utilizado en aplicaciones similares a la presente (42; 
43; 44; 45; 46). La definición de este coeficiente es (47;48): 

 

(16) 

donde X es una imagen binaria que contiene los píxeles identificados como del tejido k, Y es una 
imagen binaria de la segmentación de referencia para el tejido k, y nx(k) es la cantidad de pixeles de 
la imagen X que corresponden al tejido k. Este valor se calcula para cada tejido. Cuando la 
segmentación es perfecta, el coeficiente toma el valor 1. 

 

3 RESULTADOS 

Aplicando este método de segmentación basado en predicados con valores de verdad difusos se ha 
logrado discriminar exitosamente la sustancia gris, la sustancia blanca y el fluido cerebroespinal en 
estudios de RM de cerebro. Se probó el método en 

En las Figuras 5a y 5c se muestran como ejemplos imágenes corte coronal, secuencia T2 y en las 
Figuras 5b y 5d se observan los respectivos resultados aplicando el método propuesto con diferentes 
colores para cada tejido detectado. 

http://www.kaggle.com/
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Figura 5: Cortes T2 (a,c) y resultados del reconocimiento de tejidos obtenido (b, d) para sustancia 

blanca (amarillo), sustancia gris (rojo) y líquido cefalorraquídeo (azul). 

Las operaciones involucradas son sencillas, por lo que los tiempos de cálculo son cortos, lo que hace 
el método adecuado para estudios completos en los que se requiere el procesamiento de gran 
cantidad de cortes. 

Los valores obtenidos para el TC en las imágenes simuladas fueron superiores a 0.78 para todas las 
sustancias, aun en las peores condiciones de nivel de ruido y de no-uniformidad en la intensidad, lo 
que permite asegurar en principio que el método funciona aceptablemente y con una gran robustez. 
Cuando se probó el método con imágenes sin distorsiones el TC tomó siempre valores superiores a 
0.94. 

 

4 DISCUSIÓN 

Para esta aplicación específica (imágenes de RM), los predicados que definen los tejidos a reconocer 
podrían involucrar otras características más allá de los niveles de gris en las imágenes. Podrían 
incorporarse características de texturas tales como rugosidad o inclusive nivel de ruido o cualquiera 
que pueda ser cuantificable. 

A través del cálculo del TC se aseguró la robustez del método. Los valores del TC son inclusive muy 
buenos en presencia de ruido o no-uniformidades en la intensidad. 

Dada la simplicidad de las operaciones involucradas, el sistema puede ser programado en cualquier 
lenguaje sin necesidad de motores de cálculo ni cualquier otra librería específica. 

Cualquier lenguaje que manipule eficientemente vectores y matrices será adecuado. En esta etapa 
aún no se ha optimizado el código. Sin embargo, sólo con compilarlo en un lenguaje de más bajo nivel 
que Java se lograría una apreciable reducción de los tiempos de procesamiento. Tampoco se debiera 
despreciar la posibilidad de implementarlo en hardware de manera de obtener una herramienta en 
tiempo real. 

La segmentación de las imágenes de RM es muy útil tanto para mejorar los informes de rutina como 
para poder discernir entre valores normales y patológicos de las diferentes estructuras presentes. 

Como trabajo futuro se proponen dos líneas específicas: la optimización de los parámetros de las 
funciones de pertenencia mediante algoritmos genéticos, utilizando también lógica compensatoria 
para su función de evaluación y la incorporación de modificadores a los conjuntos difusos (“muy”, 
“poco”, “algo”) que definen los predicados. Estas contribuciones mejorarían la exactitud del sistema 
(TC aún más cercanos a 1). Ya se han realizado algunos avances en ese sentido que se encuentran en 
etapa de prueba y se han obtenido resultados preliminares alentadores. 

Un post-procesamiento adicional podría considerar aisladamente los píxeles que tienen como 
resultado del grado de verdad de todos los predicados valores inferiores a 0.5. En este caso podría 
tratarse de sustancias no indicadas en los predicados y estos píxeles deberían rotularse como tales. 
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5 CONCLUSIONES 

Este trabajo presenta un método para segmentar tejidos en imágenes de RM basado en Lógica Difusa, 
aplicando los operadores de la Lógica Compensatoria para el cálculo de las operaciones difusas. 

El sistema implementa en forma computacional el conocimiento que brindan los expertos a la hora 
de interpretar las imágenes de RM en forma de predicados lógicos compuestos. 

Como las operaciones involucradas son sencillas, los tiempos de cálculo son cortos, lo que hace al 
método adecuado para estudios completos en los que deben segmentarse gran cantidad de imágenes. 

El método resulta robusto respecto al ruido y a las no-uniformidades en la intensidad. Además, 
resulta prometedor para aplicaciones en otros tipos de imágenes con una mayor cantidad de 
sustancias a reconocer. 

Dada la relativa sencillez de los cálculos a efectuar, este sistema puede ser programado en cualquier 
lenguaje sin requerir grandes motores de cálculo ni librerías especiales. En general es adecuado 
cualquier lenguaje que pueda trabajar eficientemente con vectores. 

La segmentación de las imágenes es importante en posteriores cuantificaciones para la presentación 
de informes y sobre todo a la hora de discernir entre valores normales y patológicos de las diferentes 
estructuras presentes. 
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